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Overview
The purpose of this guide is to walk you through the steps for setting up budget plan files for your
organization as well as how to work with budget plan files. This guide assumes that you have
administrator role privileges and that you are familiar with the basic concepts related to using Axiom
Budgeting and Performance Reporting, including the administrative aspects of the application. If you are
new to Axiom software in general, we recommend that you first review the Getting Started and System
Administration areas of the online help.

TIP: Online help offers these topics and many more, including multiple training videos related to how
to use the Axiom Budgeting and Performance Reporting. You can access online help by navigating to
theHelp ribbon tab, click Online Help, and then click Budgeting and Performance Reporting.

What's new
Welcome to Version 2019.3 of Axiom Budgeting and Performance Reporting!

Enhancements in this release include:

l Significant budget plan file performance improvements - Improved performance of the plan file
open and save times and enhancements to the overall user experience.

l Budget plan file user interface improvements - Improvements weremade to the user experience
by designing a new side navigation menu and an updated color palate that helps to focus a user’s
attention.

l Click-to-Expand feature -We continued a theme from 2019.2 where we introduced the “click-to-
expand” feature in the Provider Detail tab and expanded its use to the labor methods. The “click-
to-expand” feature summarizes what would normally be a busy looking tab and reduces the initial
view to summarized rows. You now havemore control over their plan file session by selecting
what and when you see detailed content.

l Budget Labor Configuration driver improvements - To improve the administrator’s ease of use
when adding new budget groups to this driver, we added logic to start out the insertion of a new
budget group with all the values from the Global group. This means essentially no inputs are
needed to the new budget group unless changes from the global values are desired.

1
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l Improved navigation to online help - TheMain, Admin, and Help ribbon tabs now include a
single listing of the online help sites for each product, including access to Axiom platform help
from the Advanced Help link.

IMPORTANT: Some of the new features listed above have been included in the latest Prototype file
group. You must create a new file group or update an existing file group to utilize the updated
contents from the 2019.3 release. To create a new file group for a new budgeting year, follow the
instructions in the section Rolling forward to a new budget year.

Budget plan file improvements
The 2019.3 release focused on mandates that included improved performance of the plan file open and
save times and enhancements to the overall user experience. We set out to accomplish this in a manner
that met the following objectives:

Improvements weremade to the user experience by designing a new side navigation menu and an
updated color palate that helps to focus a user’s attention.
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We continued a theme from 2019.2 where we introduced the “click-to-expand” feature in the Provider
Detail tab and expanded its use to the labor methods. The “click-to-expand” feature summarizes what
would normally be a busy looking tab and reduces the initial view to summarized rows. The user can
then has more control over their plan file session by selecting what and when they see detailed content.

Performance gains were accomplished thru a multi-faceted approach that included optimizing the entire
template for formula improvements, moving some template components to optionally selected tabs,
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and development of platform capabilities to process open and save times significantly faster. If you are
currently on a version of Axiom Budgeting and Reporting that is several versions older than 2019.3, you
will likely see a significant change in your user experience.

One of the highlights for the Axiom team in this release was the defined approach to include several
Axiom budget planning clients join us thru the development cycles. Several design sessions were held to
showcase our progress along the way and offer invaluable feedback. This experience was enjoyed by all
and will be an important ongoing improvement to our design model. Much of what you will see in this
release is a direct contribution from your peer’s feedback and influence.

As previously noted, it was Axiom’s intent to minimize the burden of retaining users so we have kept the
changes to a minimum for most users. The operation of the plan file is intended to be very familiar. We
do have videos to support and assist with common plan file operations and we encourage
administrators to direct users to the video content. You can find these videos on the VIdeos page of the
Axiom Budgeting and Performance Reporting online help.

Budget Labor Configuration driver improvements
As the focus of this release was to improve performance, weminimized adding new features except for
one important update was made to the Budget Labor Configuration driver. To improve the
administrator’s ease of use when adding new budget groups to this driver, we added logic to start out
the insertion of a new budget group with all the values from the Global group. This means essentially no
inputs are needed to the new budget group unless changes from the global values are desired.

We also added “click-to-insert” controls for key dimension-related values such as selecting pay types, job
codes, and accounts. This helps reduce the risk of unintentional input errors that can cause plan file
issues when processing.
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Improved navigation to online help
TheMain, Admin, and Help ribbon tabs now include a single listing of the online help sites for each
product, including access to Axiom platform help from the Advanced Help link.
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Understanding File Groups and
Budget Plan File Setup

Before setting up budget plan files, we recommend that you first familiarize yourself with file groups and
how they work.

Axiom Budgeting groups related files for a single year's annual budget into a file group. You maintain a
single, designated file group for the active budget. This section covers file groups in detail.

Accessing file groups
You access file groups from the File Groups section of the Explorer task pane. Your access rights to each
plan file (read-only or read/write) within a file group are determined by a combination of your security
settings and workflow or process settings (if applicable).

To access a file group:
In the ExplorerExplorer task pane, in the File Groups section, expand a file group to do the following:

2
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Option Description

Open Plan Files Select the plan files to open by double-clicking a budget file group's plan
file.

Create Plan Files Create and save empty plan files, per the configuration settings in
dimension tables and the file group's driver files.

Process Plan Files Load historical data into each budget plan file, then run calculations based
on calc methods in the dimension tables.

Copy Plan Files Copy plan files from one file group to another.

Drivers DriversDrivers store configuration settings and key statistics used
throughout the file group. Driver files control plan-wide settings, such as
the current planning period, and contain assumptions such as payroll-
related rates and percentages, production or utilization statistics, and
conversion rates that the plan files use to calculate and spread data.

Utilities If your organization has purchased certain add-on modules, you might
find additional utilities in this folder.

Process Definitions Lists processes defined for the files group. Budget plan files include the
Budget Approval Process definition, by default.

Scenarios This section is not used in Axiom Budgeting 2019.3.

NOTE: By default, only Administrators can see the file group administration options for a group.
Users without Administrator privileges can only open specific plan files for the file groups to which
they have access.

Working with file group aliases
Because you need to manage current and future plan files simultaneously, the task panes recognize the
fiscal year the administrator wants to point them to.

Additionally, using file group aliases allows you to determine when an annual update is made active in
your environment. You can obtain updates at any time an update is made available, without affecting
current operation settings.

In the ExplorerExplorer task pane, the File Group Aliases folder is located in themain File Group section.
There are three aliases available and are currently defaulted with values. BP_CurrentYear, BP_NextYear,
and BP_PriorYear.
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This means that when using task panes to open plan files, the file group aliases determine which plan file
set opens. For example, in the Budgeting task pane, there are two sets of budgets, Open Next Year
Budgets and Open Current Year Budgets.

When opening the Next Year Budgets, the dialog confirms that the plan files are for the next budget year.
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Setting the fiscal year for file group aliases
IMPORTANT: File group aliases also affect scheduled jobs. A scheduled job can only contain one
fiscal year setting. By changing the file group aliases, you may be changing a data set the job will run.
To confirm which file group aliases a scheduled job points to, open the job, and click Process Plan
Files from the task pane. The Select File Group box on theOptions tab displays the alias.

To set the fiscal year for file group aliases:
1. In the ExplorerExplorer task pane, in the File Groups section, right-click BP_CurentYear, and click

Edit.

2. In the File Group field, click the folder icon.

3. Select the file group to use for the current year budget plan files.

4. Click OK.

5. Repeat Steps 2-4 for BP_NextYear and BP_PriorYear.

Deleting a file group
Deleting a file group deletes all of the files stored in the associated file group folder, including templates,
plan files, drivers, calc method libraries, and workflows. Additionally, any document reference tables
linked to the file group are also deleted.
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IMPORTANT: You cannot undo this action, and the deleted files cannot be recovered using normal
Axiom Budgeting functionality. Be sure that you no longer need the file group before you delete it.
You may want to back up the Kaufman Hall Axiom database before deleting the file group.

To delete a file group:
1. In the ExplorerExplorer task pane, in the File Groups section, right-click the file group to delete.

2. Click Delete.

3. At the confirmation prompt, click Yes.

The system deletes the file group and all of its associated files.

Updating file group aliases
File group aliases are reference pointers that are used throughout the system to determine which file
group corresponds to which budgeting year.

IMPORTANT: The aliases must be set before copying driver security so that themost recent year is
used. For example, if a 2020 file group was created and the intent is to copy the file group security
from 2019, then BP_CurrentYear must point to 2019 File Group.

To update file group aliases:
1. In the Admin ribbon tab, click System Browser.

2. In the Axiom Explorer window, click File Group Aliases, and double-click the BP_CurrentYear or
BP_PriorYear aliases to assign their respective file group year relative to the new file group year.
For example, if creating a new 2020 file group, set the BP_CurrentYear to 2019 and BP_PriorYear to
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2018.

3. In the Edit File Group Alias dialog, click the folder icon.

4. In the Choose File Group dialog, select the file group, and click OK.

5. Click OK.

6. Click Close.
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Setting Up Budget Plan Files
The numbered list below include the required and optional steps you need to complete to configure,
test, and release the budget plan files in your organization for the next budgeting season. The system
can also walk you through these same steps by running the Budget Checklist process.

TIP: The steps below link to the corresponding help topics, where applicable.

1. Change year and period.

2. Prepare data for budget go-live.

3. Reconcile data.

4. Create one plan file for each Labor tab template.

5. Process one plan for each Labor tab template.

6. Create plan files using the scheduled job.

NOTE: Run the Build & Process Budget Files job in Scheduler, and use a filter to run the job.
Review the log for errors once the scheduled job completes to confirm that no errors have
occurred.

7. Open a plan file, and save it to confirm there are no errors on save.

8. Review the Budget Configuration driver.

9. Review all the tabs of a plan file for reasonableness.

TIP: Specifically focus on the Stat_Rev, Expense, and Payroll tabs

10. General plan file tab review

a. Ensure navigation under Go To jumps as expected for all tabs.

b. Row/Col headers should be turned off for all tabs.

c. Confirm all print definitions look as expected.

d. Test each View option to ensure it displays/hides parts as expected.

3
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e. Verify print settings for all worksheets.

f. Save the plan file to the database without any errors.

g. Repeat steps below for different departments types (Nursing, Fixed, Admin).

11. Instructions tab review.

a. Review the due dates.

b. Review the budget questions.

c. Review the budget assumptions.

12. Summary tab review.

a. Do initiatives display as they should? Are initiatives set to be displayed in Budget
Configuration driver?

b. Review labels for proper year setting.

TIP: Projected Year settings are highlighted in blue in the Budget Configuration driver
and can be budget group specific.

c. Confirm columns hidden in the Budget Configuration driver are hidden in the plan file.

TIP: Set the Hide Column option in Budget Configuration driver.

d. Confirm "Display Contribution Margin on Summary Tab" is set properly.

TIP: Set the Display Contribution Margin on Summary Tab? option in Budget
Configuration driver.

e. Review dollar and % variances for NYB to ensure reasonableness.

13. Stat_Rev tab review.

a. Verify that History and YTD numbers are accurate.

b. Verify that Projected numbers appear reasonable.

c. Verify that all expected accounts interfaced.

d. Verify that accounts appear under the correct section.

e. Verify that accounts use the expected calc method.

f. Test changing a calc method type used in a plan file.

g. Confirm statistics coming from the Budget Statistics driver do not contain blue input cells.

h. Confirm correct Budget Method selection.
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i. Verify that sections without data are hidden, as expected.

j. Verify that the Global Drivers are reflected at the top from the Budget Driver driver for the
corresponding Budget Group.

k. Verify that all the expected drivers display.

l. Verify that key statistics, identified in Dimensions, are listed.

m. For revenue accounts, verify that the global adjustments display from the Budget Revenue
Adjustments driver.

n. Check review projections in CYP.

o. Test that the summary section for revenue ties with the detail sections.

p. Confirm that the columns hidden in the Budget Configuration driver are hidden in the plan
file.

q. Test to confirm red flag warnings disappear when all comments with red flags include
comments.

14. Expense tab review.

a. Verify that History and YTD numbers are accurate.

b. Confirm column labels are accurate from the Budget Configuration driver.

c. Verify that all expected accounts interface.

d. Verify that accounts display under the correct sections.

e. Verify that accounts use the expected calc method.

f. Test changing a calc method type used in a plan file.

g. Confirm that expense adjustments interface from expense-related drivers (Budget
GlobalExp, Budget GlobalData, etc.) for all calc methods (Budget Group specific).

h. Test resolving "Salaries do not match" warning.

NOTE: Test with provider and non-provider plan files.

i. Test using ePTO with and without ePTO (Gross and Net).

NOTE: See the Earned Paid Time Off setting in the Budget Labor Configuration driver to
configure this feature.

j. Test resolving "Hours do not match" warning.

NOTE: Test with provider and non-provider plan files.
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k. Ensure that the Budget Method is correct for Detail Method.

l. Review the Statistics spread total for Key Stat accounts.

m. Confirm that the projected numbers appear reasonable.

n. Confirm that the columns hidden in Budget Configuration tab are hidden in the plan file.

o. Confirm that KHABgtMap works as expected.

NOTE: The DEPT column for calc methods that use KHABgtMap will be highlighted in a
different background color. The DEPT column is visible ONLY if KHABgtMap is in used.
Otherwise, the column is hidden.

p. Test the drilling feature by drilling historical GL Transactions.

NOTE: See the Expense Transaction Drilling setting in the Budget Configuration driver to
enable this feature.

q. Confirm that the Use Preliminary Estimate on Detail Calc Method option in the Budget
Configuration driver works as expected.

15. Labor tab review.

a. Verify that the plan files interface with the expected labor type.

NOTE: ACCT.KHAStdLine (or other StdLine columns) Calc Method selection (Labor,
ProviderLabor, etc.)

b. Verify that the expected job codes are interfaced.

NOTE: All job codes that work in the Dept YTD will be interfaced into the Dept.

c. Review the Uniform Merit Increase Date.

d. Review the FTE Comparison to YTD.

e. Test with Projected FTE Starting Point.

f. Test with Forecast FTEs from Projection.

g. Change the titles for Program Additions Title and Position Changes Title, and confirm it
displays up in the plan file.

h. On the Staffing and Jobcode tabs, test % of Staffing Change with Volume.

NOTE: The default is set to 60% for Variable job codes.

i. Ensure that the FICA limits apply, regardless of the fiscal year (it should taper down in the

Setup Guide Axiom Budgeting │ 19



months of Oct – Nov, regardless of the fiscal year).

j. Ensure that the total dollars match the dollars on the Expense tab.

k. Confirm that the YTD Hours and YTD Dollars are accurate.

l. Confirm that the GL mapping is accurate.

TIP: Select the Audit view in the Labor tab to confirm the account coding.

m. Test the Dept_BasePay calc methods.

n. Review the allocation rates in the JobCode block for reasonableness.

o. Confirm that the PayTypeMapping Analysis report includes no variances.

p. Confirm that only the PayTypes mapped on the Budget Labor Configuration driver interface
into the Jobcode block.

q. Confirm that the Contract labor (Agency) is set up and interfaces appropriately.

r. Confirm ePTO GLAcct maps correctly when set to Yes.

NOTE: Review the Earned PTO Hours Conversion Factor (by default, the system sets
this to 80 hours) and PTO per FTE (by default, the system sets this to 176).

s. If using Lump Sum, confirm that the Budget Labor Limits is set up for max rates.

NOTE: The default is 100% for full payout ofmerit abovemax rate.

t. Test by adding a new PayType to the Dollars section of JobCode block.

u. Review the Fixed/Variable coding for each job code and test variability.

NOTE: For JobCode and Staffing labor tabs only; Comes from Dimension setting
JobCode.Variable.

v. Test the overrides from the driver, if Budget Group specific.

NOTE: Cross check with the Budget Labor Override driver.

w. Update/change the days staffed and shift hours (impacts variable spread)

NOTE: For the Staffing and JobCodeADC labor tabs only.

x. Employee labor tab only:

l Confirm that the Empl_List tab is unavailable.
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l Review the Employee labor tab for a complete list of the employees.

y. ADC labor tab only:

l On the ADCConfig tab, add a block for Global Budget Group and Dept Exceptions.
Ensure that the ADCConfig tab options came through as expected.

l Confirm that the Jobcode and ADC tabs are equal to each other for FTEs.
l Review FTEs and Hours calculations for reasonableness.

16. Empl_List tab review.
a. Verify all of the interfaced data (comes from EmployeeMaster import).

b. Check that all employees or job codes display under their home department.

c. Check that increases are populated.

d. Test the Lump Sum options.

17. Initiatives tab review (if applicable).
a. If enabled in New Initiatives tab of drivers, all the approved initiatives display on the

Summary tab, and save to the database.

b. The list of initiatives that displays in the New Initiatives tab of Drivers is available for
selection.

c. Test by adding new calc methods.

18. Dept_History tab review.
a. Validate data by ensuring that the historical data ties to department P&Ls.

b. Check that the Dept column for calc methods that use KHABgtMap are highlighted in a
different background color.

NOTE: The Dept column is visible ONLY if KHABgtMap is used. Otherwise, the column is
hidden.

19. Provider and Provider Comp tab review.
a. Verify that History and YTD numbers are accurate.

b. Verify that projected numbers appear reasonable.

c. Verify that all the providers that meet the threshold setup display, if applicable.

d. Verify the summary section totals the detail sections.

e. Verify that all stats and revenue flow to the Stat_Rev tab, as expected.

f. For Provider Detail methodology:
l Verify the FTE is pulling from the ProviderComp tab.
l Review the overall driver for the department, and compare the production days
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based on provider FTE.
l Verify that seasonality appears reasonable, if provider has at least one year of

history.
l Review the various data breakout, if using the detail method, to make sure the data

is grouped appropriately.
l Review the Gross Charges section, and verify that the charges calculate either on

Encounter, WRVU, Procedure, or RVU.

g. Provider Summary methodology:
l Verify that the system appropriately pulls FTE and driver stats from the Simple Dept

Config driver.
l Verify that the system pulls the spread from the Simple Dept Config driver.

h. Verify that the expected job codes relating to providers interface with the ProviderComp
tab.

NOTE: The system will interface all job codes that have worked in the department YTD
into the department when the KHAInt on the Jobcode dimension is set to Provider.

i. Verify that the YTD Hours and YTD Dollars are accurate.

j. Verify that RVUs flow from the Provider tab.

k. Verify that the Comp Models pull properly from the Provider List driver.

l. Complete a few calculations manually to verify that the expected salary calculates.

m. Review the compensation spread for reasonableness.

n. Verify any additional pay/benefits either calculate properly in the provider block and/or pull
appropriately from the Provider List driver.

o. Ensure that the FICA limits are applicable, regardless of the fiscal year.

NOTE: It should taper down in themonths of Oct – Nov, regardless of the fiscal year.

p. Verify that the GLMapping is accurate and flowing to the Expense tab.

20. Reconcile the budget.
a. Schedule nightly recalculation for all budgets to transfer results to the database.

b. Correct any errors encountered during the recalculation process.

c. Review the Budget Income Summary report for reasonableness.

21. Run and review optional calculator reports.
a. NewDepartment utility
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TIP: This utility is located in the Utility section of the file group year you will use for the
planning cycle.

b. Deductions Calculator by Payor utility

TIP: Do not create a plan file for the Budget Deduction Department when using this
utility.

c. Deductions Calculator using FSDetail utility

d. Deductions Calculator using FSPayor utility

e. Budget Balance Sheet and Cash Flow utility

22. Run and review Budget Reconciliation reports.
a. Budget Department Audit report

b. Budget Process Management report

c. Budget Workbook Reconciliation report

d. Global Depreciation Reconciliation report

e. Global Expense Reconciliation report

f. Global Revenue Reconciliation report

g. Labor Non-Matched report

h. Payroll12 Hours Reconciliation report

i. Payroll12 Negative Hours report

j. PayTypeMapping Analysis report

k. Reconcile NYBDetail to Financial report

l. Reconcile Payroll12 to Financial-Dollars report

m. Reconcile Payroll12 to Financial-FICA report

n. Reconcile Payroll12 to Financial-Hours report

o. Salaries Do Not Match report

23. Delete test plan files.

24. Clear test data from the budget data table.

25. Build budget plan files.

26. Process budget plan files.

27. Verify plan file creation and interface.
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28. Advance the plan files using Process Management to Owner stage.

Running the Budget Checklist process
Use this process to walk you through the steps needed to create plan files for the next budgeting season.
The Budget Checklist process displays all of the steps to complete on the left side of the window. Those
steps that include sub-steps are indicated with an arrow icon, which you can click to expand or contract
the list.

To run the Budget Checklist process:
1. In the Bud AdminBud Admin task pane, in the Prepare Budget Plan Files section, double-click

Budget Checklist.

2. In the Process Owner field of the Process Properties tab, do one of the following:
l To assign a specific user as process owner, click Select User.
l To assign users with specific roles as process owners, click Select Role.

NOTE: You must assign a user or role before you can run this process.

3. Click Start Process in the upper right corner of the dialog.
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4. At the Start process 'Budget Checklist' prompt, click OK.

5. As you complete each step, click Complete step in the upper right corner of the screen.

TIP: An arrow icon displays next to steps that contain sub-steps. Click the icon to expand or
contract the list of sub-steps.

NOTE: You can skip steps that do not apply to your organization.

6. In the Process Action dialog, you can enter any details about the step you performed, and click
OK.

TIP: The dialog also displays the next step in the process.
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7. If you need to stop the process as you work on the different steps, click Stop process in the upper
left corner above the list of steps. This places the process in an inactive status until you are ready
to start the process again.

TIP: To view a report of the process history, click Process history in the upper left corner above
the list of steps.

8. At the Are you sure that you want to stop this process? prompt, click OK.

Changing year and period
Use this table to configure the following for your organization:

l Set the fiscal year and the first month of the fiscal year
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l Define the number of work days in the current year, last year, and next year
l Select the standard Full Time Equivalent (FTE) hours worked by employees in a year.

NOTE: The standard FTE hours you select in this worksheet displays as the default FTE Hours in the
Budget Labor Configuration Budget Labor Configuration driver.

The FTE Hours you select are reflected on the following tabs in the plan file:

l Expense
l Jobcode
l Staffing
l Employee
l ProviderComp
l altEmployee
l HHLabor

To set year and period:
1. In theMgmt Admin task pane, in theData Maintenance section, double-click Update Year and

Period Tables.
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2. In the Primary Inputs section, complete the following options:

Option Description

Fiscal Year Select the fiscal year.

Fiscal Start Month Select themonth in which the fiscal year starts.

FTE Hours Select one of the following:

l To use the standard of the number of days worked multiplied by a
40-hour work week divided by 7, select 2086.

l To use the standard 40 hour work-week multiplied by 52weeks,
select 2080.

3. In theWorking Days Inputs area, enter the number of working days for the current year, last
year, and next year for each fiscal month.

TIP: To hide the year and/or period tables, click the corresponding check boxes under the
Working Days Inputs section.

4. After making your changes, click Save.

Preparing data for budget go-live
Importing and loading data is an important part of keeping your budget up-to-date and correct. We
recommend that you perform these actions on a biweekly and monthly bases.

The following topics provide instructions on running the required and optional data imports reports.
These are the same imports you will run to create your monthly reports.

IMPORTANT: You must load and reconcile data before you start building and processing plan files.

Run these imports and utilities in the following order to load your data into the system:

1. Import General Ledger data - The Load 12Month import brings in 12months of General Ledger
data from your source system. This will include values for revenues, deductions, expenses, etc. -
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including values for balance sheet (if provided).

2. Import Monthly Statistics data - The Load Monthly Stats import brings in departmental-level
statistics, including key and non-key statistics. This can also include facility-level statistics. If payroll
hours are not imported through the Payroll Transfer utility, then they will commonly be imported
using this import.

3. Import Biweekly Payroll data - Imports biweekly payroll data, which includes identifying
department, job code, pay type, and employee ID values.

4. Load EmployeeMaster - Imports the employee level detail information, including base rate,
full/part time status, anniversary date, PTO balance, etc. The employees are listed by job code.
The employeemaster is used in the interfacing and plan files to apply merit and market
adjustments.

5. Loading Revenue and Usage data - Imports your Charge Description Master (CDM)monthly data,
including department, CDMCODE, revenue and volume type (i.e. inpatient, outpatient).

NOTE: This import only applies if your organization is licensed for the CDM template.

6. Load Provider Data - Imports the transactional-level records for a provider, including ID,
department, and key database fields such as CPT, location, FinClass, and other related records.
This information is used for reporting and budgeting purposes. Once loaded, you can configure
whether to use the Provider Summary or Provider Detail options, and adjust your dimension
accordingly. This is the core transactional data from your provider billing database.

NOTE: This import only applies if your organization is licensed for the Provider feature.

� Other imports
These imports can be run in any order, as needed, with the exception of the Biweekly to Monthly Payroll
Accrual utility. While these imports are not required to create budgets, they do provide enhanced
reporting and plan file analysis without having to leave the Axiom application.

l Running the Biweekly to Monthly Payroll Accrual utility - Run this utility to accrue for hours,
dollars, and statistics from your biweekly payroll import(Payroll26) into themonthly data tables
(Payroll12).

IMPORTANT: This utility is a prerequisite to using theMonthly to GL Accrual utility.
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l Running theMonthly to GL Accrual utility - If payroll hours are not coming through your GL
Import, you can move your hours from the Payroll12 data tables created from the previous
process to your Financial tables by running theMonthly to GL accrual utility.

IMPORTANT: Only run this utility if you are not loading hours from your GL using the GL12
Month or Monthly Statistics imports (step 1 or 2 above).

l Loading AP Detail data - Imports your Accounts Payable sub-ledger detail, including amount,
check date, check number, invoice date, invoice number, etc.

l Loading GL Detail data - Imports your general Journal Entry detail, including department, account,
and other identifying information.

l Loading MM Detail data - Imports your Materials Management sub-ledger detail, including
amount, item number, item description, location, quantity, unit price, and vendor information.

l Loading Accrued Receipts data - Imports your Accounts Receipts sub-ledger detail, including item
number, description, invoice date, vendor name and number, and other vendor identifier
information.

l Summarizing CDM statistics to financial - To use your Charge Description Master (CDMCODE) to
create your statistics, we offer a save-to-database utility that summarizes the inpatient and
outpatient volumes in the RevUsage database (ACT_RU_20XX) into statistic accounts that can be
stored in the Financial database (ACT20XX).

NOTE: For this utility to work, your Kaufman Hall implementation consultant will help you
design your CDMCODE table during the implementation.

� Resolving import errors
If any of the imports experience validation errors, you can view them in two places in the system: a
separate CSV file and the Execution log area of the Execute Import dialog, as shown in Step 8 of Loading
GL12Month data.

For more information, see Resolving import validation errors.

Loading GL12 Month data
Make sure to create and save the import file to a directory accessible by the Axiom Application server.
We recommend naming the file with a GL_ prefix.

To load GL12 Month data:
1. To change the current period, in the Admin ribbon tab, in theDatabase group, click Imports &

Utilities > System Period/Year.
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2. In the System Current Period dialog, in theNew Value field, type the newmonth value, and click
OK.

IMPORTANT: Do not change the System Current Year field unless changing over a new fiscal
year. Setting the system period and year could affect other Axiom Healthcare Suite products.

3. In the Admin ribbon tab, in theDatabase group, click Imports & Data Utilities > Imports,
Management Reporting> 01-Load GL 12 Months, and click Execute.
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4. Click Execute.

5. In the Variables dialog, do the following, and click OK:
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Field Steps

Table: Select Table Select the ACT or BUD table.

Year Selection: Input
Year (YYYY)

Type the year to load.

6. In the Choose the import source file dialog, select the source file to load.-

If the import encounters validation errors, see Resolving import validation errors.

7. After you load the data, run the Income Statement Summary report in Explorer in Reports Library
> Management Reporting > Income Statement > Income Statement Summary to reconcile to
your GL income statement.

Loading Monthly Statistic data
Make sure you create and save the import file to a directory accessible by the Axiom Application server.
We recommend naming the file with a ST_prefix.

To load Monthly Statistic data:
1. In the Admin ribbon tab, in theDatabase group, click Imports & Data Utilities > Imports >

Management Reporting > 02-Load Monthly Stats, and click Execute.
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2. Click Execute.

3. In the Variables dialog, do the following, and click OK:
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Field Steps

Table: Select Table Select the ACT or BUD table.

Year Selection: Input
Year (YYYY)

Type the year to load.

4. In the Chose the import source file dialog, navigate to the location where you stored the source
file, and select it.

NOTE: We recommend that you name the file using a ST_ prefix.

If there are any import exceptions, follow the import exceptions remediation from Resolving
import validation errors.

5. If you are not loading your statistics through an import set up by your Kaufman Hall
Implementation Consultant, then you can also load statistics using a Save to Database report.
There are standard reports delivered with your system for this, which you can find in Explorer in
Management Reporting Utilities > Data Input > Input Monthly Statistics.

6. Use the top section of the report, labeled Add New Stats, when entering a newDept-Acct
combination into the database.
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If needed, you can copy additional rows by copying the entire row, and then using the Insert
Entire Row option in Excel. If you Refresh the report, it will bring in all existing statistic
combinations from the database, and you can then update any monthly value in the blue cells in
the Change Existing Stats section.

7. After you complete your inputs, from theMain ribbon tab, click Save to send the data into the
database and save the report.

Loading Biweekly Payroll data
Make sure you create and save the import file to a directory accessible by the Axiom Application server.
The file should be saved as LD_MMDDYY_PP. For example, LD_100418_1

To load Biweekly Payroll data:
1. In the Admin ribbon tab, click Imports & Data Utilities > Table Current Periods.
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2. Filter using the Table Type, and select Payroll.

3. Change the period for all of the payroll tables where theUses System checkbox is not selected.
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4. In the Table Current Periods dialog, double-click the current period for the table, and type the
new period.

5. When you have finished all the tables, click OK.

6. In the Admin ribbon tab, click Imports & Data Utilities > Imports > Management Reporting > 03-
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Load Biweekly Payroll > Execute.

7. In the Execute Import: 03-Load Biweekly Payroll dialog, click Execute.

8. In the Variables dialog, do the following, and click OK:

Field Steps

Year Selection: Input
Year (YYYY)

Type the year to load.

PayPeriod: Input
Period (1 – 27)

In the drop-down, select the pay period to load to.

9. In the Choose the import source file dialog, navigate to the location where you stored the source
file, and select it.
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10. If there are any import exceptions, follow the import exceptions remediation from .

Loading Employee Master
Make sure you create and save the import file to a directory accessible by the Axiom Application server.
We recommend naming the file with a LM_prefix.

To load Employee Master:
1. In the Admin ribbon tab, in theDatabase group, click Imports & Data Utilities > Imports >

Management Reporting > 10-Load Employee Master, and click Execute.

Setup Guide Axiom Budgeting │ 40



2. Click Execute.
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3. In the Variables dialog, do the following, and click OK:

Field Steps

Yr: Input Year (YYYY) Type the year to load.

4. In the Chose the import source file dialog, navigate to the location where you stored the source
file, and select it.

NOTE: We recommend that you name the file using a LM_ prefix.

If there are any import exceptions, follow the import exceptions remediation from Resolving
import validation errors.

5. After you complete your inputs, from theMain ribbon tab, click Save to send the data into the
database and save the report.

Loading Revenue and Usage data
Make sure to create and save the import file to a directory accessible by the Axiom Application server.
We recommend naming the file with a RU_prefix.
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To load Revenue and Usage data:
1. In the Admin ribbon tab, click Imports & Data Utilities > Imports > Management Reporting > 09-

Load RevUsage > Execute.

2. In the Execute Import: 09-Load RevUsage dialog, click Execute.
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3. In the Variables dialog, do the following, and click OK:

Field Steps

YR: Input Year (YYYY) Type the year to load.

Month: Select
Current Month

In the drop-down, select themonth to load to.

4. In the Choose the import source file dialog, navigate to the location where you stored the source
file, and select it.

5. If there are any import exceptions, follow the import exceptions remediation from Loading GL12
Month data.

Loading Provider Detail data
Make sure you create and save the import file to a directory accessible by the Axiom Application server.
We recommend naming the file with a PB_prefix.

To load Employee Master:
1. In the Admin ribbon tab, in theDatabase group, click Imports & Data Utilities > Imports >

Management Reporting > 4-Load Provider Detail, and click Execute.
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2. Click Execute.
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3. In the Variables dialog, do the following, and click OK:

Field Steps

Yr: Input Year (YYYY) Type the year to load.

Month: Select
Current Month

Select themonth to interface the data into the system from the drop-
down.

4. In the Chose the import source file dialog, navigate to the location where you stored the source
file, and select it.

NOTE: We recommend that you name the file using a PB_ prefix.

If there are any import exceptions, follow the import exceptions remediation from Resolving
import validation errors.

5. After you complete your inputs, from theMain ribbon tab, click Save to send the data into the
database and save the report.
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Loading AP Detail data
Make sure to create and save the import file to a directory accessible by the Axiom Application server.
We recommend naming the file with an AP_prefix.

To load AP Detail data:
1. In the Admin ribbon tab, click Imports & Data Utilities > Imports > Management Reporting >

06-Load AP Detail > Execute.

2. In the Execute Import: 06-Load AP Data dialog, click Execute.
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3. In the Variables dialog, do the following, and click OK:

Field Steps

YR: Input Year (YYYY) Type the year to load.

YearMonth: Select
GLPeriod

In the drop-down, select the GLPeriod to load to.

4. In the Choose the import source file dialog, navigate to the location where you stored the source
file, and select it.

5. If there are any import exceptions, follow the import exceptions remediation from Resolving
import validation errors.

Loading GL Detail data
Make sure to create and save the import file to a directory accessible by the Axiom Application server.
We recommend naming the file with a JE_prefix.

To load GL Detail data:
1. In the Admin ribbon tab, click Imports & Data Utilities > Imports > Management Reporting >

05-Load GL Detail > Execute.
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2. In the Execute Import: 05-Load GL Data dialog, click Execute.

3. In the Variables dialog, do the following, and click OK:
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Field Steps

YR: Input Year (YYYY) Type the year to load.

YearMonth: Select
GLPeriod

In the drop-down, select the GLPeriod to load to.

4. In the Choose the import source file dialog, navigate to the location where you stored the source
file, and select it.

5. If there are any import exceptions, follow the import exceptions remediation from Resolving
import validation errors.

Loading MM Detail data
Make sure to create and save the import file to a directory accessible by the Axiom Application server.
We recommend naming the file with an MM_prefix.

To load MM Detail data:
1. In the Admin ribbon tab, click Imports & Data Utilities > Imports > Management Reporting >

07-Load Materials Issues> Execute.
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2. In the Execute Import: 07-Load Materials Issues dialog, click Execute.

3. In the Variables dialog, do the following, and click OK:
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Field Steps

YR: Input Year (YYYY) Type the year to load.

YearMonth: Select
GLPeriod

In the drop-down, select the GLPeriod to load to.

4. In the Choose the import source file dialog, navigate to the location where you stored the source
file, and select it.

5. If there are any import exceptions, follow the import exceptions remediation from Resolving
import validation errors.

Loading Accrued Receipts data
Make sure the import file is created and saved to a directory accessible by the Axiom Application server.
We recommend naming the file with an AR_prefix.

To load Accrued Receipts data:
1. In the Admin ribbon tab, click Imports & Data Utilities > Imports > Management Reporting > 08-

Load Accrued Receipts > Execute.
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2. In the Execute Import: 08-Load Accrued Receipts dialog, click Execute.

3. In the Variables dialog, do the following, and click OK:
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Field Steps

YR: Input Year (YYYY) Type the year to load.

YearMonth: Select
GLPeriod

In the drop-down, select the GLPeriod to load to.

4. In the Choose the import source file dialog, navigate to the location where you stored the source
file, and select it.

5. If there are any import exceptions, follow the import exceptions remediation from Resolving
import validation errors.

Summarizing CDM statistics to financial
To use your ChargeMaster (CDMCODE) to create your statistics, we offer a save-to-database utility that
summarizes the Inpatient and Outpatient volumes in the RevUsage database (ACT_RU_20XX) into
statistic accounts that can be stored in the Financial database (ACT20XX). For this utility to work, your
Kaufman Hall consultant will help you design your CDMCODE table during the implementation process.
For more information, see Setting up CDM Summarization.

To summarize CDM statistics to financial:
1. To run this Save to Database utility, navigate to In the ExplorerExplorer task pane, in the Libraries

section, click the Reports Library > Management Reporting Utilities > RevUsage folder, and
double-click Summarize CDM Statistics.

2. In the drop down box in cell M19, select whether you are running the process for Current Year or
Last Year.
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3. Refresh the data by doing one of the following:

l In theMain ribbon tab, click Refresh Data.

l Press F9.

TIP: After you initially configure the CDM settings, we recommend that you test with just one
department before running this utility for all departments. You can do this by filtering the
report for a department, and then selecting “Refresh Data” to see the results of the
summarization. You can also use the Quick Filter from theMain ribbon tab to limit the data set
to review. Once you are comfortable with your coding, remove the filter, and from theMain
ribbon, click Saveb.

4. In the File Processing task pane, click Process file.

Setup Guide Axiom Budgeting │ 55



NOTE: You do not need to run this utility using Multipass unless you are a large health system
and are noting performance issues when previously running.

The report calculates monthly volumemultiplied by the RVU for all statistics listed as KeyStat =”Yes” in
the CDMCODE dimension.

TIP: The system populates the key departmental statistics into the ACT20XX table, which are
available to view in Open in Spreadsheet mode or by running any standard KHA report that contains
key departmental statistics.

Resolving import validation errors
If the import experiences import validation errors, you can view them in two places in the system: a
separate CSV file and the Execution log area of the Execute Import dialog, as shown in Step 8 of Loading
GL12Month data.

The CSV file is located in Explorer in the Imports Library > Management Reporting > Import Errors
folder.
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The CSV file shows you which rows of data were invalid within the context of the import data. This error
file includes the following:

l Look up validation errors from Kaufman Hall's Software's built-in validation against lookup
columns.

l Validation errors from any Custom Data Validation steps in the transforms.

l Key validation errors such as blank keys or duplicate keys.

You can also open the file from the Execute Import dialog by clicking the link the Status area. The status
displays either "failed" or "warning," followed by "click here to open errors in a spreadsheet." The status
type depends on whether the option to Ignore lookup and key errors is selected.
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Each execution of an import that results in a lookup error generates a unique error file (differentiated by
a date/time stamp). These error files are not automatically deleted; you must manually delete them
when you finish investigating the error.

The CSV file contains the import data, followed by one or more validation columns. Validation columns
are labeled as follows:

l LookupColumnName Lookup Error column – Contains lookup and key validation messages. For
example, Acct Lookup Error"\ when looking up against the ACCT column.

l AXTRANSFORM_StepNumber column – Contains Custom Data Validation messages where
StepNumber is the number of the associated transformation step. For example, AXTRANSFORM_5
when the associated transform is step 5 in the list.

If there are errors (most commonly new codes in Dimensions), add those codes to dimensions, and re-
run the import.

Setup Guide Axiom Budgeting │ 58



Reconciling data
After importing and loading the data, you need to reconcile it to make sure it enters the system correctly
before starting the budget process. We recommend that you perform these actions on a biweekly and
monthly bases.

The following topics provide instructions on running the required reconciliation reports. These are the
same reports you will run to create and reconcile your monthly reports.

IMPORTANT: You must load and reconcile data before you start building and processing plan files.

Run these imports and utilities in the following order to load your data into the system:

1. Reconcile Income Statement - Use this report to review the Income Statement totals by FSDetail
category for the current period and year-to-date compared to budget and prior year.

2. Reconcile GL to GL Transactions - If you load sub-ledger detail, such as Accounts Payable (AP),
Accrued Receipts (AR), Materials Management (MM), and Journal Entries (JE), we have a
reconciliation utility that ties the sub-ledger data back to the General Ledger data (ACT20XX). This
report confirms that the data loaded to the GL matches the data loaded to the Journal Entry (JE)
detail. It also compares the JE detail to AP, MM, and AR transactions to make sure the data
balances.

3. Reconcile GL to RevUsage - Use this report to reconcile GL revenue data in the Financial tables to
the Revenue and Usage data imported into the database on a monthly and year-to-date basis.
The desired result for this report is to show a zero variance.

4. Monthly RevUsage Reconciliations (For CDM template licensed users only) - After all revenue and
usage data is loaded, run theMonthly RevUsage Reconciliation. This report shows the IPVolume,
IPRevenue, OPVolume, and OPRvenue by department for each month.

5. Biweekly Payroll Reconciliation - Run this report after loading the biweekly payroll data to validate
totals for the dollars, hours, and statistics from the import file.

Working with Dimensions
Dimensions are the key index fields for the tables in the Axiom Budgeting 2019.3 database. All data in the
system will be associated with one or more dimensions.

A few examples of dimensions used in Axiom Budgeting 2019.3 include:

Each dimension has multiple fields. The fields within dimensions tables are typically referred to as
columns. Field/column names are expressed as tablename.fieldname.
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When Axiom Budgeting 2019.3 is first implemented, your Kaufman Hall Implementation Consultant helps
you configure the dimension tables to reflect the structure of your organization (departments, entities,
accounts, and so on). Subsequently, you may need to edit dimensions in order to add new departments,
accounts, positions, pay types or other items to the database.

Working with the Dimension Maintenance utility
Your organization may usemultiple distinct Entity Management branches within your structure to help
manage your Axiom Software products. It might be the responsibility of each local product administrator
to maintain their own elements within dimensions for each Axiom Software product that your
organization is licensed for. Additionally, and ideally, each administrator should not be able to modify
elements outside of their area, otherwise, reports and processes could be negatively impacted.

The Dimension Maintenance utility allows the administrator for a local branch to manage only grouping
columns within a dimension and limits this dimension to only the elements that the administrator has
access to.

IMPORTANT: Version 2017.1 and higher includes a variety of security changes to enable this tool. The
dimension tables have been restricted to read-only access until the system administrator configures
a user for dimension maintenance security. For more information, see Editing the security rights for a
user.

The Dimension Maintenance utility allows administrators to:

l Havemulti-user and filtered access to key universal dimensions.

l Restrict dimension grouping column maintenance to specified product grouping columns.

l Create dimension grouping columns, and assign them to products.

l Add new records and update all validated grouping columns, even when they are outside of that
product range.

l Create dimension grouping columns that automatically display in an organized manner.

To enable the Dimension Maintenance functionality described above, the following features were
created:

l In the Edit Data Structuremode, administrators can manage grouping columns using datasets.
l In the Dimension Maintenance utility, depending on their roles, users can select the products and

dimensions to maintain.
l Using the security feature in the Dimension Maintenance utility, for each product, administrators

can quickly assign write filters to those users who have an administrator role assigned to them.

The following table represents which dimensions are part of each product. A check mark means users can
access the dimension using the Dimension Maintenance utility, but the records each user can edit
depends on the security filter applied to each.
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The following dimension tables are not affected by this update and are not part of the Dimension
Maintenance utility. Each of these dimensions retain:

l Full edit rights, per authorized user.
l Ability for direct table edit.
l Leverage existing edit tools as you have used in the past.
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IMPORTANT: Because Axiom Budgeting and Performance Reporting uses CDMCODE, GLPERIOD, and
INITIATIVEID dimension tables, which are not included as part of the Dimension Maintenance Utility,
you will need to access these dimensions in the Budget System Maintenance > View Dimension
Tables area of the Bud Admin task pane or from the Explorer task pane.

Configuring the Dimension Maintenance utility

To configure the Dimension Maintenance utility, do the following:

1. Configure the utility to assign any custom dimension grouping column to their respective
products. For more information, see Assigning an existing grouping column to a dataset (product).

2. Configure the security for each administrator user in the utility. You must apply a dimension filter
to any member that you want to have edit rights. IfNotConfigured displays, then the user does
have edit ability. A filter grants users edit abilities for those records within the assigned filter. For
more information, see Editing the security rights for a user.

3. Review and test the Dimension Maintenance utility.

Editing the security rights for a user

You can only access the security management feature of the Dimension Maintenance utility if you are
assigned the security administrator role.

With Dimension Maintenance - Security, you can set in bulk the security rights for all users assigned a
product administrator role for all dimensions for a specific dataset (product).
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NOTE: If a user is assigned as an administrator for a product and as a user for another product, the
user can only access the tables for the product they are administrator of. For example, if a user is a
product administrator for Axiom Cost Accounting and a user for Axiom Budgeting and Performance
Reporting, the user would only be able to edit the dimensions for Axiom Cost Accounting.

IMPORTANT: For a user (with a product administrator role) to edit a dimension, you must first assign
them security rights using this utility.

To edit the security rights for a user:
1. From the Explorer task pane, in the Reports Library section, select System Files > Dimension

Maintenance, and double-click Dimension Maintenance - Security.

2. In the Select a Product drop-down, select the product to display the respective product
administrators, and click OK.

3. Select a user, and do one of the following:

IMPORTANT: IfNotConfigured displays in the cell, then the user does not have edit rights. For
full edit access on numeric dimensions, enter >= 0, for example Acct > 0.
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To... Then...

Use the filter
wizard to specify
the security
rights

a. Right-click the cell to edit.

b. Select Axiom Wizards > Filter Wizards.

c. Use the Filter Wizard to select and specify
the security rights for a product
administrator. For more information on
using the Filter Wizard, do the following:

i. On theMain ribbon tab, click Help.

ii. In the left navigation pane, click
Reference > Filters > Filter
Wizard.

Enter the
security rights
manually

Click in a cell, and type the rights.

In the following example, Angela is not authorized to edit the ACCT dimension. She can, however,
edit the DEPT dimension records for departments that belong to Entity 2.

4. In theMaintenance - Security table, at the top of the utility, On indicates saving will post changes
to the database.
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NOTE: The ability to save is initially enabled (On). Clicking Save on theMain ribbon tab posts
any changes to the database.

5. In theMain ribbon tab, click Save.

Assigning an existing grouping column to a dataset (product)

You can associate each grouping column you create with multiple licensed products. The assignment
determines which product each column gets displayed under within the Data Maintenance utility.

NOTE: You can only perform assignments for custom columns that your organization has added. We
recommend that you do not change the assignments of any standard columns included with the
product.

IMPORTANT: Make sure to define a default value entry for the column. To do this, complete steps 1-
8 of Creating a grouping column.

To assign an existing dimension grouping column to a dataset (product):
1. From the Explorer task pane, in the Libraries section, click Table Library > !Dimensions.

2. Right-click a dimension, and select Edit table structure.
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3. In the Edit Table dialog, click the Columns tab.

4. In the list of columns, select a column to assign, and click the Assign Column to Data Sets button.

5. In the Data Set Assignment dialog, in the list of data sets (products) that have predefined for you,
select the checkbox next to the products to assign this grouping column to, and click OK.

NOTE: The list that displays will vary depending on the Axiom Healthcare Suite products you
are licensed to use.
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Product Product Node

Budget Planning BP

Financial Planning FP

Rolling Forecast RF

Cost Accounting Cost

Cost Management CM

Capital Planning CP

Decision Support DSS

Capital Tracking CT

Performance Reporting PR

Available to all related products General
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After you select the products, they display in the Edit Table dialog in the Product Data Sets field.

6. In the Edit Table dialog, click OK.

Managing dimensions
After you configure the Dimension Maintenance utility and set the security rights for the appropriate
users, they can access the utility from the Administrator task pane to manage and configure dimensions.
The products and dimensions a user can access will vary depending on their role. As an administrator,
you can select all of the Axiom Software products.

Creating a grouping column

Some dimension tables include grouping columns that allow data associated with those records to share
common settings or be rolled up into larger groups for calculation or reporting purposes.

NOTE: If you created a custom grouping column in Axiom Budgeting version 2016.4 or earlier, you
need to assign it to a data set (product). For instructions, see Assigning an existing grouping column
to a dataset (product).

Here are a few guidelines for naming your columns:

l Keep the descriptions of grouping columns short and simple.
l Avoid using common English words in your grouping column names, such as Interface or Union.

Instead, combine words to come up with column titles such as IntGroup.
l It is good practice to fill out each grouping column for every element (table row).
l Spaces are not allowed. Use the underscore to separate upper/lower case words.
l Grouping columns cannot start with a number, but they may include a number.

To create a grouping column:
1. In the Explorer task pane, in the Libraries section, click Table Library > !Dimensions.

Setup Guide Axiom Budgeting │ 68



2. Right-click the dimension table to add the grouping column to, and select Edit table structure.

3. In the Edit Table dialog, click the Columns tab.

4. Above the list of column names on the left side of the tab, click the + button.

5. In the Column Name field, type a name for the new column.

IMPORTANT: Use only alphanumeric characters in group column labels.

6. In the Data Type field, click the drop-down button, and select String.

7. In theDefault Value field, type a default value that displays to the user.

8. Click Apply.

9. In the list of columns, select the column you just added.

10. Above the list of columns, click the Assign Columns to Data Sets button.

11. In theData Set Assignment dialog, select the checkbox for any Axiom Healthcare Suite products
to add to the column to, and click OK.

12. In the Edit Table dialog, click OK.

13. To view the new column, in theMain ribbon tab, click Refresh Data.

The new grouping column nowdisplays in the dimension.

Editing a dimension

The Dimension Maintenance utility allows you to edit the grouping columns for one or more products,
but the product options available to you depend on the role assigned to you. Axiom Financial Planning
administrators have rights to Financial Planning dimensions, Axiom Capital Planning and Capital Tracking
administrators have rights to Capital dimensions, and so on.

TIP: You never edit database tables directly in the database. Instead, data is pulled into
spreadsheets, where you can edit the data and then subsequently save it back to the database.

The columns that display depend on what products each column is assigned to using the Data Set
Assignment.

When editing dimensions, keep in mind the following:

l The products you select determine the columns you can view.
l The dimension you select determines the table you can edit.
l Your role determines the records you can edit.

Some dimensions are not included in the Dimension Maintenance utility. You can continue to access and
modify these dimensions from the Axiom product's Admin task pane, as usual. If the dimension you
open displays as read-only, this means that you need to use the Dimension Maintenance utility to
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modify it. For example, in Axiom Budgeting, when you open the DEPT dimension from Bud Admin task
pane > Budget System Maintenance > View Dimension Tables, the tab displays DEPT R/O. Though you
can view the dimension, you need to use the Dimension Maintenance utility to edit it. On the other
hand, if you open the INITIATIVEID dimension, the tab does not display R/O. This means that you can
modify the dimension as usual. This is because the INITIATIVEID table is not included in the list of tables
that aremaintained via the Dimension Maintenance utility. For a list of dimensions not included in the
Dimension Maintenance utility, see the Overview section.

IMPORTANT: Edit dimension data with extreme care, as any errors introduced could cause problems
throughout the system. Do not modify fields not described in Axiom documentation.

After you select the product(s) and dimension to edit, the Dimension Maintenance utility refreshes itself
and displays the different products and the columns that belong to them for the dimension. As seen in
the following example, the columns display in groups.

TIP: It is not always necessary to populate every field. Enter as much information in the dimension
table as you have available.

In the blue cells, you can do the following:

l Choose from a list of validated values by double-clicking the folder in the column next to the
grouping column.
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l Enter free-form values, though we recommend that you take into consideration any existing
values or rules for that column.

Grouping columns tagged as General display first, as shown in the previous example. General columns
are typical reference fields leveraged by multiple products. Each subsequent grouping displays based on
the products you selected. Records display depending on the security assigned to you. For example, if a
no write filter is assigned for that member, the dimension will return no records. For more information,
see Editing the security rights for a user.

IMPORTANT: If you are not sure whether to edit a cell, contact your system administrator.

Some columns in dimensions tables are validated, allowing only certain predefined values. If you enter
an invalid value, an error will occur when you save, specifying the cell so you may make a correction and
save again.

The following are examples of validated columns:

l RFCODE.RFStdLine – Used during the reporting process to identify the standard financial
statement categories to use for each RFCode category. (Same as Acct.FSDetail in Axiom
Management Reporting.)

l RFCODE.RFType – Used during the forecast workbook interface process to define the categories
within each model that an account or account group will be categorized into. (Similar to
BudgetType in the traditional budget workbooks.)

For more information, see Adding validations.

To edit a dimension:
1. Launch the Dimension Maintenance Utility.

2. In the RF Admin task pane, in theDimension Update section, double-click Dimension
Maintenance.

3. In the Cap Plan Admin task pane, in the Administration section, double-click Dimension
Maintenance.
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4. In the Cap Track Admin task pane, in the Administration section, double-click Dimension
Maintenance.

5. In the Cost Accounting Admin task pane, in the Costing Structure Maintenance section, double-
click Dimension Maintenance.

6. In the Bud Admin task pane, in the Budget System Maintenance section, double-click Dimension
Maintenance.

7. In theMain ribbon tab, click Refresh Data.
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8. In the Refresh Variables dialog, do the following:

a. In the Select The Product To Edit drop-down, select the product.

NOTE: The list of products that display is determined by the Axiom product licenses
that your organization owns.

b. In the Select a Dimension to Edit drop-down, select the dimension, and click OK.

9. To retrieve a smaller subset of data, you can use theQuick Filter in theWorkbook Options of the
Main ribbon tab.

For detailed instructions on how to use the feature, see Applying a Quick Filter to a report.

10. Enter the dimension member attribute information in the appropriate cells. You can type a value
in the cell free-form or select from a list of existing validated values. These are represented with a
folder icon next to the grouping column. You can do one of the following to enter validated values:

l Next to the column, double-click the folder icon. In the Choose Value dialog, select the
value, and click OK.

l If you have a large number of entries to make, instead of opening each folder, you can copy
and paste the validated value to other cells in the same column.

IMPORTANT: Do not change the format of cells in dimensions (e.g., number, date,
percentage, and so on).

11. After you finish making your changes, in theMain ribbon tab, click Save.
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NOTE: If a column is missing, then it is assigned to a different dimension or not assigned. For more
information, see Assigning an existing grouping column to a dataset (product).

Adding a dimension record

When you save the new dimension record, it displays in the existing table on the next utility refresh.

To add a dimension record:
1. Launch the Dimension Maintenance Utility.

2. In the RF Admin task pane, in theDimension Update section, double-click Dimension
Maintenance.

3. In the Cost Accounting Admin task pane, in the Costing Structure Maintenance section, double-
click Dimension Maintenance.

4. In the Bud Admin task pane, in the Budget System Maintenance section, double-click Dimension
Maintenance.

5. To select the product to add the new dimension record, do the following:
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a. Press F9 or in theMain ribbon tab, in theWorkbook Option group, click Refresh Data.

b. In the Refresh Variables dialog, from the Select The Product To Edit drop-down, select the
Axiom Healthcare Product.

c. From the Select a Dimension to Edit drop-down, select the dimension.

d. Click OK.

6. At the bottom of the workbook, click the Add_New_Dimension tab.

7. You can type a value in the cell free-form or select from a list of existing validated values. These are
represented with a folder icon next to the grouping column. You can do one of the following to
enter validated values:

l Next to the column, double-click the folder icon. In the Choose Value dialog, select the
value, and click OK.

l If you have a large number of entries to make, instead of opening each folder, you can copy
and paste the validated value to other cells in the same column.

8. For each record to create, in the Save? cell, click the drop-down box, and select Yes.

If you do not select Yes, the Save ? cell for the new dimension displays No with a red background
as a reminder that you need to save your changes. If you do not save your changes, the default
values you enter will not display. If you leave the values unpopulated, the system will populate
the defaults using those defined in the column properties in the dimension table.
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9. In theMain ribbon tab, click Save.

Upon Save, the new record posts to the database and the utility refreshes, moving the newly saved
record to theDimension Maintenance tab.

IMPORTANT: When adding new records, the field used as that user’s security filter must be
completed and within their filter before it will save successfully. If it is not, the system displays a
message that you cannot post this record to the database because it is outside of your write filter.
For example, if a security administrator using the Dimension Maintenance Security provides a filter
for Angela to grant her edit rights to the Department dimension for Entity =2, then Angela must enter
2 in the Entity column before saving. For more information about setting up security for the
Dimension Maintenance utility, see Editing the security rights for a user.

Best practices for setting up the ACCT dimension and statistics

The ACCT dimension contains records for each account in the General Ledger (GL) of your organization,
which includes balance sheet, income statement, hours, and statistics accounts. This topic focuses on
best practices for statistics and hours accounts in Axiom Budgeting and Performance Reporting.

� Overview
You can easily configure Axiom Budgeting and Performance Reporting system to use two types of
statistics:

l Key Statistic (ACCT.Type is KeyStat)
o For revenue producing departments, we recommend that you use a Key Statistic that is the

most directly connected to the resulting revenue.
o Inpatient Care Areas - Patient days
o Surgical Care Services - Operating Cases or Operating Minutes
o Outpatient Care Areas - Visits, Encounters, Procedures, or Cases
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o For non-revenue producing departments, we recommend that you use a Key Statistic that
is themost directly connected to the activity of those operations.

o Housekeeping - Square footage
o IT - Number of Devices
o Other Overhead Areas - Adjusted Patient Days

l Non-key Statistics (ACCT.Type is Statistic)
o Non-key statistics are statistics captured by the department for reporting purposes but are

not a primary driver of revenue and expenses. For example, a Labor and Delivery
department may track procedures, but Deliveries is the designated key statistic as it is most
directly connected to revenue and expense.

� Designing the statistic account structure
We recommend creating a statistic account structure to include the following categories of Key Statistics:

l Inpatient Statistics (KeyIP) – Used for hospital-billed patient revenue producing departments.
These statistics drive inpatient revenue calculations. If an individual department contains multiple
key statistic categories, the sum of KeyIP, KeyOP, and KeyOth will drive variable expense
calculations.

l Outpatient Statistics (KeyOP) – Used for hospital-billed patient revenue producing departments.
These statistics drive outpatient revenue calculations. If an individual department contains
multiple key statistic categories, the sum of KeyIP, KeyOP, and KeyOth will drive variable expense
calculations.

l Key Other Statistics (KeyOth) – This category serves a different purpose depending on
department type. For physician-billed patient revenue producing departments, these statistics
drive other patient revenue calculations. If an individual department contains multiple key
statistic categories, the sum of KeyIP, KeyOP, and KeyOth will drive variable expense calculations.
For non-revenue producing departments, this statistical category drives expenses.

A similar approach should be also considered for Non-Key Statistics:

l Inpatient Non-Key Statistics – Used for revenue producing departments. These statistics do not
drive inpatient revenue calculations, but they may be included for tracking purposes and other
reporting requirements.

l Outpatient Non-Key Statistics – Used for revenue producing departments. Tese statistics do not
drive outpatient revenue but may be included for tracking purposes and other reporting
requirements.

l Other Non-Key Statistics – Can be used for both revenue and non-revenue producing
departments. These statistics do not drive expenses and may be included for tracking purposes
and other reporting requirements.
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Other considerations
Many organizations track summarized statistic values such as Total Patient Days, Total Discharges, or
Adjusted Discharges. In some cases, these are tracked in a single department, such as “Facility Statistics”
or an administrative department. In other cases, the summarized statistic values are tracked in multiple
departments. For example, the key statistic for a Nursing Administration department may be Total
Patient Days and the key statistic for an Education department is also Total Patient Days. You should also
consider GL account numbers that enable easy identification of facility statistics versus those used for
department statistics.

� Units of Time (Hours) accounts
When considering Units of Time accounts, your account structure can be easily established based on
salary accounts. You may also want to capture hours by job classification.

TIP: If you do not currently track hours in your GL, we recommend prefixing the GL salary account
with a “9” to allow you to track hours with the related salaries.

NOTE: If payroll hours are not coming through your GL Import, you can nowmove your hours from
the Payroll12 data tables created from the previous process to your Financial tables by running the
Monthly to GL Accrual utility.

To determine Units of Time, first identify whether or not hours are included in your FTE calculations:

l Productive Hours
o Units of Time easily defined

o Regular
o Overtime
o Agency

o More difficult to define
o Education
o Orientation
o Call-Back
o Call-Pay

o Treatment of premium pay
o Differentials
o Call Pay
o Incentive Pay
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l Non-Productive Hours
o Units of Time easily defined

o PTO
o Sick
o Bereavement

o More difficult to define
o Education
o Orientation
o Jury Duty
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� Stat account example
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Working with dimensions
Dimensions are key fields in each data table. Each dimension has its own table that includes a series of
attributes (columns) for each element that further defines the dimension. These columns are leveraged
throughout various Axiom Healthcare Suite products in reports, planning processes, and plan file
configurations. Many dimensions, such as DEPT, are shared between various products.

When Axiom Healthcare Suite products are first implemented, a Kaufman Hall Implementation
Consultant helps you configure the dimension tables to reflect the organizational structure such as
departments, entities, accounts, and so on. Subsequently, editing dimensions to add new departments,
accounts, positions, pay types, or other items to the database is part of your routine system
maintenance.

IMPORTANT: Becausemany dimensions are shared across multiple Axiom Healthcare Suite
products, do not delete a grouping column or modify entries in the dimension tables without
consulting the administrators for the other applications.

Some columns in dimension tables are validated. This means they only allow certain predefined values
that are contained in validation system table. If you enter an invalid value, an error occurs when you
save, specifying the cell so you can correct it and save again using a corrected entry.

Examples of validated columns include:

l ACCT.Credit – Identifies which accounts should have their signs reversed during an import.
l PAYTYPE.CM_PayCategory – Defines which summary pay category to use for each Cost

Management plan file during a sequential interface. May also be used in reporting for grouping
PayTypes.

l JOBCODE.CM_PlanCode – Used for combining job codes during reporting and Cost Management
plan file creation. If there are historical values for two job codes that you want to report as one
combined job code, list the surviving job code on both lines.

Dimensions aremanaged and maintained using the Dimension Maintenance utility. This utility allows
users assigned the Product Administrator role to only manage grouping columns within specified
dimensions. It also limits these dimensions to only the elements that the Product Administrator role can
access. For more information, see theDimension Maintenance Utility Administrator's Guide, which you
can download from https://support.kaufmanhall.com/documentation/documentation.

ACCT

The ACCT dimension table contains records for each account in the GL of your organization. This includes
accounts that can be found on the balance sheet, income statement, hours, and statistics.

Refer to the Axiom EPM Dimensions Setup files (AcctCoding sheet) for codes to use in \Axiom\Reports
Library\System Files\Documents\Admin\Management Reporting\KHA EPM Dimensions Coding.xls.
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NOTE: Some dimension tables are shared across multiple Axiom products. As a result, some of the
columns listed in the following table may not display in the Dimension Maintenance Utility,
depending on the Axiom products in which your organization is licensed.

The following table lists all of the options available in this dimension table:

Column Description

ACCT The Axiom Software account number. This can be the combination of the prime
account and sub account, if that is how your GL system is set up.

Description The account description from the GL. Do not enter a description in all capital
letters. To remove the all-caps format in the spreadsheet, use the Proper formula
=Proper().

Credit Used during the interface process to reverse the signs so values are stored in a
positive condition in the database. Select one of the following valid entries:

l dr
l C

Normally, Revenue and Liabilities are C, and all others are dr.

RptMap Used to group accounts. Valid entries include any account numbers in the ACCT
column. The system automatically copies the information in the ACCT column to
this column during installation.

Statement Used to identify the Financial Statement category. Select one of the following
valid entries:

l BS (Balance Sheet)
l HoursJC (Jobcode Hours)
l Hours
l IS (Income Statement)
l KeyStat
l NI (New Initiatives)
l SCA (Cost Management)
l Statistic
l VCC (Variance Comments Collection)

NOTE: This is an Axiom standard column and categories cannot be added or
edited. The default value is NA.
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Column Description

Type Used to identify the major Financial Statement category. Select one of the
following valid entries:

l Asset
l Bmark (Benchmark)
l Capital
l Comments
l Deduction
l Equity
l Expense
l GenStat
l HoursJC (Job Code Hours)
l Hours
l KeyStat
l Liability
l NetAsset
l Plan
l Revenue
l Scenario
l Statistic
l Target (Hours codes that are not reported as FTEs should be coded as

Statistic.)

NOTE: This is an Axiom standard column and categories cannot be added or
edited. The default value is NA.

FSSummary Used to identify summary-level Financial Statement categories. For the naming
convention, use the first letter of the type category with an underscore and then
the category name. For example, R_PatientRev or E_Salaries.

NOTE: This is an Axiom standard column and categories cannot be added or
edited. Default value is NA.

FSDetail Used to identify line-item Financial Statement categories. For the naming
convention, use the first letter of the type category with an underscore and then
the category name. For example, R_IPRev, R_OPRev. For a list of the available
options, see Options for Acct.FSDetail.

NOTE: This is an Axiom standard column and categories cannot be added or
edited. The default value is NA.
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Column Description

FSPayor A variation of FSDetail used if GL accounts have payor categories; used for
Budgeting Deductions models. If this is not used, match to FSDetail. Categories can
be added or edited. The default value is a blank.

FPCode Used to identify the name of the Financial Planning category to use for
summarization during the integration process with Axiom Financial Planning. If
Axiom Financial Planning is not used, the default is NA.

FSProvider Used to identify line-item Financial Statement categories. For the naming
convention, use the first letter of the type category with an underscore and then
the category name. For example, R_IPRev, R_OPRev.

NOTE: This is only used if licensed for the Provider Budget Module. The default
value is NA.

FPCategory Used to identify the name of the Financial Planning category to use for
transferring the financial plan targets during the integration process with Axiom
Financial Planning. If Axiom Financial Planning is not used, the default is NA.

BPCode Used to identify the payors from the Budget Deductions report. During
installation, the system automatically copies the information from the FPCode
column to this column.

FlexStat Identifies the primary statistic used for Flexible Budgeting. The most common set
up is KeyTot for all stat, hours, and expenses. Revenue uses KeyIP for IP, KeyOP
for OP, and KeyOth for other patient revenue. The default is NA.

FlexPercent Identifies default variable percentage (0-100%) to use for Flexible Budgeting.
Values should be entered as decimals, 0.75 = 75%. The default value is 0 (zero).

ReclassType A grouping attribute that is useful in defining the type of reclass to use in the in
Axiom Cost Accounting reclass functionality.

AllocType Defines the type of account for indirect allocations in Axiom Cost Accounting.

FlexGroup Used to group accounts together for Flexible Budgeting. For example, Medical
Supplies or Other Expenses. The default is NA.

CostVarPct The Percent Variable for Axiom Cost Accounting; 0 = Fixed, which is used in the
costing processes to determine the dollar weighted variability for calculation
results.
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Column Description

KHAInt Used to identify which tab an account should be interfaced to during the budget
plan file create process. Valid entries include the following:

l To assign to all statistics, revenue, and deduction accounts that will be
budgeted in the budget plan files, type Stat_Rev .

l To assign to all expense and hours accounts that will be budgeted in the
budget plan files, type Expense.

l To exclude an account from all budget plan files, type NA.

KHAStdLine Used to identify default budget methodology used in budget plan files during
budget plan file creation. Refer to calc methods for Stat_Rev sheet and Expense
sheet in the Axiom Budgeting and Performance Reporting Administrator's Guide
(Budget Plan Files chapter) for valid entries and definitions. The default value is
NA.

Cost_Provider Used by the Axiom Cost Accounting system when performing the Provider RVU
costing method. This identifies the cost information at the account level that is
associated to the Provider, which is then allocated to his or her patients’ cost item
or chargeable activities.

KHABgtCode Used for combining accounts together during budget plan file creation. If there
are historical values for two accounts that you want to budget as one combined
account, list the surviving account number on both lines. If not combining
accounts, this value should match value in the Account column. The default value
is 0 (zero).
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Column Description

BudgetType Used to identify which category an account should be interfaced to during the
budget plan file interface process.

If KHAInt = Stat_Rev, valid entries are:

l IPRev

l OPRev

l OthPtRev

l OtherRev

l Allowance

l BadDebt

l KeyIP

l KeyOP

l KeyOth

l OthStat

If KHAInt = Expense, valid entries are:

l Salaries
l Benefits
l Supplies
l OtherExp
l PaidHours

The default value is NA.

DropDown Identifies Drop Down pick list when adding new accounts on Stat_Rev or Expense
sheets in the budget plan file. It should be the same as value in BudgetType
column.

CDMStdLine Used to identify default budget methodology for CDM budget plan files
(departments which have CDMStdLine in KHACMDimGrp column of DEPT
Dimension) during budget plan file creation. It is used similarly to KHAStdLine in
Budget Planning workbooks.

Valid entries are:

l Statistical accounts = CDMStatistic
l IP Revenue accounts = CDMIPRevenue
l OP Revenue accounts = CDMOPRevenue

Copy the remaining account assignments from KHAStdLine column.
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Column Description

KHASum Used to summarize information from the Stat_Rev and Expense sheets to the
Summary sheet within the budget plan files.

NOTE: This is an Axiom standard column and categories cannot be added or
edited. The default value is NA.

CYPMethod Used to identify the methodology used for projecting the remainder of the
current fiscal year. Valid entries are dependent upon values in KHAStdLine
column:

l Input Monthly, Detail, or any of the Fixed Options:
o Rolling12 – Use historical values from previous year's same months
o Annual –- Annualize YTD value
o RemBud – Use remaining budget
o CapBud – Use Total Budget less YTD actual
o PctBud – Use percentage of CY Actual over Budget

l Variable – Use Variable

l Labor – Use Labor

l FICA – Use FICA

l Hours – Use Hours

l GlobalExpense – Use GlobalExpense

l Depreciation – Use Depreciation

l IP_Per_Unit – Use IP_Per_Unit

l OP_Per_Unit – Use OP_Per-Unit

l Oth_Per_Unit – Use Oth_Per_Unit

PhyStdLine Used to identify default budget methodology used in the Provider budget plan
files (departments which have PhyStdLine in KHACMDimGrp column of the DEPT
dimension table) during budget plan file creation. Refer to Provider Version Only:
Calc Methods - Stat_Rev Sheet and Expense Sheet in the Axiom Budgeting and
Performance Reporting Administrator's Guide (Budget Plan Files chapter) for valid
entries and definitions. The default value is NA.
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Column Description

CYFMethod Used to identify the methodology used for projecting the remainder of the
current fiscal year in the current year forecast utility. This utility is available in
Axiom Budgeting and Performance Reporting in the Bud Admin task pane in
Financial Reporting > Financial Utilities > Current Year Forecast.

Statistics:

l Key Dept Statistics – See Forecast Methods below, normally use Trend
l Other Dept Statistics – See Forecast Methods below

Revenue:

l IP Revenue – IP_Per_Unit
l OP Revenue – OP_Per_Unit
l Other Patient Revenue – Oth_Per_Unit
l Other Operating Revenue – See Forecast Methods below

Salaries:

l Hours – See Forecast Methods below
l Salaries – Labor

All Other Accounts: See Forecast Methods below

Forecast Methods:

l IP_Per_Unit: YTD IP_Per_Unit * Forecasted Volume
l OP_Per_Unit: YTD OP_Per_Unit * Forecasted Volume
l Oth_Per_unit: YTD Oth_Per_Unit * Forecasted Volume
l Labor: Actual Hourly Rate * Forecast Hours * Budget Rate Change
l RemBud: Remaining Budget from CYB
l Annual: YTD / Calendar Days * Remainng Calendar Days
l Rolling12: YTD Actual / YTD Budget * Remainder of LYA
l PctBud: YTD Actual / YTD Budget * Remainder of CYB
l Variable: Actual Rate per Unit * Forecast Volume
l Trend
l CapBud: Remaining Budget not to exceed the annual budget

You can also add additional CYFMethod columns. Create a new CYFMethod
column and use this in conjunction with the CYFDimGrp column in the DEPT
dimension if you need to use a different CYP method for different departments.
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Column Description

BudStat Identifies Budget Statistic accounts used in Budget Statistics Driver. Standard
entries are:

l Admits
l PatientDays
l Discharges
l AdjDischarges
l Encounters
l ERVisits
l ClinicVisits

You can also create custom stats to use in the Budget Statistics Driver and identify
accounts appropriately. The default value is a blank.

CMStdLine Used to identify the StdLine for Axiom Cost Management.

KHAStandardClass KHA standard classification used for reporting.

BPCategory Used to identify the Budget Planning category.

NewDeptStdLine Used to set or update the calc method for each department.

InitStdLine Use to make accounts available for initiatives in the Axiom Budgeting budget
workbook.

In the Choose Value dialog for the InitStdLine, there are five validated values to
select from. The following table lists the Initiative Standard Lines that we
recommend you assign to each account type:

l Statistics accounts to use Detail Line
l Patient Revenue accounts to use Patient Revenue
l Other Revenue accounts to use Detail Line
l Deduction accounts to use Detail Line
l Labor accounts to use Detail Line
l Benefit accounts to use Detail Benefits w Percent
l All other expense accounts to use Detail Line
l Hours accounts to use Hours Line
l For accounts not configured, NA will be the default value

RFCode Identifies the RFCode for account. Only used with Axiom Rolling Forecast. The
default value is Z_Exclude.

CM_Group Used to summarize account types at a higher level for Axiom Cost Management
analysis and reporting needs.
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Column Description

InitType Used by the system to select the sections so that when the user refreshes the
plan file, the accounts will insert into the appropriate section of the Initiative
block in the Axiom Budgeting budget workbook.

In the Choose Value dialog for the InitType, you can configure up to seventeen
possible values. The section types available are noted in the following list. NA is
the default value until configured or for any account not configured.

l Benefits
l ContractLabor
l Deduction
l Depreciation
l Drugs
l Hours
l Interest
l IPRev
l NA
l OPRev
l OtherExp
l OtherRev
l ProFees
l PurchSvcs
l Salaries
l Statistic
l Supplies

CM_NonLabor Used to classify non-labor accounts in Axiom Cost Management according to
FSDetail. Valid entries include the following:

l Drugs
l KeyStats
l OtherExp
l PurchSvcs
l Supplies

These classifications are used in reporting and plan creation.

CM_Map Used to map accounts together in Axiom Cost Management. You can use this
column to map closed accounts with another existing account or to group like
accounts.

CM_TargetBgt Used to create team workbooks in Axiom Cost Management at the account level.
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Column Description

CM_FlexStat Used to identify the flex stat for Axiom Cost Management.

CMFlexPercent Used to identify the flex percentage for Axiom Cost Management.

DEPT

The DEPT dimension contains records for each department within an organization. For example,
radiology, emergency, finance, and so on.

The following table lists all of the options available in this dimension table:

Column Description

DEPT The Axiom Software department number, which is formed by combining the
entity and cost center.

Description The department description. The naming convention is entity abbreviation with
department description. For example, MHS Operating Room.

NOTE: For closed departments, add three asterisks to the beginning of the
description. For example, MHS *** Operating Room. Descriptions should not be
in all capital letters.

Entity The Axiom Software entity code. The description lookup table is in the ENTITY
dimension table. This should be the Business Unit, and match the first three to
four characters of the department number.

CostCenter The cost center portion of the department number. You can use this for
comparative reporting across entities, such as comparing the cost per unit of all
operating rooms across your health system.

RptMap Used to consolidate departments for reporting.

BudgetGroup A collection of departments used primarily for plan file purposes. This is
commonly setup by a KHA consultant during implementation but can easily be
updated by clients. For example, departments 16010 and 16020 may be assigned
to EMC budget group.

NOTE: BudgetGroup is a validated dimension so additions and deletions need to
first be added/deleted in the associated validation table.

ProdMap Used to consolidate departments for productivity reporting.

VP The Vice President responsible for the department. Use the naming convention
of FirstName LastName. This information is primarily used for rollup reporting.

Director The director responsible for the department. Use the naming convention of
FirstName LastName. This information is primarily used for rollup reporting.
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Column Description

Manager The manager responsible for the department. Use the naming convention of
FirstName LastName. This information is primarily used for rollup reporting.

Division The division for rollup reporting, which is defined by your organization. You can
use this information to consolidate types of departments together for reporting.
For example, you can use the word Radiology to combine all radiology
departments across all entities.

KHABgtTemplate Used to identify the template to use for plan file creation. Valid options include
the following:

l Master
l NoBudget
l RollingForecast

NOTE: This is an Axiom standard column and categories cannot be added or
edited. The default value is NA.

KHABgtCode Used to identify departments to combine during plan-file creation.

TplOptions Used to identify the template option based on licensed products. Valid options
include the following:

l Master (common for all clients)
l MasterCDM (used for clients licensed for CDM option)
l MasterProvider
l NoBudget
l RFProvider

CM_Template Used to assign a specific Axiom Cost Management plan template.

LaborType Used to identify the labor method to use for plan file creation. Valid options are:

l altEmployee
l Employee
l HHLabor
l JobCode
l JobCodeADC
l NoBudget
l Staffing

NOTE: This is an Axiom standard column and categories cannot be added or
edited. The default value is NA.

CM_Map Similar to RptMap, used to consolidate departments for reporting.
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Column Description

KHACMDimGrp Used to identify the Standard Line selected from the ACCT dimension for use in
budget planning specifically for the budget values. Valid options are the options
used on the ACCT dimension. For example the common ones uses include:
KHAStdLine, PHYStdLine.

CM_TeamMap Used to create team-planning workbooks. You can create teams by combining
like departments or like accounts for team Axiom Cost Management planning.

JobcodeDimGrp Used to designate which labor type distribution set applies to the associated
department. KHAInt is the standard set of job code labor types. PhyInt is the
modified set of job code labor types.

ProjDimGrp Used to identify the Standard Line selected from the ACCT dimension for use in
budget planning specifically for the projection values. Valid options are the
options used on the ACCT dimension. For example the common ones uses
include CYPMethod.

CM_Team Create teams by combining like departments for team Axiom Cost Management
planning.

KHABgtMap Used for combining departments during plan-file creation. This column is also
used when more than one department is needed in one plan file.

CM_Division Used to group similar departments for Axiom Cost Management reporting and
analytics.

CYFDimGrp Used to identify which CYFMethod column each department uses to forecast
accounts. Valid options are:

l CYFMethod - Uses the method specified in ACCT.CYFMethod
l NA - Not Applicable
l [Other Column Name] - Uses the method specified in the corresponding

column on the ACCT dimension table

FPNode Used to group the department to the appropriate FPNode in Axiom Financial
Planning.

ShowOnList_Costing Determines which departments to include in the unit cost processing.

CM_BMarkStatus Used to define which departments to include in Axiom Cost Management
benchmarking reports and analytics. Valid entries include the following:

l To include the department, type Yes.
l To exclude the department, type No.
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Column Description

FPType Used to group the department to the appropriate FPTYPE in Axiom Financial
Planning.

Owner Used to identify the network ID of the person responsible for initial input of the
plan file (i.e. Manager). It should be the same as their Axiom login ID. Naming
convention would be first initial, full last name (or whatever your network ID
naming convention is).

If your organization does not use this role for plan file approval, type [skip] in the
cell.

IMPORTANT: Do not leave this cell blank.

DeptType Determines the Direct or Indirect department category. Direct departments are
those that generally provide patient care services and generate revenue, while
Indirect departments are involved in support services and do not generate
patient care related revenue.

FPNodeBS Balance Sheet node for Axiom Financial Planning.

Reviewer The network ID of the person responsible for reviewing the cost management
plan, for example, Director. This information should be the same as the user's
Axiom Software login ID. The naming convention is first initial, full last name or
whatever your network ID naming convention is.

If your organization does not use this role for plan file approval, type [skip] in the
cell.

IMPORTANT: Do not leave this cell blank.

Approver The network ID of the person responsible for approving the cost management
plan, for example, VP. This information should be the same as their Axiom
Software login ID. The naming convention is first initial, full last name or whatever
your network ID naming convention is.

If your organization does not use this role for plan file approval, type [skip] in the
cell.

IMPORTANT: Do not leave this cell blank.

CM_DeptStandard Used for mapping departments to external benchmark data. This mapping
matches the department to the ExternalBMark information in the Axiom Cost
Management file groups.

CM_PdHrsMetricID The paid hours metric ID from external benchmark. Elements are validated to the
MetricID table. Used to link a department with specific metrics in the CM_
Benchmarks_yyyy tables. Used only in Axiom Cost Management.
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Column Description

CM_WkdHrsMetricID The metric ID for worked hours from external benchmark. Elements are
validated to the MetricID table. Used to link a department with specific metrics in
the CM_Benchmarks_yyyy tables. Used only in Axiom Cost Management.

CM_
NonLabor1MetricID

The metric ID for NonLabor 1 from external benchmark. Elements are validated
to the MetricID table. Used to link a department with specific metrics in the CM_
Benchmarks_yyyy tables. Used only in Axiom Cost Management.

CM_
NonLabor2MetricID

The metric ID for NonLabor 2 from external benchmark. Elements are validated
to the MetricID table. Used to link a department with specific metrics in the CM_
Benchmarks_yyyy tables. Used only in Axiom Cost Management.

BudLocalAdmin1 Used to select the local administrator for Axiom Budgeting.

CM_CombineStat Used to determine if key statistics should be combined when grouping
departments together with CM_Map grouping column for Axiom Cost
Management. Valid entries include the following:

l If the key statistics of the rolled up departments are to be cumulative, type Y.
l To only use the key statistics from the surviving department, type N.

CM_
NonLabor3MetricID

The metric ID for NonLabor 3 from external benchmark. Elements are validated
to the MetricID table. Used to link a department with specific metrics in the CM_
Benchmarks_yyyy tables. Used only in Axiom Cost Management.

CM_
NonLabor4MetricID

The metric ID for NonLabor 4 from external benchmark. Elements are validated
to the MetricID table. Used to link a department with specific metrics in the CM_
Benchmarks_yyyy tables. Used only in Axiom Cost Management.

CostMap Allows departments to processed as a group in the unit cost processing phase of
cost accounting. All costs for the group are combined and allocated to all of the
Cost Items within the group. In most cases, the first or largest department of the
groups becomes the target CostMap definition to which the other members are
mapped.

ShowOnList_Budgeting Used to identify if a department displays to be selected during the plan file
creation process. Valid entries include the following:

l True
l False

CM_
NonLabor5MetricID

The metric ID for NonLabor 5 from external benchmark. Elements are validated
to the MetricID table. Used to link a department with specific metrics in the CM_
Benchmarks_yyyy tables. Used only in Axiom Cost Management.

BudLocalAdmin2 Used to select the local administrator for Axiom Budgeting.
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Column Description

MarkupName The specified markup table to use when processing unit costs using the Reverse
Markup method.

NOTE: Currently only one table is available per department.

BudLocalAdmin3 Used to select the local administrator for Axiom Budgeting.

FinContact Used to assign the finance contact for a department during the cost management
process.

KeyStatDesc Used to identify the description of the primary statistic for each department.

FlexGroup Used for grouping departments together for the flexible budget utility. (For
example, Imaging).

FlexDept Used for defining each department as fixed or variable during the flexible budget
utility. Valid entries include the following:

l Yes
l No
l NA

Campus Used as part of Axiom Cost Accounting.

KHAStandardClass Used for reporting.

RFGroup Used to define your forecast groups. Consider:

l Management structure and cultural impact.
l Team concept versus individual department managers.
l The availability of a statistic that can be collected.

CM_ShowOnList Used to define which departments to build Axiom Cost Management plan files.
Valid entries include the following:

l To build a plan file, type TRUE.
l To exclude from plan file lists and build, type FALSE.

CM_PlanGroup Used to group departments together for applying assumptions and configurations
in Axiom Cost Management driver files.

CM_
ExtBenchmarkSource

The source name of the external benchmark to use for this department in Axiom
Cost Management. Used to link a department with the CM_Benchmarks_yyyy
tables.
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Column Description

ShowOnList_Capital Used to define which departments to build Axiom Capital Planning plan files. Valid
entries include the following:

l True
l False

PM_IT The IT reviewer assigned for Process Management in Axiom Capital Planning and
Capital Tracking.

PM_Facilities The Facilities reviewer assigned for Process Management in Axiom Capital
Planning and Capital Tracking.

PM_Clinical The Clinical Engineering reviewer assigned for Process Management in the Axiom
Capital Planning and Capital Tracking systems.

PM_Voting The owner of the prioritization process assigned for Process Management in
Axiom Capital Planning and Capital Tracking.

ProviderType Select, by dept, whether to use the Detail or Summary options for provider plan
files.

PM_Legal The Legal reviewer assigned for Process Management in Axiom Capital Planning
and Capital Tracking.

PM_HR The Human Resources reviewer assigned for Process Management in Axiom
Capital Planning and Capital Tracking.

PM_Purchasing The Purchasing or Supply Chain reviewer assigned for Process Management in
Axiom Capital Planning and Capital Tracking.

PM_CFO The Chief Financial Officer reviewer assigned for Process Management in Axiom
Capital Planning and Capital Tracking.

PM_CEO The Chief Executive Officer reviewer assigned for Process Management in Axiom
Capital Planning and Capital Tracking.

PM_BOD The Board of Directors reviewer assigned for Process Management in Axiom
Capital Planning and Capital Tracking.

PM_Accounting The Accounting reviewer assigned for Process Management in Axiom Capital
Planning and Capital Tracking.

CM_DeptSeries Groups departments into service lines or other client-defined series for Axiom
Cost Management analytics and reporting.

CDMCODE

The CDMCODE dimension table includes all the charge codes within an organization. The charge codes
are used to track gross revenue and statistics at an inpatient (IP) and outpatient (OP) level.
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The following table lists all of the options available in this dimension table:

Column Description

CDMCode Used in Axiom Budgeting. This must be an alpha numeric field so that during the
import process, a C is appended to all CDMCodes to ensure they are alpha
numeric.

Description Identifies the CDMCode description. Try to be as explicit as possible, avoid
abbreviations, and use layman’s terms. Descriptions should not be in all capital
letters. To remove the all-caps format in the spreadsheet, use the Proper formula
=Proper().

KeyStat Identifies which CDMCodes to use for key stat calculation. Valid entries include
the following:

l To count the code, select Yes.
l To exclude the code, selectNo.

To summarize all of the Yes codes as monthly key stats, use the Summarize
CDMCode utility. This utility is available in Axiom Budgeting and Performance
Reporting in the Bud Admin task pane, Financial Reporting > Financial Utilities >
RevUsag.

RVU Identifies an RVU value for each CDMCode. This RVU value is used to weight each
CDMCode for monthly reporting. To summarize all of the Yes codes as monthly
key stats, use the Summarize CDMCode utility.

This utility is available in Axiom Budgeting and Performance Reporting in the Bud
Admin task pane, Financial Reporting > Financial Utilities > RevUsage. This RVU
may also be used as a source for RVU information in the costing process.

IPStatAcct To summarize all of the Yes codes as monthly key stats, use the Summarize
CDMCode utility. This utility is available in Axiom Budgeting and Performance
Reporting in the Bud Admin task pane, Financial Reporting > Financial Utilities >
RevUsage.

If you use this report, list a valid account number from the IP Statistic ACCT
dimension to use to post to when running this utility each month.

OPStatAcct To summarize all of the Yes codes as monthly key stats, use the Summarize
CDMCode utility. This utility is available in Axiom Budgeting and Performance
Reporting in the Bud Admin task pane, Financial Reporting > Financial Utilities >
RevUsage.

If you are using this report, list a valid account number from the OP Statistic ACCT
dimension to use to post to when running this utility each month.

IPRevAcct Used for mapping if your organization is licensed for the CDMRevenue template.
This maps CDMCodes to IP revenue accounts in the budget process.
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Column Description

OPRevAcct Used for mapping if your organization is licensed for the CDMRevenue template.
This maps CDMCodes to OP revenue accounts in the budget process.

KHABgtCode Used for combining CDMCodes during budget plan file creation. If there are
historical values for two CDMCodes that you want to budget as one combined
CDMCode, list the surviving CDMCode on both lines. If you do not want to
combine codes, then the code for this column should be the same as the
CDMCode in the CDMCode column.

KHAStdLine Used during the budget creation process. Valid entries include the following:

l To budget that CDMCode, select CDM.
l To not budget that CDMCode, selectNA.

KHAINT Valid entries include the following:

l If RVU > 0, IPStatAcc > 0, KeyStat=Yes, select Include.
l If RVU<0, IPStatAcc < 0, KeyStat=No, select Exclude.

UBRev The Universal Billing Code associated with each charge code from your
chargemaster. If there is no code available, then enter NA. This column is used for
reporting purposes.

HCPCS_CPT The Health Care Procedure Coding System/Current Procedural Terminology
codes associated with each charge code from the chargemaster. If there is no
code available, then enter NA. This column is used for reporting purposes.

DATATYPE

The DATATYPE dimension is used to load provider-level to the data tables. Each record is tagged with a
DataType when loaded. Examples of DataTypes include Revenue, Visit, WRVU, and so on.

The following table lists all of the options available in this dimension table:

Column Description

DATATYPE The DATATYPE used in Axiom Budgeting and Performance Reporting. This must
be an alpha code.

Description Identifies the description to be use for budgeting and reporting.
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Column Description

BudgetType Used during interface to determine which section each data type should
interface to. Valid codes Include the following:

l Encounter
l Revenue
l RVU
l WRVU
l Volume
l NA

KHAInt Used to identify which tab an account should be interfaced to during the budget
plan file creation process. Valid entries include the following:

l Driver

l Statistic

l Financial

INITIATIVEID

Use the INITIATIVEID dimension when budgeting for initiatives, which may or may not be approved. It
allows for tracking the impact of proposed initiatives while keeping that data separate from the baseline
budget.

The following table lists all of the options available in this dimension table:

Column Description

INITIATIVEID The INITIATIVEID used in Axiom Budgeting. This is used during the budget process
to store new initiatives. InitiativeID 1 is used for baseline operations. All other
initiative numbering is determined by the system administrator and must be
numeric.

Description Identifies the INITIATIVEID description to use for budgeting and reporting.

InitType Groups initiatives together for reporting and categorization. Valid entries include
the following:

l Baseline (INITIATIVE 1 only)
l System - Initiatives that affect multiple departments.
l Dept - Initiatives for a single department.
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Column Description

Approve The coding for Approve/Exclude for new initiatives. Valid entries include the
following:

l Baseline (applies only to INITIATIVEID 1)
l Approve - Initiatives that have been approved.
l Exclude - Initiatives that are declined or deleted.

SaveCustom Used to save from the Axiom Budgeting plan file to this dimension table.

IMPORTANT: Do not alter or recode.

SaveTagDocID Used to save from the Axiom Budgeting plan file to this dimension table.

IMPORTANT: Do not alter or recode.

Profile The profile type to apply to the initiative.

To not use a profile, type NA.

For more information on setting up initiative profiles, see "Setting up initiatives" in
the Axiom Budgeting online help.

JOBCODE

The JOBCODE dimension table includes records for all of the JobCodes within your organization. Each
JobCode represents a job position or role within the organization.

The following table lists all of the dimension options available in the JOBCODE dimension table:

Column Description

JOBCODE The Axiom Software job code. This entry must be an alpha-numeric field so that
during the import process a J is prepended to all job codes to ensure they are
alpha numeric.

Description The job code description from the payroll system. Do not type descriptions using
all capital letters. To remove the all-caps format in the spreadsheet, use the
Proper formula =Proper().

GLAcct The GL account where regular dollars are posted on the GL. If your payroll data
maps to the GL based upon pay type, type 0(zero).

HRAcct The GL account where regular hours are posted on the GL. If your payroll hours
map to the GL based upon pay type, type 0(zero).

FICAAcct The FICA account code to use for each job code. You can use this to allocate FICA
expense to different accounts by job code.
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Column Description

JobClass The major job classes of individual job codes. You can use this to apply salary
increases for specific groups. Commonly used entries include the following:

l Management
l Physician
l Professional
l Technical
l RN
l LPN
l Assistant
l Support
l Other
l Clerical
l Contract

GLClass Used to identify the GL Class each job code is assigned to for budget and reporting
salary-mapping purposes. The exception-mapping table is located in the
GLPayrollMapping table. If mapping payroll by job code or pay type is not an
option, this mapping table allows for special exceptions for payroll mapping.

Variable Used to identify JobCodes, which are sensitive to volume changes. Valid entries
include Fixed and Variable.

KHABgtCode Used for combining accounts together during budget plan file creation. If there
are historical values for two accounts that you want to budget as one combined
account, list the surviving account number on both lines. If not combining
accounts, this value should match value in the Account column. The default value
is 0 (zero).

KHAInt Used to identify which tab an account should be interfaced to during the budget
plan file create process. Valid entries include the following:

l JOBCODE
l PROVIDER
l To exclude an account from all budget plan files, type NA.
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Column Description

PhyInt Used to create an alternative to the KHAInt classification for the associated job
code.
Valid entries include the following:

l JOBCODE
l PROVIDER
l NA indicates the value will default to the value currently in the KHAInt

column.

FTEFactor (Optional depending on license) Defines the FTE factor for a two week period.
Generally, this is set to 80 for all job codes. If your organization uses varying FTE
Factors by job code, this may be different.

StdHours Used to identify the standard FTE hours worked in a year. Options include Default,
which is 2086 hours, and 2080. For more information, see "Working with FTE
standard working hours" in the online help.

RFCODEGL In Axiom Rolling Forecast, this may be used to allocate salaries to specific salary
related RFCodes.

RFCODEHR In Axiom Rolling Forecast, this may be used to allocate hours to specific hours
related RFCodes.

FPCategory Used to identify the name of the Financial Planning category to be used for
transferring the financial plan targets during the integration process with Axiom
Financial Planning. If Axiom Financial Planning is not used, the default is NA.

CostHR The Prod Hours Account Definitions for Costing

CostGL The Prod Dollars Account Definitions for Costing

CostClass An alternative grouping column used in the costing process that is invoked during
the loading of payroll information into the CGL as statistics to support a payroll
related reclassification of GL dollars or hours.

CostVariable Not used at this time.

ResourceJobClass Used in the RVU developer process by the mapping of job codes to a Resource
Job Class, which determines the level of detailed RVU development for labor
resources. This attribute is also used in the mapping of payroll hour and dollar into
an average wage rate in the resource table that then drives the calculation of the
RVU.

CM_PlanCode Used for combining job codes during reporting and plan file creation in Axiom
Cost Management. If there are historical values for two job codes that you want to
report as one combined job code, list the surviving job code on both lines.

Setup Guide Axiom Budgeting │ 105



PAYTYPE

The PAYTYPE dimension table includes records for all of the possible categories of compensation that an
employeemight receive. For example, regular pay, paid time off, sick pay, incentive pay, and so on.

The following table lists all of the options available in this dimension table:

NOTE: Some dimension tables are shared across multiple Axiom products. As a result, some of the
columns listed in the following table may not display in the dimension, depending on the Axiom
products in which your organization is licensed.

Column Description

PAYTYPE The Axiom Software pay type. This must be an alpha-numeric field, so that during
the import process, a P is prepended to all pay types to ensure they are alpha
numeric.

Description Identifies the pay type description from the payroll system. Be as explicit as
possible, avoid abbreviations, and use layman’s terms. Do not enter a description
using all capital letters. To remove the all-caps format in the spreadsheet, use the
Proper formula =Proper().

PaySummary Used in reporting to identify major pay categories. Select one of the valid entries:

l Prod
l NonProd
l Other
l Stat
l NA

PayDetail Used in reporting to identify detail pay categories. Select one of the valid entries:

l Contract
l NA
l NonProd
l Other
l Overtime
l Regular
l Stat
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Column Description

LaborDist The variation of PayDetail used in Labor Distribution reporting. Valid entries
include the following:

l Regular
l Education
l PTO
l Overtime
l OnCall
l Other
l Contract
l Stat
l NA

FTE Indicates whether to include hours in FTE calculations. Select one of the valid
entries:

l To assign to pay types to count for FTE calculations such as Regular, Overtime,
Education, PTO, Jury Duty, Bereavement, Sick, and so on, select Yes.

l To assign to pay types to not count for FTE calculations such as Differentials,
Call Pay (not callback), Bonus, Benefits, and so on, selectNo.

l To assign to your productivity stat pay types, select Stat.
l If none of the above scenarios apply, selectNA.

Empl_Detail Used to identify pay types that are FTE related for employee-level budgeting.
Select one of the valid entries:

l If it is FTE-related, select Z_Employee.
l If it is not FTE-related, selectNA.

KHAInt Used to identify pay types to include in plan file processing. Select one of the valid
entries:

l To assign pay types to include in the JobCode block (generally FTE=Yes), select
JobCode.

l To assign pay types to include in the JobCode block as additional dollars
(generally FTE=No; examples include call pay, differentials, bonus, etc.), select
Dollars.

l To assign pay types to budget at the department (not job code) level, select
Dept.

l To assign pay types to exclude from the budget workbooks such as PTO
sellback, reimbursement\adoption reimbursement, car allowance, benefit
expenses, and so on, selectNA.
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Column Description

GLAcct Used to identify the account number to use for dollars on the GL. Do one of the
following:

l If your payroll data maps to the GL-based upon job code, type 0(zero).
l If your payroll data does not map to the GL-based on job code, type the GL

salary account from the ACCT dimension table.

HrAcct Used to identify the account number to use for hours on the GL. Do one of the
following:

l If your payroll hours map to the GL-based upon job code, type 0(zero).
l If your payroll hours do not map to the GL-based on job code, type the GL

hours account from the ACCT dimension table .

JobCode The pay type summary groupings used for plan-file processing when using the
Jobcode labor method. The code used must be a valid pay type.

Staffing The pay type summary groupings used for plan-file processing when using the
Staffing labor method. The code used must be a valid pay type.

Employees The pay type summary groupings used for plan-file processing when using the
Employee labor method. The code used must be a valid pay type.

Providers The pay type summary groupings used for plan-file processing when using the
ProviderComp labor method. The code used must be a valid pay type.

KHAStdLine Used to identify default budget methodology used in budget plan files during
budget plan file creation. Refer to the calc methods for the Stat_Rev sheet and
Expense sheet in the Axiom Budgeting and Performance Reporting
Administrator's Guide (Budget Plan Files chapter) for valid entries and definitions.
The default value is NA.

CDMStdLine Used to identify default budget methodology for CDM budget plan files
(departments which have CDMStdLine in KHACMDimGrp column of DEPT
Dimension) during budget plan file creation. It is used similarly to KHAStdLine in
Budget Planning workbooks.

Valid entries include the following:

l Statistical accounts = CDMStatistic
l IP Revenue accounts = CDMIPRevenue
l OP Revenue accounts = CDMOPRevenue

Copy the remaining account assignments from KHAStdLine column.
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Column Description

Accrue Used to identify paytypes to be included when using the payroll accrual utility.
Valid entries include the following:

• To accrue during monthly payroll accrual process, type Yes.

• To not accrue during monthly payroll accrual process, type No or NA.

RFPAYCLASS Not used at this time.

Cost Variable Not used at this time.

CM_PlanCode Used for combining pay types during Axiom Cost Management reporting and
plan-file creation. If there are historical values for two pay types that you want to
report as one combined pay type, list the surviving pay type on both lines.

CM_PayCategory Used in Axiom Cost Management to group individual pay types into summary
categories for planning purposes. Examples include the following: Regular,
Overtime, Education, PTO, Contract, Other, Stat.

CM_Paid Used to identify the pay type to include in the Paid Hours calculations in Axiom
Cost Management. Valid entries include the following:

l For paytypes that will be included in paid hours, select Yes.
l For paytypes that will not be included in paid hours, selectNo.

CM_Worked Used to identify the pay type to include in the Worked Hours calculations in
Axiom Cost Management.

l For Pay Types that will be included in worked hours, select Yes.
l For Pay Types that will not be included in worked hours, selectNo.

CM_PaidDLLRS Used to identify the pay type to include in the Paid Dollars calculations in Axiom
Cost Management.

l For Pay Types that will be included in paid dollars, select Yes.
l For Pay Types that will not be included in paid dollars, selectNo.

CM_WorkedDLLRS Used to identify the pay type to include in the Worked Dollars calculations in
Axiom Cost Management.

l For Pay Types that will be included in worked dollars, select Yes.
l For Pay Types that will not be included in worked dollars, selectNo.

ResourceCalculation Determines the calculation behavior for the hours or dollars within the PAYTYPE
when using the payroll information within the RVU development process. When
labor rates are calculated for the Resource Table, the designation here
determines if the Hours, Dollars, or Both are to be used in the numerator and
denominator in the average.
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Column Description

CMStdLine Used during the interface process to assign the standard planning method to use
for each pay type. In other words, this identifies the desired formula to use to
calculate Axiom Cost Management initiatives. It is used similarly to KHAStdLine in
Budget Planning workbooks.

Options for Acct.FSDetail

l A_AccumDepr
l A_AR
l A_ARAllow
l A_BoardInvest
l A_BondAmort
l A_BondCost
l A_Cash
l A_CashInvest
l A_CIP
l A_CurLtdAsset
l A_CurOtherAsset
l A_CurReceivable
l A_Inventory
l A_Land
l A_LTNotesRec
l A_LTOtherAsset
l A_PPE
l A_Prepaid
l A_RelatedParty
l A_ThirdPartyRec
l A_Trusteed
l C_Comments
l D_BadDebt
l D_Charity
l D_Contractual
l D_Discounts
l E_BadDebt
l E_Benefits
l E_Depreciation
l E_Drugs
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l E_Insurance
l E_Interest
l E_MaintRepairs
l E_MedSupplies
l E_OtherExp
l E_OthSupplies
l E_ProFees
l E_PurchSvcs
l E_RentLease
l E_Salaries
l E_SalariesContract
l E_SalariesMid
l E_SalariesPhy
l E_Utilities
l F_ContractFTEs
l F_NonProdFTEs
l F_OvertimeFTEs
l F_ProdFTEs
l H_Contract
l H_JCHours
l H_Midlevel
l H_NonProd
l H_Overtime
l H_Physician
l H_Prod
l L_AccExpense
l L_AccPayroll
l L_AP
l L_CurLTDebt
l L_CurOthLiab
l L_LTDebt
l L_LTOther1
l L_LTOther2
l L_ThirdPartyPay
l M_BmarkAdjD
l M_BmarkNOR
l M_DEPUOS
l M_NonLabor
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l M_ONLPUOS
l M_PSPUOS
l M_SEPUOS
l M_TContPct
l M_TEducPct
l M_TEPUOS
l M_TFTERate
l M_TOTPct
l M_TPHUOS
l M_TUOSRate
l M_TWHPUOS
l N_NetAsset
l N_NetAssetPerm
l N_NetAssetTemp
l NA
l Q_Restricted
l Q_RestrictedPerm
l Q_RestrictedTemp
l Q_Unrestricted
l R_IPRev
l R_NonOpContrib
l R_NonOpExtraord
l R_NonOpGainLoss
l R_NonOpInterest
l R_NonOpInvest
l R_NonOpOther
l R_NonOpRev
l R_OPRev
l R_OtherRev
l R_OthPtRev
l S_Admits
l S_Deliveries
l S_Discharges
l S_Encounters
l S_ER Visits
l S_GenStat
l S_Global
l S_KeyIP
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l S_KeyOP
l S_KeyOth
l S_Newborn
l S_OthStat
l S_PatientDays
l S_PayorDays
l S_PayorDisch
l S_PayorVisits
l S_StatOth
l Z_Exclude

Mapping the PAYTYPE dimension

Working with Drivers
Driver files contain rates, statistics, and other drivers that your budget plan files reference to help
calculate data. Driver files can also contain global values such as calendar information.

The data in driver files is ultimately saved to the database into one or more driver tables. These driver
tables can then be referenced by templates/plan files to calculate planning data or determine other
global settings for the file group.

In Axiom Budgeting 2019.3, the file group for each year's budget contains a set of driver files that display
configuration settings and Budget Assumptions (key statistics) referenced by all of the other files within
the file group.
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The configuration settings in the driver files can impact the structure of budget plan files in the following
ways:

l Show or hide sections of sheets, columns, and rows.
l Set default values and parameters within budget plan files, including:

o Pay types
o Number of pay periods
o Thresholds for flagging variances
o Column headings

Budget Assumptions are used in calculations throughout the entire budgeting process.

Examples of Budget Assumptions include:

l Inflation rates
l Labor merit increases and benefits percentages
l Revenue rates
l Any other statistics that impact multiple budgets

NOTE: Whenever you create a new budget, review the assumptions and settings in the driver files to
make sure they still apply to the current year.

Cells in driver files are color-coded as follows:

l White shading – Cells cannot bemodified.
l Blue shading – Input or modify data in the cell.
l Green shading – Choose from a drop-down selection of entries.

Depending on a user's security profile settings, certain parts of a driver file may be protected.

IMPORTANT: Any changemade to the configuration settings and assumptions in the driver files can
impact the structure and contents of any number of related budget plan files.

The Budget Driver is referred to as a rebuildable driver. This means that the driver stores and controls
information using data tables, which provides the ability to control who can edit driver data and what
driver data each can edit. A rebuildable driver also provide other benefits:

l Secure access to default driver settings – You determine who can edit the default sections in each
driver table.

l Secure access to budget group exceptions – You determine which Budget Groups each product
admin member can view and edit.

l Filtered data access –When editing the driver, filtered data access provides improved
performance.

Setup Guide Axiom Budgeting │ 114



l Multi-user driver file access – You can havemultiple members responsible for separate budget
groups access the same driver at the same time.

l Updatability and enhancements – By removing the persistent file requirement, Kaufman Hall can
provide you enhanced driver templates without any risk to current parameters and construct.

l Calc methods included – You can add additional sections/rows with double-clicks instead of
manually. You can save or delete each section using the drop-down next to each budget group
section.

NOTE: Axiom Budgeting driver files may reference dimension tables shared with other applications.

Throughout the driver files, you define default settings and assumptions for use throughout the file
group. In some cases, however, you might want to make exceptions for certain groups of departments,
accounts, and so on. These groupings of exceptions (particularly departments) are referred to as Budget
Groups. Many of the driver files include fields where you can indicate how budget groups are defined
within the dimension tables.

After the driver data is stored in data tables, you must establish security by doing the following:

l Allowmultiple users to access the driver files at the same time.
l Configure a user to only have access to the correct budget group sections or all sections of each

driver file.

Opening budget driver files
There aremany drivers available in Axiom Budgeting. You can access most of them from the Bud Admin
task pane.

To open budget driver files:
1. In the Bud AdminBud Admin task pane, in the Budget Assumptions section, do one of the

following:

l To open next year's budget drivers, click Access NY Budget Assumptions.
l To open this year's budget drivers, click Access CY Budget Assumptions.

2. Double-click the driver.

3. Refresh the variables by doing the following:

NOTE: Not all drivers include the ability to select variables, depending on the purpose of the
driver.
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a. In theMain ribbon tab, click Refresh Data, or press F9.

b. In the Refresh Variables dialog, for each variable option, click Choose Value.

c. In the Choose Value dialog, select one or more variables, and click OK.

TIP: If the dialog displays a large number of variables, you can use the Select All or
Clear All to select or deselect all the selections in the check boxes. If you do not select
check boxes for any variables, the system automatically includes all of the variables in
the driver. If you click Cancel, no variables are included in the driver, and it displays
blank.

4. After you make your changes, in theMain ribbon tab, click Save.

Order to set up drivers
Set up the drivers in the following order:

1. Budget Configuration

2. Budget Labor Configuration

3. Budget Statistics

4. Budget Driver

5. Budget Depreciation

6. Budget Global Data Configuration

7. Budget Global Data 1

8. Budget Global Data 2

9. Budget Global Data 3
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10. Budget Global Data 4

11. Budget Global Expense

12. Budget Revenue GlobalRev

13. Budget Expense Adjustments

14. Budget Labor Rates

15. Budget Assumptions

16. Budget CDM Config

17. Budget CDM Overrides

18. Budget Expense Admin Adjustments Setup

19. Budget Expense Admin Adjustments

20. Budget Global Sum

21. Budget Labor Accounts

22. Budget Labor ADC Config

23. Budget Labor Alt FTE Factors

24. Budget Labor Benchmark driver

25. Budget Labor JobCode Dropdown

26. Budget Labor Limits

27. Budget Labor Override

28. Budget Labor Target

29. Budget Provider Configuration

30. Budget Provider

31. Budget Provider Global Provider

32. Budget Provider GlobalVolChg

33. Budget Provider List

34. Budget Provider Simple Config

35. Budget Provider Simple Dept Config Basic

36. Budget Provider Simple Dept Rate

37. Budget Provider Vol

38. Budget Revenue Adjustments

39. Budget Revenue Deductions
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40. Budget Revenue Payor Adjustments

41. Budget StatAcct

42. Budget Statistics Supplement

Summary of commonly used drivers and use of global assumptions
Driver Global BudgetGroup Comments

Budget
Assumptions

Budget Driver

Plan files will default to
Global if BudgetGroup
block is not built out

Exceptions

Budget
Configuration

Budget Labor
Configuration

Plan files will default to
Global if BudgetGroup
block is not built out

Exceptions BudgetGroups built
out in both drivers
must match

Budget
Depreciation

Budget
GlobalData (1-4)

Budget GlobalExp

Budget
GlobalSum

Budget Revenue
GlobalRev

NA BudgetGroup/DEPT/ACCT
specific

Budget method must
be identified in
ACCT.KHAStdLine

Budget Expense
Adjustments

FSDetail level only

Plan files will default to
Global if BudgetGroup
block is not built out

FSDetail or ACCT level.

Budget Labor
Benchmark

NA NA DEPT specific,
regardless of
BudgetGroup

Budget Labor
Limits

NA NA JOBCODE specific,
regardless of
BudgetGroup

Budget Labor
Override

NA BudgetGroup, DEPT, or
DEPT/JOBCODE specific
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Driver Global BudgetGroup Comments

Budget Labor
Rates

Global, Jobclass, or
Jobcode specific

Plan files will default to
Global if BudgetGroup
block is not built out

Global, Jobclass, or
Jobcode specific

Budget Labor
Target

NA NA DEPT/JOBCODE
specific, regardless of
BudgetGroup

Budget Revenue
Adjustments

Global IP, OP, Other
Patient, Other Revenue

Global or ACCT specific IP,
OP, Other Patient, Other
Revenue

Budget Statistics Includes high level stats
only - Calendar &
Worked Days, Paid
Hours, Consolidated
Stats (Admissions,
Discharges, Patient
Days, Outpatient Visits,
ER Visits)

Consolidated Stats
summarize
BudgetGroups

Includes Admissions,
Patient Days, Discharges,
Adjusted Discharges,
Calendar Days, Worked
Days

Budget Assumption and Configuration drivers
The following table includes a description of each type of assumption and configuration driver:

Driver Description

Budget Configuration Use to configure a variety of general settings that affect themajority of
budget plan files.

TIP: Usually the first driver you edit prior to creating a budget.

Budget Driver Use to assign a driver statistic either to the facility or to an individual
department, and assign a default statistic to be used if a department does
not currently have a database statistic.
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Driver Description

Budget Assumptions Use to control the contents of the Instructions and Planning sheets in
budget plan files.

Budget Depreciation Use to designate an alternative location for entering depreciation for
specific expense accounts shared across departments without having to
divide the depreciation between multiple budget plan files.

Current payroll period
driver

Use to change the current period for the Payroll 27 tables.

Service Line data
tables

Use to configure the import into tables that store your Decision Support
data (DSS).

Budget Configuration

� Overview
This driver contains a variety of general configuration settings that affect themajority of budget plan
files. This is typically the first driver file you edit prior to creating a budget.

The Budget Configuration driver is divided into a Global Setup section with settings that apply system-
wide and a section with default settings, followed by separate sections for each defined budget group.
Each section contains the following:

� Global Setup
Open the driver, and then configure the Global Setup parameters to apply to all the budget plan files.
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Settings in this section include:

Option Definition

Dept Dimension
Grouping Code to be
used for Global
Assignments

Define the groupings by which the system will build and assemble the plan
files.

Use KHACMDimGrp? Define from the ACCT dimension which Stdline to use for the department.
For example, if the budget plan file is a typical basic operating plan file used
in a hospital, then you would use Account KHAStdline. For a physician
department, you would likely select Physician KHAStdline.

Activate Red Flag
Popup?

For certain values, you can set variance thresholds which, if exceeded,
cause a red flag icon ( ) to display. Select one of the following options to
determine whether or not the user needs to address the threshold by
entering a comment:

l Yes -When the threshold is met, require the user to enter a comment
in the Comment field before they can save the plan file.

l No - Allow the user to save the plan file without entering comments.

Expense Transaction
Drilling, On or Off?

Select one of the following:

l On - To allow users to drill down to a subsidiary General Ledger in the
Expense tab.

l Off - To not allow users to drill down in the Expense tab.

Dept Column Width? By default, the department column width is 15 pt. Use this field to enter
different column width size.

NOTE: If you enter a size larger than 15 pt, large numbers will display in
scientific notation (i.e. #######).

Acct Column Width? By default, the account column width is 15 pt. Use this field to enter
different column width size.

NOTE: If you enter a size larger than 15 pt, large numbers will display in
scientific notation (i.e. #######).
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� Budget Setup section
The Budget Setup section for each budget group defines basic parameters such as pay periods and start
and end months for the fiscal year.

Settings in this section include:

Option Definition

Payroll27 - YTD
Biweekly Pay Periods

Indicates howmany pay periods have elapsed in the current fiscal year, in
case you need to create a budget for a fiscal year already in progress.

Financial - Current
Fiscal Year Period

Indicates the current fiscal year period, in case you need to create a budget
for a fiscal year already in progress. When you build a new budget, the
Current Period entered heremust equal the Current Period of your data
sources.

IMPORTANT: Be sure to enter a specific number. Do not use the
KHAPeriod formula (which returns the current period) in this cell, as it will
cause your data to become out of sync as the value of KHAPeriod changes.
Changing the value recalculates the YTD calendar days, impacting
calculations throughout the system. For example, if this field is mistakenly
set to seven months but the budgets were built using 8months of data,
most values will be overstated.

Year of Fiscal Year End The calendar year in which the budget's fiscal year ends.

Fiscal Year Beginning
and End Month

Themonth in which the fiscal year begins and ends for each budget plan
file.

Current Year
Beginning and YTD
Date

The date when the current year budget began and the date when YTD data
was imported.

� Budget Tab Settings section
This section configures the sheet headings for time period columns in budget plan files.
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Settings in this section include:

Option Definition

Month End Determines the end date for all monthly spread sections in budgeting
driver and plan files.

NOTE: This must be updated for the current year end at the beginning of
each new budget cycle.

Months in Period Designates the number ofmonths in each period, typically 12 for past year
actual data, but may vary for the YTD period versus projected period for
the current year.

Days in Period The total number of business days in the period.

NOTE: Must be updated for each budget year.

Identify columns to
hide in budget
workbooksplan files

Enter the names of any columns you wish to hide on the Stat_Rev and
Expense sheets in budget plan files.

Print Suppressor to
hideWB columns

Designates which columns have been suppressed per the previous row.

Identify columns to
hide in Summary Tab

Allows you to control which columns to display on the Summary sheet of
the budget plan files. Set to Yes to hide, No to display in the budget plan
files.

Print Suppressor to
hide Summary
columns

Designates which columns have been suppressed per the previous row.

� Red Flag Parameters section
This section determines if and when users will be required to enter comments for variances in budget
plan files (for more information, see the chapter on Variance Reporting).

Settings in this section include:

Option Definition

Percent Increase
Threshold

Sets the percentage variance above budget for which users will be required
to enter an explanation.

Percent Decrease
Threshold

Sets the percentage variance below budget for which users will be required
to enter an explanation.
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Option Definition

Dollar Threshold (+/-) Sets a strict dollar amount above or below budget for which users will be
required to enter an explanation

� Other Tab Parameters section
This section addresses additional configuration options for budget plan files:

Settings in this section include:

Option Definition

Use Preliminary
Estimate on Detail
Calc Method?

If set to Yes, the preliminary estimate displays on the detail sheet in
budget plan files. If set to No, the system will hide the preliminary estimate
row.

Display Contribution
Margin on Summary
Tab?

If set to Yes, the contribution margin row displays on the Summary sheet
in the budget plan files. If set to No, the system will hide the contribution
margin row. To display themargin, choose a custom name for that row on
the Summary sheet.

Use Forecast for
Current Year
Projection?

Select Yes orNo.

Show Initiatives Tab? Select to Show or Hide the Initiatives tab.

Show Plan Tab? Select to Show or Hide the Plan tab.

Show Empl_List tab
with JobCode and
Staffing Tabs?

Select to Show or Hide the Empl_List tab with the JobCode and Staffing
tabs.

Show Empl_List tab
with Employee Tab?

Select to Show or Hide the Empl_List tab with the Employee tab.

ShowNet Revenue
section on Stat_Rev
tab (Requires Global
Sum Setup)?

Select to Show or Hide the Net Revenue section on the Stat_Rev tab.
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Budget Driver

� Overview
This driver is used for two major purposes:

1. Assign a driver statistic either to the facility or to an individual department.

l These drivers must exist in the Statistics sheet.
l The code requested is the same code that is in column A of the Statistic worksheet which is

a combination of columns B & C in the Statistic worksheet.
l A red flag will indicate if an incorrect code has been input (refer to screen shot example).

2. Assign a default statistic to be used if a department does not currently have a database statistic.

l Departmental Exceptions from the facility assignment can be entered in the lower half of
this sheet (refer to screen shot below).

The Driver sheet contains the following columns for each entity:

l BudgetGroup Code
l Department Description
l IP Driver
l OP Driver
l Default Statistic

Drivers must be defined in column A on the Statistics sheet in order to be used.
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� Settings
Open the driver, and complete the driver settings, as needed.

Budget Assumptions

� Overview
Use this driver to control the contents of the Instructions and Planning sheets in budget plan files. It is
probably best to revisit this section after you have gone through the process of creating a budget and
viewed these sheets in the context of a budget plan file.
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� Settings
Open the driver, and define different sets of instructions and planning questions for each Budget Group.

Each section has three columns:

l Budget Instruction Process Steps –Modify the description of each step.
l Due – Enter the due date for step.
l Use – Enter or modify the link.

Open the Budget Assumptions driver, and then use the following table to complete the settings in this
driver, as needed:

Option Definition

Budget Contact Type the contact information for the Budget Administrator in case end
users have any questions.
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Option Definition

Budget Assumptions Input key budget assumptions in this section to display for the user's
reference. Again, this is strictly for reference. These are not the cells that
the system refers to for assumptions data when performing actual
calculations.

Budget Planning
Account

Type the account used to store plan tab answers.

Planning Questions Type the questions to display on the Planning sheet in budget plan files.

Budget Depreciation

� Overview
This driver provides an alternative location for entering depreciation for specific expense accounts shared
across departments without having to divide the depreciation between multiple budget plan files.

To use this driver, set the budget method (KHAStdLine) in the ACCT dimension table to Depreciation.

To add a new department to the driver, double-clicking theDouble click to Insert New Department cell.

� Settings
Open the driver, and complete the driver settings, as needed.

Configuring the current payroll period

Use the Change Payroll 27 Tables-Current Period utility to change the Payroll 27 tables current period.

NOTE: You must have the Administrator role profile to access this utility.

To configure the current payroll period:
1. In the Bud Admin orManagement Reporting Admin task pane, in the Budget System

Maintenance section, double-click Change Payroll 27 Tables-Current Period.
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NOTE: The utility opens in a separate browser window.

2. From theNew Pay Period drop-down, select the current pay period.

3. Click Submit.

4. At the This may take around a minute to save prompt, click OK.

5. At the confirmation prompt, click OK.

Configuring the Service Line data tables

Service Line data tables allow you to house your Decision Support data (DSS). The tables are assigned to
the Performance Reporting license such as many other tables that house data for Actuals.

The data tables are located in the Service Line folder in the Table Library accessed through the Explorer
task pane.
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Open Tables In Spread Sheet (OTIS) is available for the following Kaufman Hall standard roles for direct
table access, if needed:

l Management Reporting Admin
l Management Reporting Analyst

You will need Management Reporting Admin role to use the import.

One standard import is available in the Imports > Management Reportingmenu. You will need
Management Reporting Admin role to use the import. File specs will be provided in the related file spec
document and initial setup may be needed. Please contact Kaufman Hall customer support for
assistance.

The Service Line data tables contain four key fields, twelvemonthly periods columns, and calculated
summary fields. The Key fields are defined as follows:

l Group Service Line – Service Line category name. This is client defined and no Kaufman Hall
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standards are required. This same field is used to define the Service Line namewhen configuring
the Service Line Supplement Driver.

l Primary Payor Plan Code – Used to summarize payor categories. This is client defined and no
Kaufman Hall standards are required. This is used for reporting only and is not used as a key field
in the Service Line Supplement driver.

l Entity Code – Level of summarization similar to Budget Group. This is NOT a validated dimension
to the Entity validation table at this time, but we recommend that the Entity Codematches
validated codes.

l Data Type – Statistic category desired to be used in the data table. These are client defined and no
Kaufman Hall standards are required.

Budget Global drivers
The following table includes a description of each type of Budget Global driver:

Driver Description

Budget Global Data
Configuration

Use to configure settings related to the GlobalData calc method.

Budget Global Data 1-
4

Use to configure next-year budget values by month for individual expense
items.

Budget Global
Expense

Use as an alternative location for budgeting dollars to specific expense
accounts shared across departments without having to divide the dollars
between multiple budget plan files.

Budget Global Sum Use to calculate the value of an account on the Stat_Rev or Expense sheet
based on the value of one or more other accounts on the Stat_Rev sheet.
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Budget Global Data Configuration

� Overview
This driver contains settings related to the GlobalData calc method. The GlobalData calc method allows
you to create configurable budget relationships for calculating NYB amounts for the Expense tab only.
The GlobalData calc method is similar to GlobalExpense but allows you to use up to four configurable
tabs in GlobalData Assumptions.

This calc method works much like Global Expense, Global Revenue, and Depreciation, which look to the
StatData tab to get the budget values.

This driver file allows plan files to look up historical and projected values for expense items. To reference
a department/account combination to the Global Data Assumptions, you must specify the GlobalData
calc method in the appropriate grouping column on the ACCT dimension table. These accounts will then
look to one of the four GlobalData sheets for historical and projected data.

To use GlobalData, you must first specify a default GlobalData sheet for accounts using the GlobalData
calc method, along with any departmental or budget group exceptions. There are four sheets set up in
the Global Data Configuration to use when creating alternate data sets. If you need more than four
sheets or need to modify any of the default queries on the sheets, please contact your Kaufman Hall
Consultant.
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� Settings
Open the driver, and then use the following table to complete the driver settings, as needed:

Budget Global Data 1-4

� Overview
Each of the four GlobalData drivers allows you to adjust current year projections and next-year budget
values by month for individual expense items. The initial values are populated from source data using
predefined queries.
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� Settings
1. Open the driver.

2. Right-click the Client Filter cell above the Dept Description column header, and select Axiom
Wizards > Filter Wizard.

3. Create or select an existing filter to use. For instructions, see Using the Advanced Filter Wizard.

4. Refresh the variables by doing one of the following:
l In theMain ribbon tab, click Refresh Data.

l Press F9.

5. In the Refresh Variable dialog, click Choose Value.

6. In the Choose Value dialog, do one of the following, and click OK:
l To select one or more values to include, select the check box next to the value.
l To select all of the values, click Select All.

Setup Guide Axiom Budgeting │ 134



l To unselect all of the selected values, click Clear All.

7. Use the following table to make edits to the driver:

Option Description

CY Projected Type the adjusted current year projection.

Month-Year Budget Type the budget values for each month.

8. To delete a record, in the far left column, select Delete from the drop-down.

9. After making your changes, in theMain ribbon, click Save.

Budget Global Expense

� Overview
This driver provides an alternative location for budgeting dollars to specific expense accounts shared
across departments without having to divide the dollars between multiple budget plan files. Some
common uses are for Building Rent and Inter-company Allocations.

Use this sheet for any department and account combination to budget globally instead of by entering
values into individual budget plan files.

For an account to reference the values on this sheet, the budget method (KHAStdLine) in the ACCT
dimension table must be set to GlobalExpense.

You can add additional rows by copying the formulas from the ones already set up.
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� Settings
Open the driver, and then complete the driver settings, as needed.

Budget Global Sum

� Overview
This driver allows you to calculate the value of an account on the Stat_Rev or Expense sheet based on the
value of one or more other accounts on the Stat_Rev sheet.

Use this sheet for any department and account combination to budget as a percentage of the total of
specific accounts on the Stat_Rev sheet.

To reference this sheet, enter GlobalSum as the budget method in the ACCT dimension table
(KHAStdLine).

You can add additional rows by copying the formulas from the ones already set up.

IMPORTANT: Do not change the codes on Row1 or delete a column without consulting with
Kaufman Hall first.

� Settings
Open the driver, and complete the following sections in the GlobalSum sheet:

� Revenue Accounts to be Summed section
Use this section to list the accounts on the Stat_Rev sheet to sum together.

Accounts to sum together and have the same adjustment factor applied should have the same Account
Summary Group.
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Summary groups can be text or numeric. Do not use the word Unused to avoid inadvertent summations.

The only methodologies that can be summed are the following:

l Allowance
l BadDebt
l CDMIPRevenue
l CDMOPRevenue
l IP_Payor
l IP_Per_Unit
l OP_Payor
l OP_Per_Unit
l Oth_Payor
l Oth_Per_Unit
l ProviderRev

You can add additional rows by copying the formulas from the ones already set up.

IMPORTANT: Do not change the codes on Row1 or delete a column without consulting with
Kaufman Hall first.

Displayed fields and settings in the Revenue Accounts to be Summed section include:

Option Description

Budget Group l Acct – Add or modify the account number.
l AcctSumGroup1-4 – There are four account summary groups available.

Add or modify these values.

Dept\Acct Exceptions l Dept – Add or modify the department.
l Acct – Add or modify the account number.
l AcctSumGroup1-4 – There are four account summary groups available.

Enter or modify these values.

Acct Exceptions l Acct – Add or modify the account number.
l AcctSumGroup1-4 – There are four account summary groups available.

Enter or modify these values.
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� Accounts to use GlobalSum Methodology section
Fields and settings in the Accounts to use GlobalSum Methodology section include:

Option Description

Dept\Acct Exceptions l Dept – Add or modify the department.
l Acct – Add or modify the account number.
l Summary Group Column – From the drop-down, select one of the

following:
o AcctSumGroup1
o AcctSumGroup2
o AcctSumGroup2
o AcctSumGroup4

l Adjustment Factor Summary Group 1
l Adjustment Factor Summary Group 1
l Summary Group 1
l Summary Group 2
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Option Description

Acct Exceptions l Acct – Add or modify the account number.
l Summary Group Column – From the drop-down, select one of the

following
o AcctSumGroup1
o AcctSumGroup2
o AcctSumGroup3
o AcctSumGroup4

l Adjustment Factor Summary Group 1
l Adjustment Factor Summary Group 2
l Summary Group 1
l Summary Group 2

Budget Expenses drivers
The following table includes a description of each type of Budget Expense driver:

Driver Description

Budget Expense
Adjustment

Use to control expense rate increases by facility, broken out by income
statement category.

Budget Expense
Admin Adjustments
Setup

Use to make incremental adjustments to manager inputs on budget plan
files.
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Budget Expense Adjustments

� Overview
This driver contains the following fields for controlling expense rate increases by facility, broken out by
income statement category (as defined in the FSDetail column of the ACCT dimension table).

� Settings
Open the driver, and then use the following table to complete the settings in this driver, as needed :

Option Definition

FY Year Projection
Adjustment

Use to modify expense values for current year projection.

FY YearBudget
Adjustment

The default expense adjustment for all budget plan files (exceptions can be
made for any defined Budget Groups in the sections below)

Budget Groups Defines exceptions to the global expense adjustments for any defined
Budget Groups. Exceptions can bemade by FSDetail category and/or
Account.

NOTE: Axiom Budgeting overrides default exceptions with the FSDetail
exceptions and overrides any FSDetail-level exceptions with the ACCT
exceptions. This applies for both current year and next year’s budget.

Setup Guide Axiom Budgeting │ 140



Option Definition

FYYear Fixed % Used if using the PctofSalaries_FixedPct methodology. This will set a fixed
percentage to be used for all departments in that budget group rather
than the historical percentage which would be different for all
departments.

FYYear Rate/FTE Used if using the RatePerFTE_Fixed methodology. This will set a fixed rate
per FTE to be used for all departments in that budget group rather than
the historical rate which would be different for all departments.

Budget Expense Admin Adjustments Setup

� Overview
Use these drivers to make incremental adjustments to manager inputs on Budget plan files. To use these
drivers, you must first set up the accounts in the Budget Expense Adjustments driver.

� Settings
When you open the driver, double-click where indicated to insert a row.

Use the drop-down menu to select whether to enter exceptions for that DEPT/ACCT combination by
Amount or Percent.
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Repeat for as many DEPT/ACCT combinations as you need to enter exceptions. When you are finished,
save the file.

Next, open the Budget Expense Admin Adjustments driver from the Budget Admin task pane. When you
open the driver file, your DEPT/ACCT combinations display. Finally, save the Budget Expense Admin
Adjustments driver.

NOTE: This driver only links to calc methods for Detail, Fixed, Rate Per FTE, and Variable. It is not
designed to work for FTE or salary adjustments.

Budget CDM drivers
The following table includes a description of each type of Budget CDM driver:

Driver Description

Budget CDM
Configuration

Use to set configuration options for the CDMRevenue tab in budget plan
files, including the inpatient and outpatient volume settings.

Budget CDM
Overrides

Use to override the charge per unit rate for specific CDM codes, either
globally or by budget group/department.

Budget CDM Config

� Overview
Use this driver to configure the CDMRevenue tab in Budget plan files, including the inpatient and
outpatient volume settings.
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� Settings
Open the driver, and then use the following table to complete the driver settings, as needed:

Option Description

Budget Option -
Activate KHABgtMap?

Select one of the following:

l To activate KHABgtMap, select Yes.
l To not activate KHABgtMap, select No.

Stat_Rev Integration
Option

l From the Allocate CDM Revenue to GL Accounts drop-down, do the
following:
o To calculate the total revenue on the CDMRevenue sheet to be

allocated to the GLAccounts interfaced on the Stat_Rev sheet, select
Yes. The allocation uses YTD history as its allocation method.

o If you select No, the Use CDM GLAcct to integrate with Stat_Rev
automatically will turn to Yes, and it will use themapping from the
RevUsage dimension table on the IPRevAcct and OPRevAcct
columns.

l From theUse CDMCode.GLAcct to integrate with Stat_Rev drop-
down, select Yes orNo.
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Option Description

Optional CDM
Revenue Column
Display

l Select whether to Show or Hide the Last Year Actual, Current Year
Budget, and Preliminary Budget columns on the CDMRevenue sheet in
the budget plan files.

l From the IP Revenue Spread and OP Revenue Spread drop-downs,
choose the default spread in the budget plan files. Choices include the
Driver, Calendar Days, Work Days, Even, or History. You can override
this setting in each budget plan file.

Budget CDM Overrides

� Overview
Use this driver to override the charge per unit rate for specific CDM codes, either globally or by budget
group/department.

Setup Guide Axiom Budgeting │ 144



� Settings
Open the driver, and then complete the driver settings, as needed.

Option Description

CDM Code Type the charge code to override.
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Option Description

Description Displays a description of the charge code you entered in the CDM Code
column.

IP Inpatient

OP Outpatient

Budget Labor drivers
The following table includes a description of each type of Budget Labor driver:

Driver Description

Budget Labor
Configuration

Use to configure default settings for tracking and calculating labor-related
expenses.

Budget Labor Rates Use to control the wage rate increases globally for your entire organization
as well as for specific budget group and department categories.

Budget Labor
Accounts

Use to configure certain salary or benefit accounts to use total salaries or a
subset of salary accounts to use in the calculation.

Budget Labor ADC
Configuration

Use to configure the job classes and staffing ratios for each job class.

Budget Labor Alt FTE
Factors

Use to configure Alt FTE factors.

Budget Labor
Benchmark driver

Use to define a benchmark target of FTEs or Worked Hours per Unit of
Service (WHPUOS) by department.

Budget Labor
JobCode Dropdown

Use for any department where a filter applied to a JobCode drop-down
provides a streamlines list for the user.

Budget Labor Limits Use to top-out rates when needed.

Budget Labor
Override

Use to make overrides to the various labor-related sheets, such as Empl_
List, in budget plan files.

Budget Labor Target Use to define a target ofWorked Hours per Unit of Service (WHPUOS) by
department and job code.
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Budget Labor Configuration

� Overview
This driver contains default settings for how labor-related expenses are tracked and calculated. You can
set exceptions for specific budget groups by adding another calc method and entering data for the
specific budget group.

� Settings
Open the driver. The top of the sheet begins the settings for the global configuration, including the
following calc method blocks:

l Labor Configuration
l Standard Budget PayTypes
l Earned Paid Time Off Setup

After configuring the global labor drivers, you can do the same for each budget group.

� Global Setup and Default Budget Workbook Configuration Settings section

Settings in this section include:
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Option Definition

Activate Dept Based Pay? Enable or disable department-based pay and designate a
default JobCode (the default is initially set to JDept).

Global or BudgetGroup name Hours
per FTE Convention

Do one of the following for each BudgetGroup:

l To use the default standard work hours specified by
your organization, select Default.
NOTE: The default selected by your organization is
configured in the YearPeriod table.

l To use the non-default standard work hours, select it
from the list. For example, if the default is 2086, then it
displays as Default. The other option that would display
is 2080.

For more information, see Changing year and period.

Global or BudgetGroup name
Calendar Days

The calendar days for the YTD, remainder of the current
year, and upcoming budget years.

Global or BudgetGroup nameWork
Days in Period

The work days in each period.

Global or BudgetGroup name Hours
in Period

The hours in each period, calculated by work days.

Global or BudgetGroup name
Number of Holidays

The number of holidays in each period.

� Labor Configuration section
In this section, enter basic assumptions and key statistics related to payroll.
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Settings in this sheet include:

Option Definition

%of Staffing Change with Volume The ratio of staffing increases to volume increases.

Medicare Tax TheMedicare tax rate for staff.

Current FICA Rate The FICA rate for staff.

Current FICA Limit The FICA limit for staff for the calendar year.

Retirement Below FICA limit The retirement benefit rate to apply before the employee's
salary passes the amount in the Current FICA limit cell.

In the following example, the current FICA limit is $113,700.
As a result, the retirement benefit is calculated at 12%.

Retirement Above FICA limit The retirement benefit rate to apply when the employee's
salary exceeds the amount in the Current FICA limit cell
but does not exceed the amount in the Retirement Max
Limit cell.

For example, an employee's salary increases to $125,000.
As a result, the retirement benefit rate increases from 12%
to 18%.

Retirement Max Limit The amount at which the retirement benefit rate stops.

Uniform Merit Increase Date? Click Yes and designate a date when themerit increases go
into effect; otherwise, click No.
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Option Definition

FTE Comparison to YTD Can use Scheduled FTEs (from Labor Master import) or
CYB FTE – Current year budget FTEs from Payroll26.

Projected FTE Starting Point Use this option to set the starting point for projected FTE
counts.

l To use the scheduled or budget as the projection
starting point, select YTD_FTE

l To set the starting point as schedule and budget, select
Sched/Budget

NOTE: To use CYB_FTE, you must run theMonthly to
Biweekly report under Reports Library >Management
Reporting Utilities > Payroll to transfer your budgeted FTEs
from themonthly payroll tables to the biweekly payroll
tables. Default setting is Sched_FTE, which feeds from the
Empl_List in the budget plan files.

Forecast FTEs from Projection To set the default budget FTEs to zero in all labor sheets
(JobCode, Staffing and Employee), select No. The default
setting is Yes.

Hours per PayPeriod Defines the number of hours in a pay period. The default is
80.

Hours per Monthly This should not be edited.

Reimbursed Salaries Account This should not be edited.

KHASum Code for Agency Summary code for Agency labor.

KHASum Code for Physician Summary code for Physician labor.

Use Self-Balancing to Target on
JobCode tab?

When active, this feature forces the department budget to
a selected target on the Benchmark sheet.

JobCode to use for Self-Balancing
JobCode Adjustment

Input valid job code for variable and fixed.

PayType to use for Self-Balancing
JobCode Adjustment

Input valid pay type for variable and fixed. The default is
the Regular pay type specified in the Standard Budget
PayTypes Productive Categories section below.

Account to use for Self-Balancing
JobCode Adjustment

Input valid account for variable and fixed. Default is the
"Regular" account specified in the Standard Budget
PayTypes Productive Categories section below.
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Option Definition

Projection FTEs - Use YTD Actual or
NYB Adjusted

You can base the Projected FTE allocation off of YTD or
NYB. This means that if there are adjustments in the yellow
allocation rows from the base YTD calculation, you can
elect to make that same assumption for the Projected FTE.

For example, assume that the YTD% for overtimewas 4%
YTD. The projection would also be 4% and would calculate
the overtime FTE accordingly. But, assume an adjustment
to overtime allocation of 8% is made. This would normally
apply to just NYB, but now that 8% adjustment can apply
to the Projection FTE too.

Program Additions Allows for custom naming of the Program Additions row.
To change the name, type the desired name in the cell to
the left of the label.

Position Changes Allows for custom naming of the Position Changes row. To
change the name, type the desired name in the cell to the
left of the label.

� Standard Budget PayTypes section

This section defines the pay categories for Productive, NonProductive, and Contract labor that you can
assign to the JobCode, Staffing, and Employee columns in the PAYTYPE dimension table. This determines
how different paytypes are spread out over themonths of a year. The initial configuration is set up by
your Kaufman Hall Implementation Consultant during implementation.

Settings in this section include:
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Option Definition

Productive Categories Includes regular, overtime, education, and so on.

NonProductive
Categories

Includes time off and other non-productive hours.

Contract Labor
Categories

Define up to seven categories of contract labor in the labor models

Productivity Statistic Defines the PayType used to store productivity statistics, usually PStat.

� Earned Paid Time Off Setup section
Use this section to determine how PTO is computed based on labor hours.

Settings in this sheet include:

Option Definition

Earned Paid Time Off
Setup

Set whether to use calculated PTO. To use historical taken PTO as the
budgeted PTO, select No. If you select Yes, you can select the gross or net
method for earned PTO.

Earned PTO Hrs
Conversion Factor

The rate at which hours accrue based on which account.

Default Earned PTO
Hours Per FTE

The default annual per-FTE PTO hours earned.

Working with FTE standard working hours

The FTE Hours standard specified from the YearPeriod table is included in the Budget Labor Configuration
tab. This allows you to not only define standard working time globally across your organization, but you
can also define it for each budget group.
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In the Budget Labor Configuration driver, the Default values are set up in the YearPeriod table where you
can set the standard working hours by job code.

You do this in the StdHours column in the JOBCODE dimension table. This is a validated field so the two
options are Default and 2080 Hours.

The FTE Hours standard specification is especially helpful if your organization has a mix of employees
using the Jobcode or ProviderComp labor methods but are using alternate FTE standard working hours.
For example, highly compensated employees are perhaps using a 2080 FTE scale while others are using a
2086 FTE scale, yet they are on the same Jobcode labor type.

NOTE: As an administrators, you only need to update this column if you need the alternate scale.
The column automatically displays Default, so no additional configuration is required.
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NOTE: Standard reports do not recognize FTE calculations based on the two scales. We recommend
that you modify or create your reports to represent the FTE values, if needed. For example, if an FTE
using 2080 hours is calculated with a denominator of 2086, then the FTE displays as .9971, unlesss
rounded to two decimals.

After setting up and applying the FTE Standard, within the plan file, a row is added. If the 2080 Hours
option is selected, the hours will be based on the FTE factors on this row.

In themonthly hours row of the applicable Labor calc method, the formula looks for 2080 Hour, and if
present, then the hours are based on the 2080 row, as seen i the calculation highlighted in the following
example.

The following example shows the option selected from the JOBCODE dimension.
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The following example shows the option selected from the JOBCODE dimension.

Budget Labor Rates

� Overview
The Budget Labor Rates driver allows you to control the wage rate increases globally for your entire
organization as well as for specific budget group and department categories. For each category, you can
also set rate increases by job code (determined by the JobClass grouping column in the JOBCODE
dimension table), job class, and step.

There are two types of wage rate increases you can configure:

l Annual Merit – The effective date from the labor master file is used in the budget plan file. If there
is no match to the Empl_List, theMerit Month is used by default.

l Market Adjustments – TheMarket month listed in Budget Assumptions is themonth in which the
increase is applied. You can define up to two Market Adjustment merit increases.
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� Settings
Open the driver. When configuring the Labor Rate driver, you begin by specifying global rate and merit
increases that apply to the broadest set of job codes. Next, you specify the rate and merit increases by
specific budget group. Finally, you can finish your configuration at themost specific category—by
department.

NOTE: Budget groups are normally used for entities within your organization, but you can use them
any way you wish.

Within each Labor Rate category, you can specify rate and merit increases by job code, job class, and
step. The following is a list of the different configuration combinations you can set up, in order of
broadest to most specific.

l Global | Global (Broadest)
l Global | JobClass
l Global | JobClass | Step
l Global | JobCode
l Global | JobCode | Step

l BudgetGroup | Global
l BudgetGroup | JobClass
l BudgetGroup | JobClass | Step
l BudgetGroup | JobCode
l BudgetGroup | JobCode | Step

l Dept| Global
l Dept | JobClass
l Dept | JobClass | Step
l Dept | JobCode
l Dept | JobCode | Step (Most specific)

When it comes to actually applying the rate and merit adjustments, Axiom Budgeting evaluates each job
code and applies themost specific Labor Rate driver configuration first. If a configuration does not apply
to the specific job code, the system evaluates the next least-specific configuration to see if it applies. If it
does not, the system continues to evaluate the job code until it meets the requirements of a
configuration.

In the following example, rates have been specified for Global |JobClass and Global | JobClass | Step for
a job class defined as Other. Employees who meet the step criteria will receive a 30% increase while those
in the same job class that do not meet the step criteria will only receive a 20% increase.
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In the following example, note the configuration of Global-J00200.

In this next example, note that Global-J00200 is recognized in the Empl_List tab.

When configuring the Labor Rate driver, remember the following:

Setup Guide Axiom Budgeting │ 157



l Themost specific labor rate you configure will be the one that controls the labor rate adjustments.
For example, if you configure the rates for Dept | Global, but you do not specify the rates for Dept
| JobClass, then the rates apply to everyone in the department—regardless of job class, job code,
or step.

l To minimize the number of configurations you need to set up and maintain, we recommend using
the global configurations to institute your rate and merit increases for most job codes. You should
only use themore specific labor rate categories and configurations as exceptions.

The configurations you make in the Labor Rate driver affects the following tabs in the plan file:

l JobCode
l Staffing
l Employee
l Provider
l HHLabor
l AltFTE

The same exception principle that is applied in expense adjustment is applied here as well. After Axiom
Budgeting determines that it is an exception, all other related increases will not apply.

You can make exceptions to budget groups by adding another calc method block and entering the code
for the budget group.

� Configuring labor-rate details
1. To make global rate changes for the Global, BudgetGroup, and/or Department categories, in the

Global Change row, type rate increase percentages in theMerit,Market-1, andMarket-2
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columns.

2. To add a job class or job code to an existing labor-rate category, click >> next to <= Click here to
enter JobClass or <= Click here to enter JobCode.

3. To add a step to a job class or job code, in the Step field, type the step code or description.
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4. To make rate changes for job classes and job codes for a labor-rate category, type rate increase
percentages in theMerit,Market-1, andMarket-2 columns.

5. To add another job class or jobcode and step, double-click Double Click to Insert New Jobclass
and Step or Double Click to Insert New Jobcode or Step.

6. To add a new budget group and/or department, do the following:
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a. In the Enter New BudgetGroup Code section or the Enter New Department Code section,
in the BudgetGroup column, type the budget group or department group in the blue cell.

b. To add another new budget group or department, double-click Double Click to Insert New
Budget Group or Double Click to Insert New Department Group.

c. To add job classes, job codes, or steps to the new category, complete Steps 2-5.

7. When you are donemaking changes, in theMain ribbon tab, click Save.

NOTE: After you click Save, any new budget groups and departments that you added move
up to the list of existing budget groups and departments. The system then reorganizes the list
in alphabetical order.

8. At the confirmation prompt, click OK.

Budget Labor Accounts

� Overview
Use this driver to configure certain salary or benefit accounts to use total salaries or a subset of salary
accounts to use in the calculation. You can set the configuration for all or configure it for a specific budget
group.
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� Settings
Open the driver, and then complete the driver settings, as needed.

Budget Labor ADC Config

� Overview
In the Budget Labor ADCConfig driver, configure the job classes and staffing ratios for each job class. The
staffing ratios are used to build out the nursing grid in the budget plan files. You must also determine if
each class is considered:

l Fixed - Position is fixed but is not replaced for PTO calculation.
l Fixed With Replacement - Position is fixed but is replaced for PTO calculation.
l Variable - Position is replaced for PTO calculation and fluctuates with volume changes.

For each defined job class, you must input a staffing ratio to determine the flexing point of each Average
Daily Census level.

There are sections to do this globally for all departments, make exceptions by BudgetGroup, or make
exceptions by department. For each defined job class, you must input a staffing ratio.

Fields and settings in the ADC Configuration driver include:

l Global – Used to set a global staff-per-patient ratio for each category.
l BudgetGroup – Designate exceptions by budget group.
l Dept – Designate staff per-patient-ratios by department. This is themost commonly used section.

NOTE: To activate the ADC sheet for a department, enter JobcodeADC in LaborType in the DEPT
dimension table.
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� Settings
Open the driver, and then complete the driver settings for Global, BudgetGroup, and Dept, as needed,
for each shift.

Budget Labor Alt FTE Factors

This driver allows you to enter different bi-weekly hours for some job codes due to union labor contracts.
For example, you might need to enter 75 hours for some job codes instead of 80.

� Overview
Use this driver to configure the Alternate FTE factors.
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� Settings
Open the driver, and then use the following table to complete the driver settings, as needed:

Option Description

JobCode Type the job code.

FTE Factor Type the FTE factor.

Budget Labor Benchmark driver

� Overview
Use this driver to define a benchmark target of FTEs or Worked Hours per Unit of Service (WHPUOS) by
department. You can define a target for the current year (CY Target) as well as next year (NY Target). The
Target Type column contains drop-downs to select the type of target to use for each department.
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� Settings
Open the driver, and then use the following table to complete the driver settings, as needed:

Option Description

Dept Displays the department code.

Department Name Displays the name of the department.

Target Type Select the target number of paid FTEs for the department.

Total FTEs Type the target number of FTEs for the department.

WHPUOS Type the number ofWorked Hours per Unit of Service.

PHPUOS Type the number of Paid Hours per Unit of Service.

Budget Labor JobCode Dropdown

� Overview
Use the Budget Labor JobCode Dropdown driver for any department where a filter applied to a JobCode
dropdown provides a streamlined list for the user.

NOTE: This methodology only works with the Add New JobCodemethodologies on the JobCode tab.
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� Settings
Open the driver, and then complete the driver settings, as needed.

Budget Labor Limits

� Overview
Use the Budget Labor Limits driver to top-out rates when needed.

� Settings
Open the driver, and then complete the driver settings.

l Enter any applicable Job Code and its corresponding rate limit. If a Job Code has a rate limit of
$20.00 per hour and the 5% increase will exceed that, then the rate is capped at $20.00 per hour.

l TheMaxRate is used to determine if a lump sum payout should be calculated when a salary
increase is applied to employee rates. If you do not want to calculate lump sum payouts, set the
MaxRate to $1000. You can also set the Lump Sum Payout Multiplier on the Configuration sheet
to 0%.

l TheMid Rate (MidPoint) is used when a new Job Code is added to a departmental budget. The
Budgeted Rate defaults to the rate listed here, if available.

l TheMid and Max Rate values should reflect the rates that will be used in the new budget year. In
most cases, they should be adjusted by Human Resources to include the range updates related to
merit and market assumptions.
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Budget Labor Override

� Overview
Use this driver to make overrides to the various labor-related sheets, such as Empl_List, in budget plan
files. You can configure labor overrides at the following levels:

l Global
l Budget Groups
l Department Exceptions
l Department - Jobcode Exceptions
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The plan file calc methods process the overrides by first evaluating for exceptions at the job code level,
then department exceptions, budget group exceptions, and then finally applies the default settings at
the global level.

Labor Overrides allow you to modify how the Jobcode, Staffing, and Employee tabs calculate salaries and
related statistics and expenses.

You can adjust the following items:

l The source for Regular and PTO pay
l The source for PTO and EPTO FTEs
l The spread of pay across pay types

� Settings
Open the driver, and then use the following table to complete the driver settings, as needed:

Option Definition

Department The department in which to apply the labor override.

Jobcode The job code for the specified department to apply the labor override.

NOTE: This column is only editable in theDepartment - Jobcode
Exceptions section.

Regular Rate Source Select the Regular Rate Source to use for the beginning budget rate for
each job code.

l History – Uses the historic rate based on themost recent current
period actual.

l Base – Uses the base rate from the EmployeeMaster sheet.
l Global – Uses the rate of pay entered on this tab in the Rate Override

Amount column.

Rate Override
Amount

Enter the override amount.

NOTE: This column is only editable in theDepartment - Jobcode
Exceptions section.

PTO Rate Source Select the beginning PTO budget rate for each job code.

l Base – Uses the rate listed on the EmployeeMaster sheet.
l Regular – Uses the Regular pay rate for PTO.
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Option Definition

PTO FTE Source Select the source of FTE for PTO Calculation.

l YTD – Uses actual Year-to-Date FTE.
l Rolling12 – Uses 12-month actual (full year) FTE.
l EPTO – Uses the EPTO rate based on scheduled. This may not match

the actual EPTO rate.

EPTO%Override Enter one of the following to override the calculated EPTO% from the
Empl_List:

l A percentage to override the standard PTO calculation.
l History orNA - If you do not want to adjust the EPTO%, enter NA, and

the default lookup to Emp_List logic applies.

IMPORTANT: Do not enter zero (0), because zero is a valid adjustment
percentage.

Adjustment to
Calculated PTO%

Modify the EPTO%used on the PTO row. This is a data validation entry
field, with a range from 0%-200%. For example, if the EPTO% for a selected
job code is 8%, and you enter 100% as the default in this column, the value
remains at 8% (i.e. 8% x 100% = 8%). If you enter the adjustments to
calculated EPTO% as 80%. then 6.4%would display as the value on the
PTO row.

EPTO FTE Source Select the source of the FTE for Earned PTO Calculation, if that option is
enabled on the Configuration sheet.

l YTD – The YTD FTE.
l Scheduled – The scheduled FTEs from the EmployeeMaster sheet.

Paytype Distribution
Overrides

Enter the Override FTE Allocation percentages by category. For each
category, do one of the following:

l Enter a percentage.
l To use the historical percentage by category by job code, select

History.

NOTE: History is the default. You can enter or modify this value. There are
several columns available, for both Prod and NonProd entries.

� Adding a new row to a section
To add a new row to a section, click theDouble Click to Insert New Budget Group/Dept
Exception/Jobcode Exception row.
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� Displaying the legend
The Labor Override Legend provides descriptions that corresponds to specified columns. The letter next
to the description corresponds to the letter that displays above the column, as seen in the following
screen shot.

By default, the legend is hidden. To display it, in theMain ribbon tab, click Change View > Legend.

To hide the legend, in theMain ribbon tab, click Change View > Default.

NOTE: When you close and reopen the driver, the system automatically hides the legend.
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Budget Labor Target

� Overview
Use this driver to define a target ofWorked Hours per Unit of Service (WHPUOS) by department and job
code.

� Settings
Open the driver, and complete the following:

l A target can only be defined for next year (NY Target).
l You can only enter a variable target based on worked hours per unit of service or a fixed paid FTE

target.
l The variable FTE calculation in the budget plan file will be forced to match the target.
l This method does not work on the Employee sheet since there is no variable logic.

Budget Revenue drivers
The following table includes a description of each type of Budget Revenue driver:

Driver Description

Budget Revenue
GlobalRev

Use to budget all dollars for specific revenue accounts centrally without
touching each individual budget plan file.

Budget Revenue
Adjustments

Use to control the revenue rate increases by BudgetGroup broken out by
Inpatient, Outpatient, and Other Revenue.
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Driver Description

Budget Revenue
Deductions

Use to control the rest-of-year projection as well as monthly budget
assumptions for those deduction accounts that are budgeted at the
department level.

Budget Revenue
Payor Adjustments

Use to configure percentage shifts in payor mix.

Budget Revenue GlobalRev

� Overview
Use this driver to budget all dollars for specific revenue accounts centrally without touching each
individual budget plan file. Common uses are for Other Operating revenue and Inter-company
allocations.

� Settings
To reference this sheet, the budget method (KHAStdLine) in the ACCT dimension table must be
GlobalRevenue.

Budget Revenue Adjustments

� Overview
This driver allows you to control the revenue rate increases by BudgetGroup broken out by Inpatient,
Outpatient, and Other Revenue.

� Settings
You can make department and account exceptions.

l EffectiveMonth is based on Fiscal month (If FYE is June, January is effectivemonth 7.)
l Departmental Exceptions are allowed at the bottom of each section.
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l Common exceptions are if nursing inpatient increases will occur at a different rate than other
inpatient services, you need to enter each nursing department as an exception. You can also use
this to reflect the results of a price optimization study.

IMPORTANT: After you enter a department or account as an exception, any global facility
parameter will not be applicable.

Budget Revenue Deductions

� Overview
Percentage of Gross Revenue for Estimated Deductions

The Deductions driver controls the rest-of-year projection as well as monthly budget assumptions for
those deduction accounts that are budgeted at the department level.

The assumptions can be defined by:

l BudgetGroup and Account
l Department and Account

The same exception principle that is applied in expense adjustment is applied here as well. After Axiom
Budgeting determines that it is an exception, all other related increases will not apply.
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� Settings
Open the driver, and complete the following settings:

l BudgetGroup – Enter or modify this value.
l Acct – You can enter, modify this value.
l [Monthly budget amounts] – 12months of budget amounts, which you enter or modify.

Budget Revenue Payor Adjustments

� Overview
This driver allows for percentage shifts in payor mix. Payor adjustments are used for revenue accounts in
the general ledger system and set up by payor. In the ACCT dimension table, you need to configure the
FSPayor column to use this sheet. List a valid code in the FSPayor column and list percentage changes in
the inpatient, outpatient, and other patient columns. The payor shifts displays in the Stat_Rev sheet in
budget plan files.

� Settings
Open the driver, and complete the following settings:

l FSPayor – Enter or modify this value.
l InPatient – Enter or modify this value.
l OutPatient – Enter or modify this value.
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l Other Patient – Enter or modify this value.

Budget Statistics drivers
The following table includes a description of each type of Budget Statistics driver:

Driver Description

Budget Statistics Use to ensure that your historical data for budget is the same as the data
in the database.

Budget StatAcct Use to set up with the Revenue_Stat (on Stat_Rev) and Variable_Stat (on
Expense) calc methods.

Budget Statistics
Supplement

Use to create custom statistics to pull into the Budget Statistics Driver.

Budget Statistics

� Overview
The Budget Statistics driver ensures that your historical data for budget is the same as the data in the
database. It is referenced by the Statistics, GlobalRev, GlobalExp and Depreciation worksheets for LYA,
CYB and CYA_YTD information. Also, the Rolling12 spreads on the Statistics worksheet are pulled from
the StatData tab.

If you are using staggered start periods for your budget groups, the GlobalStatUpdate report has logic
that will pull the appropriate values to correspond to the correct period.
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NOTE: Click Refresh Data to refresh your statistics with the latest information available.

� Settings
Open driver. For each entity, this driver contains the following information:

l BudgetGroup – Enter or modify this value.
l Stat Name – Enter or modify this value.
l DEPT – Enter or modify this value.
l ACCT – Enter or modify this value.
l Spread Tag (Facility Statistics only) – Select the default calc method to use for the budget group.

The Global Statistics sheet contains the following additional columns:

l FY 20XX Actual – Actual, year before last.
l FY 20XX Actual – Actual, last year.
l FY 20XX Budget – This year's budget.
l FY 20XX Dec YTD Actual – This year's December YTD actual.
l FY 20XX Jan-Jun Projected – This year's January - June, projected.
l FY 20XX Projected – This year, projected.
l Actual Percentage of Total – Percentage change from previous year.
l Change – Percentage change.
l Budget Percent of Total - Budget percent of total.
l FY 20XX Budget – Next year's budget total.
l Bud-Proj Amt – Variance amount, budget vs. projection.
l Variance % – Variance percentage.

The Service Line information at the bottom of the worksheet is pulled from the Budget Service Line
Supplement driver. Before you make any changes to these line items, make sure to select Previous Input
from the Spread Tag column. This will ensure your edits are retrieved from the Statistics driver table
versus using the default calculations.
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Budget StatAcct

� Overview
Use this driver for set up with the Revenue_Stat (on Stat_Rev) and Variable_Stat (on Expense) calc
methods.

� Settings
Open the driver, and enter the department and account combination on the left, then the driven by
department and account on the right. These calc methods will then pick up the set up to be used for the
calculation in budgets.

Budget Statistics Supplement

� Overview
The Budget Statistics Supplement driver allows you to create custom statistics to pull into the Budget
Statistics Driver.
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Setting variance thresholds
The threshold level determines howmuch an account can vary from budget before department
managers are required to enter comments explaining the variance.

To configure the threshold level, navigate to one of the following:

l In the Bud Admin task pane, in the Financial Reporting section, click Financial Utilities > System
Setup, and double-click VCC_Threshold.

l In theMgmt Admin task pane, in theDimension & Reference Maintenance section, click System
Setup, and double-click VCC_Threshold.

NOTE: In the ACCT dimension table, you need to create or include Variance Comments accounts for
the Summary selection where ACCT.Type=’Comments’.

� General settings

In the top section of the sheet, you may select the following options:

1. To only view thresholds for particular departments, type criteria in the Custom Filter for Alert
Processing cell (e.g., "(Dept.Manager='Chris Sparks' or Dept=101010)").

IMPORTANT: Do not remove the "Acct.Statement <>'NI'" criteria, otherwise new, approved
initiatives will be included.

IMPORTANT: Custom filters will not be applied to the optional Variance Comments Collection
tab in theMonth End Reporting dashboard.

2. In the Comparison Time Series cell, select one of the following options in which to base the
variance in the reports:

l For regular current year budget variances, select CYB.
l For flexible budget variances, select FLX.
l For three-month average variances, select 3MthAvg.
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l For prior month variances, select LastMth.
l For the samemonth last year variances, select SameMthLY.

3. In the Revenue & Usage Comparison field, do one of the following:

l To enable drilling in the statistic section down to CDMCode, select Budget.
l If unsure which option to select, select Budget.

4. In the Flag Max Positive Variance as Required cell, do one of the following:
l To be alerted to variances in a favorable direction as well as variances in an unfavorable

direction, select Yes.
l To not be alerted to variances, select No.

5. If your organization uses H_JCHours for Paid Hours, do the following:
l In theUse H_JCHours for Paid Hours filter (Default is H_Hours) cell, select Yes.
l If you are not sure, select No.

6. In the Activate Variance Comments Collection tab on Month End Review Dashboard drop-
down, select one of the following options:

l To create a Variance Comment Collections in theMonth End Review dashboard where you
will manage variance comments, select Yes.

l To manage variance comments in the Excel Client, especially if you already have customized
filters, select No.

� Comment level settings
In the Summary portion of the General Threshold Levels section of the page, you may decide whether to
collect comments at a summary level or account detail level.

IMPORTANT: Valid account codes are needed if reporting at the Summary level.
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This setting is reflected in the Comment Input reports. If you select Summary, a single comment input
field displays at the summary level. If you select Detail, individual comment input fields display for each
account.

If using the summary level, you need to create a dummy account to accept comment input. You need to
add the dummy accounts to the ACCT dimension table, and then indicated in the Summary Account
column on the ThresholdLevel sheet.

IMPORTANT: Do not assign any new account to an existing FSSummary category, otherwise the next
month that account will show up in detail. Use Summary instead.

You can define exceptions for summary level (and all other Threshold settings by Entity) in the sections
further down the worksheet.
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� Flag alert settings
For each account, you may define ranges at which various flags are set:

For each summary and/or detail account, you may set thresholds that will trigger flags with different
color coding in the variance reports.

Color Description

Green Displays on the report if the variance is below the value in the Min Yellow
column.

Yellow Displays on the report if the variance exceed the Min Yellow amount but remains
below the Red Threshold.
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Color Description

Red Displays on the report if the variance is greater thanMax Red but comments are
not required.

Red w/Yellow Box Displays in the yellow cell if variance is greater thanMax Red and comments are
required.

Building and processing budget plan files
A budget contains budget plan files for each department, organized into file groups, which typically each
contain a single year's budget.

IMPORTANT: Before you build and process plan files, you must first load and reconcile data. For
more information, see Preparing data for budget go-live

To initially create plan files for a new year, you will need to:

1. Build plan files - Creates the budget plan file.

2. Process plan files – Populates the budget plan file with data from the Axiom database that you
preloaded.

Budget file groups contain plan files with budget data for each department in the organization. However,
you do not copy individual plan files when cloning a file group. Instead, you use the Build & Process
Budget Files job in the Axiom Scheduler to generate a new set of plan files for the new budget year.

Budget plan files are generated from templates. Which templates are used for a particular department
and how those templates are configured is based on settings in our Budget Configuration and
Assumptions driver files.

NOTE: The Build & Process Budget Files job creates and saves the plan files per the configuration
settings in the dimension tables and the file group's driver files—it does not populate the files with
data. Populating the plan files with data is an additional step that wewill discuss later.

Within the job, creating and processing are broken out to two different tasks to allow each to be run
independent of each other.

� Building budget plan files
To build budget plan files:

1. In the Bud AdminBud Admin task pane, in the Prepare Budget Plan Files section, double-click
Build & Process Budget Plan Files.
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2. In the box on the left side of the Scheduler dialog, click Create Plan Files.

3. Click the folder icon.
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4. In the Choose File Group dialog, select the file group, and click OK.

5. To create specific plan files, you can apply filters, as needed. For example, to only run for a
selected Entity or Dept. To apply filters, in the Task Details section, click the Plan Files tab. Select
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theUse filter radio button to access filtering options.

6. After you select the options you want, in the Job ribbon, click Run Once.

7. After creating the plan files, you need to process them. For more information, see Process plan
files.

� Refreshing data
Most of the data in Axiom Software is stored in a database. Plan files are typically generated as needed
by populating a template file with the relevant data from the database. The template used for a
particular plan file often depends on the configuration settings selected in the driver file for that file
group. Most plan files automatically refresh/recalculate data on open. If you need to update an open
workbook to reflect changes to the database or driver files, however, you can use the Refresh feature.

In plan files, this feature is only available to product administrators and to users with the Run AQs in Plan
Files security permission. This control prevents users from inadvertently overwriting plan data when the
template is not designed to accommodate data updates.

An Axiom query is a method of querying data from the database and updating a specific range in a sheet
with the data. If an Axiom query is configured to refresh when the file is opened, however, that refresh
occurs for all users, regardless of their security settings. Therefore, you may see data updates in the file
when it is first opened, regardless of whether the Refresh feature is available to use.
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For administrators, typically the only time you may refresh individual plan files is during plan file testing.
To test changes made to a template, you build a plan file from the template, and then refresh the plan
file to bring in data. After testing has been completed and the final plan files are built out, use the Process
Plan Files utility to refresh plan files in a batch process rather than refreshing individual files.

After the plan files have been rolled out to end users, you only refresh the plan files if the templates are
designed to accommodate ongoing data updates. For example, when performing rolling forecasting,
your templates are designed to accommodate bringing in a new period of actuals data each month or
each quarter. On the other hand, if you are performing traditional annual budgeting, then your
templates are designed so that actual data is brought in once at the start of the process. After that initial
baseline is set, typically no further data updates are brought into the plan files.

To refresh a plan file:
l On theMain tab, in the File Options group, click Refresh.

NOTE: You may be prompted to define values before the refresh occurs. If so, these values are
applied to the plan file to impact the data refresh.

� Viewing budget plan file templates
Templates define the default file structure for budget plan files. Each template contains one or more
sheets that are copied into a budget plan file at the time it is initially created. Individual cells in templates
may contain formulas (tags) that define how data flows from the database into the corresponding
budget plan file cells and/or how data input or modified in the plan should be written back to the
database.

In all Axiom Software products, templates are generally standardized for each application and not
editable by users. However, you may still view the contents of templates to help trace formulas back to
the source data and understand how data in plan files flows to and from the central database.

Which templates (or sheets within templates) are used to create a particular plan file depends on settings
within the related driver files and dimension table(s). You may or may not be able to configure these
associations, depending on the application and particular category of plan file.

NOTE: After plan files have been created from templates, subsequent changes to the template do
not impact the plan files unless the plan files are re-created.
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To view templates:
1. In the ExplorerExplorer task pane, in the File Groups section, click the file group for the templates

to view.

2. Click Templates.

3. Double-click the template to view.

� Processing budget plan files
To process budget plan files:

1. In the Bud AdminBud Admin task pane, in the Prepare Budget Plan Files section, double-click
Build & Process Budget Plan Files.

2. In the box on the left side of the Axiom Scheduler dialog, click Process Plan Files.
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3. To process specific plan files, you can apply filters, as needed. For example, to only run for a
selected Entity or Dept. To apply filters, in the Task Details section, click the Plan Files tab. Select
theUse filter radio button to access filtering options.

4. To process the plan files, in the Job ribbon, click Run Once.
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Building plan files using a Scheduler job
Use a filter in Scheduler to run the Build & Process Budget Files job. To confirm that no errors occurred,
review the log for errors after the scheduled job completes.

To build plan files using a Scheduler job:
1. From the Admin ribbon tab, click Scheduler.

2. In the Job ribbon tab, click Open.

3. Double-click the Budgeting folder.

4. Double-click Build & Process Budget Files.

NOTE: By default, the job is already set up to run, but you can complete steps 5-9 if you want
to filter the plan files to build and process. Otherwise, skip to step 10.

5. In the left-hand navigation, click Tasks > Create Plan Files (if it's not already selected).
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6. In theGeneral tab, click the folder icon.

7. Select the file group in which to select the plan file to create.
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8. Click the Plan Files tab, and click Use filter.

9. From the list, select the plan files to create by clicking the check box next to the left of theDEPT
column.

10. In the Job tab, click Run Once.
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Configure budget security
This section provides the security settings for the Kaufman Hall Axiom Product roles - per the design of
the Axiom Budgeting product. It is intended not only to provide additional education towards security
settings but to also serve as an audit tool to validate your current Axiom EPM roles.

For more details regarding general set up and maintenance of Axiom security, see About security.

For more details regarding general set up and maintenance of Axiom Security, see "About security" in the
Axiom Budgeting online help.

� Design
Security is pre-configured according to each product. Each product provides five primary roles: System
Admin, Product Admin, Local Admin, Product Analyst, and Product User. Each role includes pre-
configured security to access specific locations, files, and features. You apply data filters to control each
user’s reach into the data.

There are two main elements to setting up security in Axiom products:

l Role - Allows access to features and files, but not data. Roles define what a user can do, which are
defined and explained in the Roles section.

l Filter - Allows access to data and plan files with standard filters built into each role. The filters are
directly referenced from the dimension tables, which provides the ability to maintain data access
through the dimensions for additional disseminated control. These are explained in the Filters
section.

� Filters
The Product User, Analyst, and Local Admin roles come pre-configured with a flexible, dynamic filter. Each
member requires a unique filter. For example, the ICUmanager needs a unique filter to restrict access to
only ICU information, as true with every member of the suite. We accomplish this by using a variable to
drive each user’s data filter from a reference table you would commonly maintain. Themost common
table is the DEPT dimension. This table is shared by many planning process and data tables, and provides
an excellent means to protect your data. Other products may have an alternative key table that drives
security filters. Wewill use the DEPT dimension in our examples.

Each product includes nine columns in the DEPT dimension, which you assign to user’s login IDs based
on who is the owner of that role for each department listed. Those security columns with login IDs are
referenced by the corresponding role as for unique data and plan file filters. In the following table,
CSparks is assigned a Budget User role. The role gives him access to specific features, functions, and
tools. The role also includes a dynamic data filter for all budget data tables of “If BPOwner or BPReviewer
or BPApprover = login name”. So, when CSparks logs in, his role filter will apply his login name to his
budget role filter, resulting in if BPOwner or BPReviewer or BPApprover = CSparks. This gives him access
to the budget planning data tables for ICU and ER.
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Managing member’s data and plan file filters aremanaged by assigning each members login ID to the
respective departments in the DEPT dimension without the need to access security. This allows you to
minimize number ofmembers with security access since Local Admin members can manage security
filters through dimension ownership assignments.

� Adding additional users
If you need additional users than the fields provide, you may create and use pseudo roles as an
assignment vs. a single login name. Every member of that role will inherit permissions to that
department. For example, let's say you have six local admins that need rights to all departments and
only there are only three slots available in the dimensions. You would do the following:

1. Open Security Manager.

2. Create a new role.

3. Assign the six members to the new role.

4. Open the Dimension Maintenance Utility.

5. In the DEPT dimension, assign the role name to each of the departments in the BPAdmin column,
and save the changes.

1. Open Security Manager.

2. Create a new role.

3. Assign the six members to the new role.

4. Open the Dimension Maintenance Utility.

5. In the DEPT dimension, assign the role name to each of the departments in the BPAdmin column,
and save the changes.

For instructions related to managing security and managing dimensions, see the following topics in the
online help:

TIP: To find the exact topic listed below, type the name of the topic with quotations.

l "The Security Management dialog"
l "Managing roles"
l "Managing users and roles"
l "Launching the Dimension Maintenance Utility"
l "Editing a dimension"

All of themembers with that role will now have proper permissions.
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If you need to assign broader filters, such as “Region=’IOWA’, you can apply a custom filter directly to
the user. A user-level filter and a role filter combine as an OR statement “User Filter OR Role Filter”. The
user filter is applied in multiple locations.

� Security basics
Security is configured by four sections.

Type Description

Product permissions General administrative functions. Many of these permissions span all
products. You can grant many of the permissions in the other sections.
This permission level is suite-wide.

Product file groups Determines access to what file groups, plan file filters, access, and abilities.

Data table types Determines access to data tables. Tables are categorized by type. For
example, the Financial type contains all the GL financial tables.

Files Determines access to select Axiom EPM files.

� Tools

Name Description

Security Manager Allows you to maintain the complete security options for all users and
roles. We recommend this tool for adjusting security at the individual
level.

Security Spreadsheet Provides a spreadsheet view of file group and table options for all users
and roles.

IMPORTANT: Use caution when using this tool. If two or more security
members save this file with overlapping filters at the same time, the
system will overwrite one over the other.

Product Security
Setup Utilities

Allow you to bulk assign roles and data filters. Each product has a
configured set in the Product Utilities > Security Setup folder. You must be
a member of Security Admin to post changes. We recommended using this
tool for initial product and role assignment.

Dimension Security
Utility

Allow you to assign permissions for Admin members to maintain
dimensions. You must be a member of Security Admin to post changes.

Product Driver
Security Utility

Allows you to assign permissions for Admin or Analyst members to
maintain dimensions. You must be a member of Security Admin to post
changes.

Active Directory
Import

Using the Active Directory Import, you can map directory groups to EPM
roles to automate enabling newmembers.
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� Roles
Each EPM license/product comes with the following role types:

� Budget planning provider roles
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� Product permissions
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� Product file groups
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� Data table types
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� Files

� Specialty roles

Running processmanagement

� Running the Budget Approval Process
To use the Budget Approval Process:

1. In the Explorer Explorer task pane, in the File Groups section, click Budget-20XX > Process
Definitions.

2. Double-click Budget Approval Process.
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3. To view the steps in the process, click the Process Steps tab.

The steps for running the Budget Planning Process include:

Step Name Description

1 Budget
Configuration

Notifies the Budgeting Admin to configure the new year's budgeting file
group.

2 Driver
Configuration
Updates

Notifies the Budgeting Admin to make any necessary updates to the
Driver files.

3 Volume
Assumptions

Notifies the Budgeting Admin to adjust volume assumptions for the
new year.
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Step Name Description

4 Budget Approval
Stages

This subprocess containing multiple steps:

l Base Budget Build – Prompts the Budgeting Admin to build plan files
for the file group.

l Budget Owner Input – Prompts department managers to edit their
respective budget plan files.

l Budget Review – Submits plan files to their designated reviewers for
approval.

l Executive Approval – Submits approved plan files to their
designated executive for approval.

l Finance Team Approval – Submits approved plan files to their
designated financial department contact for approval.

� Copying the Recalculate Budget Files job
In Axiom Budgeting, you can copy the Recalculate Budget Files job to recalculate the budget files for one
or more specified entities.

To copy the Recalculate Budget Files job:
1. In the ExplorerExplorer task pane, in the Libraries section, click Scheduler Jobs Library >

Budgeting, and double-click Recalculate Budget Files.

2. In Tasks list in the left window pane, click Process Plan Files.

3. Right-click any of the tabs, and click Save As.
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4. Name and save the new scheduler job file.

5. Click the Plan Files tab.

6. At the Specify plan files to process option, select Use filter.

7. Create a filter to specify an entity by entering the filter syntax in the Plan File Filter box or click the
Filter Wizard button.

8. Click the Axiom Queries tab.

9. In the Refresh On Open column heading, click the gray drop-down, and in the Value field, type
True. This filters the list for all the AQs that should contain the check mark.
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10. Click any blank check boxes, and then click Save.

Releasing budget plan files
After you start building plan files, they become available to your end users - unless you restrict them - so
you want to make sure you are ready before releasing them to your end users.

Ensure that Security and Process Management is set up and ready to go.

Under certain circumstances, you may want to wait to make them available for a few days. For example,
waiting until after the weekend or a major holiday.

TIP: We recommend that you review reconciliation reports on a daily basis until the budget is
complete. This allows you to find and troubleshoot any issues quickly because you are starting each
day with "clean" data. If you wait too long to reconcile your budget, it can take longer to find where
the problems are located and resolve them. It also puts your organization or department in a
constant state of readiness so that you can report information at a moment's notice
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Rolling Forward to a New Budget Year
IMPORTANT: Upgrade Axiom to themost current release, and then follow these steps. Also make
sure you're not in an active budget cycle.

As part of the implementation process, a Kaufman Hall Implementation Consultant helps you create a
budget file group for the current year, as discussed the section Setting Up Budget Plan Files. As part of
the implementation process, a Kaufman Hall Implementation Consultant helps you create a budget file
group for the current year, as discussed the section "Setting up budget plan files" in the online help.

For the next or subsequent file year, however, there are steps you need to complete to set up next year's
file group. These steps include the following:

1. Archive the current year plan file. (Optional)

2. Roll data over to next year's file group.

3. Update suite variables.

4. Update process definitions.

5. Prepare for the next fiscal year.

6. Review other system areas.

1. Archiving current year plan files (optional)
The Archive Current Year Plan Files command allows you to convert the current plan files in a file group to
static snapshots of the files, for viewing only. This command is intended to be used in cases where
planning is finished for the file group, but you still want the ability to view the finalized plan files.
However, you do not want the plan files to be updated with new data or save data to the database.

When you run this command, the system first creates a plan file restore point, so that you can restore
the plan file if a user accidentally executes it. Then, the system opens each plan file and normal "open
processes" occur, including applying default views, hiding sheets, and executing refresh-on-open Axiom
queries and data lookups.

4
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NOTE: The plan file starts out in the same state it would be in if the user executing the command
opened the file normally.

The system then processes each plan file as follows:

l Converts all formulas in the plan file to values.
l Deletes all control sheets. This disables any process that depends on a control sheet, such as

Axiom queries or save-to-database.
l Disables refresh variables, action codes, and data lookups by prefixing the primary tags with an x.

For example: [xActionCodes].
l Applies workbook and worksheet protection, as configured on the original default Control Sheet.
l Saves the plan file in this static state.

When a plan file is opened after being archived by the command, data queries will not run because there
is no longer any Control Sheet, and no formulas are left to be calculated. Manually refreshing the file will
have no effect. Users can still save the file if they have read/write access to it, but save-to-database
processes will no longer execute because there is no longer any Control Sheet.

IMPORTANT: The system processes all plan files using the permissions of the user who is executing
the command. This means that the plan files will be opened, refreshed, and then "frozen" based on
the permissions of that user. All users who open the archived files will see the plan files in the same
state. For example, if the "live" plan file used formulas to dynamically show and hide sheets based on
the current user's permissions, this will no longer apply to the archived file.

After you run this command, you can reverse the archive process by restoring the previous versions of
plan files using the restore point created by the command. For more information, see "Restoring
archived plan files" in the online help.For more information, see Restoring archived plan files.

TIP: As a back up measure, you can also export the plan file to a network folder, import it back into
the system, and save over the range valued plan file, if needed.

To archive current year plan files:
1. In the Bud AdminBud Admin task pane, in the Budget System Maintenance section, double-click

Archive Current Year Plan Files.
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2. At the Are you sure you wish to archive file group 'Budget-year' file group? prompt, to
continue, click Yes.

NOTE: The system determines the budget file group to archive based on the file group
associated with the current year's budget plan.

IMPORTANT: Confirm your File Group Alias for Current Year is pointed to the file group you
intend to archive.

2. Rolling data over to next year's file group
The Rollover File Group utility moves all of the data from the current file group to next year's file group.
This includes the driver and security setting data.

To roll data over to next year's file group:
1. Confirm or edit the Current Year file alias to point to the file group that you want the data

(including drivers) to copy from. Let's say you are building a 2020 file group, then you likely want
to point the Current Year file alias to the 2019 file group. For instructions, see Updating file group
aliases.

NOTE: In most cases, the Current Year alias will already be pointing to the correct file group,
but we recommend that you check before running the Rollover File Group utility.

2. In the Bud AdminBud Admin task pane, in theManage File Groups section, and click Rollover to
Next Year File Group, double-click Rollover File Group.

3. At the Confirmation prompt, click OK to roll over the 20XX file group using the prototype file
group.

NOTE: This may take a fewminutes to complete.

4. At the Success prompt, click OK.
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3. Updating suite variables
To update suite variables:

1. In theManage File Groups section, and double-click Update Suite Variables.

2. In the Suite Variable Input Form, edit the following fields, and click Save:

Field Entry

BudActiveFG FG0027 (example of code only. Mouse over the File
Group created and use that code)

BudgetYr Type the year to activate. For example, 2019 or 2020.

BudgetActiveFGName Type the file group to activate. For example
Budget2019.

3. In theMain ribbon tab, click Save.

4. Close the Suite Variable Input Form.

Your most current driver data is automatically copied to the new file group. We recommend that you
update the driver data, as necessary.

4. Updating process definitions
The 20XX file group contains Kaufman Hall generic process definitions (Budget Approval Process) setup.
You must update these definitions before use.

You can also copy the process definition file from the previous year file group. You can do this in Axiom
Explorer using the copy / paste or export file / import file option.

5. Preparing for the next fiscal year
If you are applying the update, then it is likely you are ready to prepare your system for the next fiscal
year. This section includes some of the common steps, but it may not be an exhaustive list so please
contact Kaufman Hall Support with any questions.

l Update system periods.
l Update year and period tables.
l Update payroll dates tables.
l Update the current payroll schedule.
l Update the Budget Configuration driver.
l Update the Budget Statistics driver.
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The new budget file group is now active, but see 6. Reviewing other systems for the new fiscal year to
make sure all systems have been reviewed and updated before you begin working with the new budget
file group.

Changing year and period
Use this table to configure the following for your organization:

l Set the fiscal year and the first month of the fiscal year
l Define the number of work days in the current year, last year, and next year
l Select the standard Full Time Equivalent (FTE) hours worked by employees in a year.

NOTE: The standard FTE hours you select in this worksheet displays as the default FTE Hours in the
Budget Labor Configuration Budget Labor Configuration driver.

The FTE Hours you select are reflected on the following tabs in the plan file:

l Expense
l Jobcode
l Staffing
l Employee
l ProviderComp
l altEmployee
l HHLabor
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To set year and period:
1. In theMgmt Admin task pane, in theData Maintenance section, double-click Update Year and

Period Tables.

2. In the Primary Inputs section, complete the following options:

Option Description

Fiscal Year Select the fiscal year.

Fiscal Start Month Select themonth in which the fiscal year starts.

FTE Hours Select one of the following:

l To use the standard of the number of days worked multiplied by a
40-hour work week divided by 7, select 2086.

l To use the standard 40 hour work-week multiplied by 52weeks,
select 2080.

3. In theWorking Days Inputs area, enter the number of working days for the current year, last
year, and next year for each fiscal month.

TIP: To hide the year and/or period tables, click the corresponding check boxes under the
Working Days Inputs section.

4. After making your changes, click Save.

Setting payroll dates
Use this table to manage your organization's pay period dates. This table is used in many of the
productivity and pay period reports.

IMPORTANT: If your organization uses more than two cycles, it will not display in this table.

To set payroll dates:
1. In theMgmt Admin task pane, in theData Maintenance section, double-click Update Payroll
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Dates Table.

2. For Cycle 1 and Cycle 2, from the Select the initial period pay date drop-down, select the date for
Pay Period 1.

TIP: You can hide or show Cycle 1 and 2 using the toggle under the Save button.

3. From the Select the number of days the Pay Date is after the Pay Period End Date drop-down,
select the number of days.

4. After you make changes, click Save in the upper right corner of the page.

Configuring the current payroll period
Use the Change Payroll 27 Tables-Current Period utility to change the Payroll 27 tables current period.

NOTE: You must have the Administrator role profile to access this utility.
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To configure the current payroll period:
1. In the Bud Admin orManagement Reporting Admin task pane, in the Budget System

Maintenance section, double-click Change Payroll 27 Tables-Current Period.

NOTE: The utility opens in a separate browser window.

2. From theNew Pay Period drop-down, select the current pay period.

3. Click Submit.

4. At the This may take around a minute to save prompt, click OK.

5. At the confirmation prompt, click OK.

6. Reviewing other systems for the new fiscal year
Refer to the budget checklist and all of the topics related to it. Although the budget file group is now
active, there remains a few system areas to review and possibly update.

l Bring data current – Bring the GL and Statistic data current.
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l Verify Budget Control columns in the DEPT dimension table – Validate that the DEPT dimension
key Budget columns have been reviewed and updated.

l Verify the Budget Control columns in the ACCT, JOBCODE, and PAYTYPE dimension tables
l Load updated employeemaster data.
l Build 1-5 sample budgets for verification.
l Adjust dimension budget settings and driver information accordingly.
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Working with Budget Plan Files
All of the files, utilities, process definitions, and other materials for a budget year are grouped together
into a single file group. The file group includes all of the budget plan files for each department. Budget
plan files are the primary means by which users pull data from and write data back to the central
database. Your organization creates a budget plan file for each department that needs a budget.

A budget plan file includes the following sheets:

l Instructions – Provides a guide to completing budget plan files, plus support contact information.

5
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l Budget - Includes all of the sheets associated with entering and reviewing the budget values.
o Summary - Provides a high-level summary of the department budget, based on

information from the plan file.
o Statistics and Revenue -Most of the sheet is pre-populated, but may require your input for

projections for next year's budget.
o Labor - Provides several different sheets for tracking payroll, depending on themethod

used by your organization and/or department.
o Expense - Summary and Detail of non-payroll expenses. Most of the sheet is pre-populated,

but may require your input for projections and next year budget.

l Provider or ProviderComp – Overview of encounters, procedures, gross charges, and RVUs for
each provider.

NOTE: Available only to organizations with the Provider module license.

l New Initiatives – Allows users to enter values into both approved and excluded (unapproved)
initiatives. Only approved initiatives are included in plan file totals. Totals incorporating excluded
initiatives are tracked in a separate column on the Summary sheet.

l Operating Plan – Questionnaire covering strategic budget concerns. A useful tool to help keep
real-world priorities in mind while you are working on budgets.

l Department History – Used to calculatemonthly spreads on the Expense tab. Contains a history of
budget updates going back 18months.

The budget plan file also allows you to include supporting files that you can attach to the budget.

Using budget plan files
Each budget plan file contains multiple sheets. Within a sheet, you can view data and/or input or modify
the values in blue or green cells.

� Opening budget plan files
Your access rights to each budget plan file (read-only or read/write) within a file group are determined by
a combination of your security settings and workflow or process settings, if applicable.

The Open Plan Files dialog lists all budget plan files available to you based on your role profile and
security settings. Use the filter box at the top of the dialog to quickly find a plan file based on the plan
code or description. You can also sort and filter the list to narrow down the list. If you have previously
opened a budget plan file within this session, the system highlights that plan file by default when you
open the dialog.
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Depending on your Axiom role profile, you can open budgets from either the Budgeting or Bud Admin
task panes.

� From the Budgeting task pane
1. From theMain ribbon tab, click Open App Menus, and select Budgeting.

2. In the Budgets section, double-click Open Next Year Budgets orOpen Current Year Budgets.
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3. In theOpen Plan Files dialog, select the budget plan file or files to open, and click OK.

4. If you have read/write permissions to a file but you want to open it as read-only to prevent locking
the file from other users, right-click your selection, and select Open Read Only.

� From the Bud Admin task pane
1. From the Adminribbon tab, click Admin Task Panes, and select Budget Admin.

2. In the Budget Files Administrationsection, double-click Open Next Year Budgets orOpen
Current Year Budgets.
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3. In theOpen Plan Files dialog, select the budget plan file or files to open, and click OK.

4. If you have read/write permissions to a file but you want to open it as read-only to prevent locking
the file from other users, right-click your selection, and select Open Read Only.

The selected budget plan files open. If a file was opened read-only, then the text (R/O) displays in the file
tab. You cannot save read-only budget plan files.

If the dialog is empty, then either you do not have access to any budget plan files in the file group or the
budget plan files have not yet been created for the plan codes that you have rights to.

If another user has the budget plan file open with read/write permissions, then the file is opened as read-
only—regardless of your security permissions.
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� Navigating budget plan files
When you first open a budget plan file, the system displays two main areas: the Navigation panel and the
sheet display area. By default, the Summary sheet and its associated budget sheets display when the
plan file is first opened.

The Navigation panel is the primary way in which to open the different sheets that make up the budget
plan file. To open a specific sheet, double-click the tab name.

NOTE: If your organization is licensed to use the Provider module, the Navigation panel will include
links to those sheets as well.

Each sheet you open displays as a separate tab in the plan file. The exception to this are the budget tabs,
which are grouped and open together as a unit to help facilitate the process of adding and entering
values. To move from one tab to another, you can use the Navigation panel or click the tab at the top of
the display area.

In the grouped budget sheets, you can also click the tab names at the bottom of the display area.
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You can easily move around to different sections within sheets by using theGoTo function onMain
ribbon tab. This opens a drop-down menu that lists links to specific sections of the budget. This is
typically a faster and more convenient way of reaching the section you need when working with tabs that
contain a large amount of data.

The system allows you to open multiple budget plan files simultaneously so that you can work on them
from one screen. To do this, click the Budgeting or Bud Admin tab, and open another budget plan file.
The system assigns color codes the tabs specific to each plan file. In the following example, the blue tabs
belong to the plan files for department 19100 and the orange tabs belong to the budget for department
27200.

Setup Guide Axiom Budgeting │ 219



To close a sheet, click the X next to the tab name. If you have unsaved data, the system will prompt you
to save before closing.

NOTE: If there is only one sheet open for the plan file and you close it, the entire plan file will close.

� Changing sheet views
On theMain ribbon tab, click the Change View drop-down to select how to display data on certain
budget tabs.

For example, the Statistics and Revenue tab drop-down menus allows you to choose whether a section
of a sheet displays data for annual, monthly, and projection intervals.

� Understanding cell formatting and input types
The cells in the budget plan file are color coded as follows:

l White cells: Displays information only. The values are either hard-coded, pre-populated from the
database, or calculated from other fields, and cannot be changed.

l Blue cells: These fields can be edited. Blue-shaded cells might be empty or pre-populated with a
value or formula that you can change.

l Green cells:. From these cells, you can select from one of several predefined options.
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While different budget plan files call for different types of user input, some common cases where the user
is called upon to enter values include:

l Adjustments – Some calculations depend on historical account balances and can only be affected
by changing the budgeted increase over the previous year.

l Spreads – Some calculations automatically spread the budget value over the year, others allow
direct entry to adjust themonthly spread.

l Monthly input – There are sections on some tabs that allow you to enter values, while others
have formulas which pre-populate values directly into each of the twelvemonths.

l Variance comments / Red flags – For certain values, the Budget Administrator may set variance
thresholds which, if exceeded, cause a red flag icon ( ) to display. The system may display a
warning message if you attempt to save the budget. When this happens, enter a comment in the
Comment field explaining the reason(s) for the variance. Entering a comment allows you to save
the budget normally.

� Understanding source data
Themajority of a budget is pre-populated with data. Sources for this data include:

l Dimension tables –When you open a plan file, Axiom Budgeting typically runs a query against
one or more dimension tables and returns data for the specified department, account, and so on.

l Data tables – These tables contain data associated with one or more dimensions. Budgeting-
related examples include Financial and Payroll data tables.

l Driver files – Some cells in plan files contain formulas that reference assumptions (key statistics)
contained in the plan file's driver files.

l File group variables – Axiom Budgeting can associate certain variables with a file group. The
variable most often used in Axiom Budgeting 2019.3 is the file group year, which is set by Kaufman
Hall when initially creating the file group.

l Other cells / other sheets – Some values are calculated based on the contents of other cells or
sheets within the plan file.

� Understanding calculation methods
Calculation methods (calc methods) are pre-formatted groups of rows with pre-defined cell contents that
can be inserted into plan files or reports. For instance, a budget plan file might use calc methods to insert
multi-line records for each account associated with a given department.

The cells in a calc method may include formulas. These formulas might incorporate variables that
reference the year of an associated file group or an assumption or configuration setting in a driver file.
Some calc methods also incorporate user-defined variables.

Creating or modifying budget plan files
When preparing a budget, complete the sheets in the budget plan file in the following order:
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1. Read the Instructions sheet.

2. To get a sense of where the budget currently stands, review the budget Summary sheet.

TIP: Before you begin entering budget values, review the Department History sheet to look for
anomalies or holes in the data that do not make sense or cannot be explained - especially if
you intend to use the Department History used for Monthly Spreads section. Make sure to
resolve any data issues before you start creating a new budget for the next budget year.

3. Enter adjustment amounts on the Statistics and Revenue sheet. Provide comments for any red
flags.

4. Review the Employee Listing sheet to ensure that the number of resources listed in the Jobcode
sheet matches the employee list.

5. Enter adjustment amounts on the Provider Detail or Provider Summary sheet, if applicable.
Provide comments for any red flags.

NOTE: This tab displays only if your organization has purchased the Provider module.

6. Complete the Labor sheets.

NOTE: Most organizations/departments use the Jobcode sheet, but the plan file may also
include Staffing, Employee, and/or ADC sheets, depending on payroll methodologies
employed at your organization.

7. When salary adjustments occur, adjust the Employee sheet.

8. Enter adjustment amounts on the Expense sheet. Add or update accounts, as necessary. Provide
comments for any red flags.

9. As you enter values for the budget, review the Department History sheet to confirm whether new
values are in line with expectations.

10. Enter information for new initiatives on the Initiatives sheet, if applicable.

11. To clarify strategic objectives, complete the questions on the Operating Plan sheet.

12. Attach any supporting files needed for evaluating or supporting the budget.

13. Save the budget plan file, and advance it to the next stage of process management for
review/approval.

For instructions on how to navigate the plan file, change views, etc., see Using budget plan files.
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Reading instructions

� Overview
The Instructions sheet provides information related to the following areas:

l Timeline and Deadlines for Submitting Budgets - Dates and other deadline information for
submitting your budget.

l Your Contact for Budgeting Questions Is - The name and contact information for the person in
your organization to contact if you have questions about managing the budget plan file.

l Budget Assumptions - Overall, high-level assumptions that may be important when creating your
budget.

l Instructions for Budgeting - Instructions related to navigating and entering information in the
budget.

NOTE: The information on this tab, including the section names, are determined and set up by your
organization. If you have Administrator privileges, you can add or edit the contents of this tab in the
Budget Assumptions driverBudget Assumptions driver.
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Reviewing budget summary

� Overview
The Summary sheet provides an overview of the entire budget. Beforemaking revisions, review the
Summary tab to get a sense of where the budget currently stands. After completing revisions, return to
the Summary sheet to see how the figures have changed. This sheet is also useful when submitting a
budget plan file for leadership review.

This sheet includes data from two sources:

l Base Budget – Summary of inputs on Stat_Rev and Expense tabs based on KHASum (set in column
U in the ACCT dimension table).

l New Initiatives – Incremental volumes, revenue, FTEs, and expenses for approved new initiatives.
It does not include data from unapproved initiatives.

This tab includes the following sections:

The Financial Summary section displays totals from the other tabs, along with the contribution margin.
The Analysis sections consist of Statistical Analysis and Hours Analysis, and features calculated metrics to
help gauge the reasonableness of a submitted budget.
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Completing statistic budget and reviewing revenue budget

� Overview
Use the Statistics and Revenue sheet to review and adjust current year projection amounts and next
year’s budget for statistics, revenues, and deductions. The sheet is segmented into two main areas:
statistics and revenue.

NOTE: Provide comments in any red comment cells.

� Statistics section
The following table describes the sections in this sheet:
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Section Description

Global Drivers Summarizes the Budget Assumptions used to drive initial projections
for the department.

Key Department Statistics Includes department-specific statistics that drive the variable gross
revenue, variable costs, and variable labor calculations in the
workbook. Global drivers are used to apply the overall organization
growth assumptions to the department statistic.

You can make adjustments in theMar-Jun change for CY as well as %
Adjust and Amt Adjust columns for NY Budget. Key statistics, such as
patient days by Nursing unit, are defined in the Budget Statistics
driverBudget Statistics driver.

NOTE: If a statistic Dept/Acct combination is listed in the Budget
Assumptions driverBudget Assumptions driver, no adjustments may
bemade in the budget plan file.

Other Non-Key Statistic Displays other statistics captured for the department, but do not
drive any other calculations in the workbook.

� Revenue section
The following table describes the sections in this sheet:
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Section Description

Patient Revenue Summarizes all revenue. Displays projections based on historical
revenue per unit plus price increase (revenue adjustments) times
volume.

Patient Revenue Detail Displays detailed patient revenue, both inpatient and outpatient, by
specific account.

Other Revenue Models the projection and budget for other operating revenue
accounts, typically using a Fixed Revenue calc method, which uses
the projected value as the starting point for budget. You can make
adjustments in theMar-Jun change, % Adjust, and Amt Adjust
columns.
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� Inserting a new statistic or revenue line item
You can add statistic or revenue line items to individual sections, including:

l Key and non-key statistics
l Deductions
l Net and other revenue
l Inpatient, outpatient, and other patient revenue

The system adds the line by inserting the appropriate calc method into the sheet. The following table lists
the available calc methods used by the corresponding section in the sheet:

Calc Method Description Sheet Section

Add NewDetail Zero-based expense calculations when
adding a new account. Inputs are done on
the Detail tab in the budget plan file.

l Other Patient
Revenue

l Other Revenue

Add New Fixed Revenue Use this new revenue calc method to add a
new Fixed Revenue account.

l Inpatient Revenue
l Outpatient Revenue
l Other Patient

Revenue
l Other Revenue

Add New Input Monthly Use this new revenue or statistic calc
method to add a new account.

l Deductions from
Revenue

l Inpatient Revenue
l Outpatient Revenue
l Other Patient

Revenue
l Other Revenue

Add New Statistic Use this new statistic calc method to add a
new key statistic account.

Key Department
Statistics

Add New Statistic_Oth Use this new statistic calc method to add a
newOther Statistic account.

Other Non-Key Statistics

GlobalSum This SPM allows you to budget for an
account at a percentage of the total of
specific other account(s) within the same
workbook.

Net Revenue

Setup Guide Axiom Budgeting │ 229



Calc Method Description Sheet Section

ProviderRev Transfers Revenue calculations from the
Provider Summary/Provider Detail tab to
the Stat_Rev tab to save to the Financial
Data tables.

NOTE: Only available to organizations with
the Provider module license.

l Inpatient Revenue
l Outpatient Revenue
l Other Patient

Revenue

ProviderStat Transfers Statistic calculations from the
Provider Summary/Provider Detail tab to
the Stat_Rev tab to save to the Financial
Data tables.

l Key Department
Statistics

l Other Non-Key
Statistics

To insert a new statistic or revenue line item:
1. Navigate to the section to add the new line item.

2. Double-click theDouble Click to Insert... cell.

3. In the Insert Calc Method(s) in sheet Stat_Rev dialog, select the calc method to insert, and click
OK.

NOTE: If the line only uses or your organization is only licensed for one type of calc method,
this dialog will not display. The system will open the Calc Methods Variable dialog instead.

4. In the Calc Methods Variable dialog, enter or select the account and department number, and
click OK.

5. Enter the appropriate values in the blue cells, as needed.

6. After making your changes, in the budget file Navigation panel, click Save Budget.

TIP: You can also click the Save button in theMain ribbon tab.

Reviewing employee master

� Overview
Use the Employee Listing sheet as reference to calculate when salary adjustments occur throughout the
planning cycle. This sheet lists all employees by job code and includes details regarding each employee's
current and next year's rate as well as their merit and market increasemonth and percentage.
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To make the budget plan file as accurate as it can be when calculating salaries, the system takes into
account any potential current year rate increases set to take place - depending on when the budget plan
file is built. For example, let's say the following budget plan file is built in month 8. All the radiology
technicians except Michael and Jeff have likely received their rate increases already because 0% displays
in the CY Inc % column and their anniversary dates have already passed. However, Michael is set to
receive his increase in month 9 and Jeff in month 10. The system anticipates this increase by showing
that their beginning rate as 3% higher than their current rate and uses this rate for the budget.

The system does the same for scheduled budget market and merit increases as well. In this example,
everyone will receive a 3%merit increase but no market increases. The system allows you to include up
to two market increases, which simply provides a way to apply additional percentages beyond themerit
increase. For example, a contract may stipulate that nurses receive two market increases per year.

The system then layers together all of the rate adjustments as well as themerit and market increases to
provide you with values related to the amount that salaries will increasemonth-over-month over the
year. In the following example, July starts with an increase of 0.70% but begins to increasemonth to
month as more employees receive their salary adjustments. These values are used in the Jobcode tab to
calculate salaries.
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The last month of the fiscal year becomes the "fully burdened" month because by this point all of the
increases have occurred. The effective rate for the fiscal year is located in the Total FTEs column. Knowing
the effective rate helps you determine the effect of adding merit or market adjustments. In the example
below, the user now knows that adding a 3%merit increase will result in a 1.67 effective rate.

The remaining section of the sheet is devoted to the scheduled hours for scheduled FTE employees. The
system projects scheduled hours based on when the employee was hired and whether they are working
full or part time.

Keep in mind the following when using this sheet:

l Employees are only listed in their home department. The Jobcode sheet may showmore
employees than what are listed for the job code in the Employee Listing sheet. This means that
employees have been borrowed from other departments.

l The Employee Listing sheet only displays current active employees.
l To add an employee, you must do so through the labor method itself. For example, if you use the

employee budgeting methodology, you must add a new employee in the Employee sheet.
l Merit and market increase factors are defined in the LaborRates sheet of the Budget Labor

Assumptions driverBudget Labor Assumptions driver.
l This sheet incorporates max rate logic to calculate the lump sum payout if an employee is

currently above their max limit or defined increases will put them above the limit.
l Max limits are defined in the Budget Labor Limits driverBudget Labor Limits driver.

Use this sheet to calculate PTO accrual hours if activated in the Budget Configuration driverBudget
Configuration driver.
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Completing labor budget

� Overview
Different departments may use different methodologies to track their labor expenses (FTEs and salary
dollars). To facilitate this, the budget plan file template includes several different labor sheets for tracking
payroll. When a department's budget plan file is first created, the system copies the payroll sheet
specified for that department in the LaborType field of the DEPT dimension table.

There are four Labor sheets used to cover thesemethodologies:

l JobCode – Use for departments needing the ability to adjust FTEs on a monthly basis or based on
volume.

l Employee – Use to allow departments to budget at the employee level. No volume adjustments
are included in the salary calculations.

l Staffing – Use for 24/7 departments to prepare the budget by shift/day of the week.
l ADC Configuration – Use for nursing departments to prepare the budget Average Daily Census

(ADC) and Nursing Staffing grid levels by job class.

NOTE: This tab only works with the JobCode tab.

l Provider Detail and Provider Summary - Use to budget at the provider level.

JobCode sheet

� Overview
The JobCode sheet is used for departments that need to adjust FTEs on a monthly basis or based on
volume.
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This sheet is comprised of threemain areas:

Summary and Target
This area displays at the top of the sheet and provides an overview of the productive hours, target hours
per unit, FTEs from target, paid hours per unit, and the productive percentage. This area automatically
updates as detail is added to each job code block. Targets are defined by department on the Budget
Labor Benchmark driverBudget Labor Benchmark driver.

The Summary and Target area provides a quick and easy way to ensure that your numbers are on track
without having to dive into the details.

Jobcode Statistics
This section displays all of the statistic values related to the job codes in the department, including the
following:

l Departmental totals
l Total program additions
l Total position changes
l Total productive FTEs
l Total non-productive FTEs
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Jobcode
Most of the sheet is comprised of the individual job code values. By default, the sheet displays only a
summary view of the job code that includes the total productive, non-productive FTEs as well as the total
FTEs for the job code.

To view the job code details, double-click theDouble click to show details cell. From this expanded
section, you can view specific details about the job code.
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� Sheet columns
The following table provides descriptions for the columns in this sheet:

Column Name Column
Letter

Description

Job Code A The job code identification number (using
Jobcode.KHABgtCode).

Current Rate G The hourly rate as of the start of the budget process.

Start Rate H The hourly rate as of the start of the new budget year.
This includes any salary increases expected to occur in
the remainder of the current year.

End Rate I The hourly rate as of the end of the budget process. This
includes all salary increases through the end of the
budget year. This is calculated using the last month of the
budget as this would contain the effective rate of all merit
& market adjustments.

Alloc Rate J Calculated based upon YTD actual % of total FTE. You can
make adjustments to allocate NYB FTEs for salary
calculations.

Sched K Scheduled FTEs from the labor master file or CYB FTEs
depending on the configuration option chosen in the
Budget Configuration Assumptions driver file.

YTD Actual L Year-to-date FTEs from the Payroll26 database.

Month-Month Projected
(FTEs)

M Projected FTEs for the remaining months of the current
fiscal year. Initial FTE allocation is the same as YTD.
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Column Name Column
Letter

Description

FY20XX Budget (FTEs) N Starting point matches projected FTEs. You can make
monthly adjustments to theMonth FTEs columns
(columns S-AD).

Month-Month Projected
(Dollars)

O Projected dollars for the remaining months of the current
fiscal year.

FY20XX Budget (Dollars) P Projected dollars for the budget year.

Notes Q Enter comments for the line item, as needed.

Spread Method R Select a spread method for the pay type, as needed.

Month FTEs S-AD Enter a percentage of each FTE factor to the total factor.
For example, let's say that the FTE factor for month one is
177 divided by the FTE factor for the year of 2080 or 2086.
It usually ranges around 8% or so per month.

NOTE: Not all pay types allow you to update the spread
amount.

Month-Year Hours AG-AS Hours spread across months, including total budgeted
hours.

Month-Year Dollars AT-BF Dollars spread across months, including total budgeted
dollars.

Month-Year FICA BH-BT FICA spread across months, including total budged FICA.

Projected FICA BW Total projected FICA amount.

Month-Month Hours BX Total budgeted hours for the remaining months of the
fiscal year.

The following sections include instructions on performing specific actions in this sheet.

� Updating the staffing ratio for a job code
Use these instructions if you want to change the default staffing ratio type.

To update staffing ratio type for a job code:
1. Navigate to the job code, and double-click Double click to show details.
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2. In the job code title row, from the drop-down, select one of the following:
l Variable - Input is the worked FTEs per a normal work week. Non-productive hours are

added to productive based upon allocation percentage. This setting is a default from the
JOBCODE dimension. When Variable, the values in the job code will fluctuate based on
changes in the departments volume.

l Fixed - Input is the total paid FTEs per a normal work week. Non-productive hours are
allocated based upon allocation percentage. This setting is a default from the JOBCODE
dimension. When FIXED, the values in the jobcode will not fluctuate based on changes in
the departments volume.

3. In theNotes column (column Q), enter comments, as needed.

4. After making your changes, in the budget file Navigation panel, click Save Budget.

TIP: You can also click the Save button in theMain ribbon tab.

� Updating start rate and projected FTEs for program additions and position changes
To update start rate and projected FTEs for program additions and position changes:

1. Navigate to the job code, and double-click Double click to show details.

2. In the Program Additions field (column H), type the start rate amount.
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3. In the Position Changes field (column H), type the start rate amount.

4. In theMonth-Month Projected column (column M) for the program additions and position
changes line items, as needed.

5. In theNotes column (column Q), enter comments, as needed.

6. After making your changes, in the budget file Navigation panel, click Save Budget.

� Updating the allocation rate for a job code pay type
To update the allocation rate for a job code pay type:

1. Navigate to the job code, and double-click Double click to show details.

2. In the Alloc Rate column (column J), enter a percentage for each line item, as needed.
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3. In theNotes column (column Q), enter comments, as needed.

4. After making your changes, in the budget file Navigation panel, click Save Budget.

� Updating the spread method for a job code pay type
To update the spread method for a job code pay type:

1. Navigate to the job code, and double-click Double click to show details.

2. From the Spread Method column (column R), select the spread method to use.
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3. In theMonth-Year FTEs columns (columns S-AD), make adjustments, as needed.

NOTE: The spread methods available are configured by your organization.

4. After making your changes, in the budget file Navigation panel, click Save Budget.

� Adding contract labor
To add contract labor:

1. Navigate to the contract labor job code.

2. In the Current Rate column (column G), enter the hourly rate for the contract labor.

3. In the Start Rate column (column H), enter the starting rate.

4. In theMonth-Month Projected (FTEs) column (column M), enter the projected FTE value.

5. In theMonth-Year FTEs columns (columns S-AD), enter the FTE spread across months.

6. After making your changes, in the budget file Navigation panel, click Save Budget.
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� Adding a new pay type for a job code
To add a new pay type for a job code:

1. In the job code in which to add the new employee, double-click Double click to show details.

2. Double-click Double Click to Insert New Pay Type.

3. From the Insert Calc Method(s) in sheet Employee dialog, select one of the following calc
methods, and click OK:

NOTE: The dialog includes fields that are not enabled at this time.

l Add New AvgPer Paid Hr PayType - Calculates other non-FTE related pay based on the
relationship to paid hours in the job code block. Monthly spread will be based on the
spread of paid hours.

l Add New AvgPer Prod Hr PayType - Calculates other non-FTE related pay based on the
relationship to productive hours in the job code block. Monthly spread will be based on the
spread of productive hours.

l Add New Input Monthly PayType - Calculates other non-FTE related pay by typing in the
monthly totals.

4. Do the following based on the calc method you selected in step 3:
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Calc Method Steps

Add NewAvgPer
Paid Hr PayType

Add NewAvgPer
Prod Hr PayType

a. In the Calc Method Variables dialog, enter a pay type or click
Choose Value to select a pay type, and then click OK.

b. In the Start Rate column (column H), enter the hourly start
rate.

c. In theNotes column (column Q), enter comments, as needed.

d. Repeat steps a-c for each pay type to add.

e. When you finish making changes, in the budget file Navigation
panel, click Save Budget.

Add New Input
Monthly PayType

a. In the Calc Method Variables dialog, enter a pay type or click
Choose Value to select a pay type, and then click OK.

b. In theMonth-Month Projected (Dollars) column (column O),
enter the projected dollars.

c. In themonthly budget (columns AT-BE), enter values for the
applicable months.

d. In theNotes column (column Q), enter comments, as needed.

e. Repeat steps a-d for each pay type to add.

f. When you finish making changes, in the budget file Navigation
panel, click Save Budget.

� Adding a new job code to a department
To add a new job code to a department:

1. Navigate to the end of the job code listing, and double-click Double Click to Insert New Job Code.
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2. In the Calc Method Variables dialog, do the following, and then click OK:
a. In the Select a JobCode field, enter a job code or click Choose Value to select a job code.

b. In the Select a Dept field, enter a department or click Choose Value to select a department.

3. To enter adjustments to allocate NYB FTEs for salary calculations, click Double Click to Show
Details.

4. From the details section, do any of the following:
l Updating start rate and projected FTEs for program additions and position changes
l Updating the allocation rate for a job code pay type
l Updating the spread method for a job code pay type

5. When you finish making changes, in the budget file Navigation panel, click Save Budget.

� Adding a new department pay type
To add a new department pay type:

1. Navigate to the bottom of the sheet, and double-click Double Click to Insert New Dept Pay Type.

2. From the Insert Calc Method(s) in sheet Employee dialog, select one of the following calc
methods, and click OK:

NOTE: The dialog includes fields that are not enabled at this time.

l Dept_AvgPerProdHr - Calculates other Non-FTE related pay based on the relationship to
productive hours in the department. Monthly spread will be based on the spread of
productive hours.
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l Dept_InputMonthly - Calculates other Non-FTE related pay by inputting monthly amounts
for the department.

l Dept_InputTotal - Calculates other Non-FTE related pay by typing in a total for the
department. Monthly spread will be spread evenly by month.

3. Do the following based on the calc method you selected in step 2:

Calc Method Steps

Dept_AvgPerProdHr a. In the Calc Method Variables dialog, enter a pay type or click
Choose Value to select a pay type, and then click OK.

b. In the Budget column (column H), enter the hourly start rate.

c. In theNotes column (column Q), enter comments, as needed.

d. Repeat steps a-c for each pay type to add.

e. When you finish making changes, in the budget file Navigation
panel, click Save Budget.

Dept_InputMonthly a. In the Calc Method Variables dialog, enter a pay type or click
Choose Value to select a pay type, and then click OK.

b. In theMonth-Month Projected (Dollars) column (column O),
enter the projected dollars.

c. In theNotes column (column Q), enter comments, as needed.

d. In themonthly budget (columns AT-BE), enter values for the
applicable months.

e. Repeat steps a-d for each pay type to add.

f. When you finish making changes, in the budget file Navigation
panel, click Save Budget.

Dept_InputTotal a. In the Calc Method Variables dialog, enter a pay type or click
Choose Value to select a pay type, and then click OK.

b. In theMonth-Month Projected (Dollars) column (column O),
enter the projected dollars.

c. In the FY 20XX Budget (Dollars) column (column P), enter the
projected budgeted dollars.

d. In theNotes column (column Q), enter comments, as needed.

e. Repeat steps a-d for each pay type to add.

f. When you finish making changes, in the budget file Navigation
panel, click Save Budget.
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Employee sheet

� Overview
The Employee sheet is for departments to budget at the employee level, and operates similarly to the
JobCode sheet. No volume adjustments are included in the salary calculations. This sheet combines the
data from the Employee Listing and Employee sheets.

This sheet is comprised of threemain areas:

Summary
This area displays at the top of the sheet and provides an overview of the FTE totals, target, and FTEs
from the budget target. It also shows you the paid hours and the productive percentage. This provides a
quick and easy way to ensure that your numbers are on track without having to dive into the details.
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Jobcode Statistics
This section displays all of the statistic values related to the job codes in the department, including the
following:

l Departmental paid totals
l Total float staff
l Total program additions
l Total position changes
l Total productive FTEs
l Total non-productive FTEs
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Jobcode summary and details
Most of the sheet is comprised of the individual job code values. By default, the sheet displays only a
summary view that includes the total productive, non-productive FTEs as well as the total FTEs for the
job code.

To view the job code details, double-click theDouble click to show details cell. From this expanded
section you can view specific details about the job code as well as a list of all the employees assigned the
job code.
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Keep in mind the following:

l Non-FTE-related pay categories are added during the interface process within the job code block
and use a dollars-per-productive-hour or input monthly methodology.

l You can makemonthly adjustments to FTEs to model staging of staffing changes.
l For contract labor, you must enter requests for contract labor FTEs. No default to YTD is made.

� Sheet columns
The following table provides descriptions for the columns in this sheet:

Column Name Column
Letter

Description

Job Code A The job code identification number number (using
Jobcode.KHABgtCode).

Employee ID F The identification number of the employee.

Current Rate G The hourly rate as of the start of the budget process.

Start Rate H The hourly rate as of the start of the new budget year.
This includes any salary increases expected to occur in
the remainder of the current year.
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Column Name Column
Letter

Description

End Rate I The hourly rate as of the end of the budget process. This
includes all salary increases through the end of the
budget year. This is calculated using the last month of the
budget as this would contain the effective rate of all merit
& market adjustments.

Alloc Rate J Calculated based upon YTD actual % of total FTE. You can
make adjustments to allocate NYB FTEs for salary
calculations.

Sched K Scheduled FTEs from the labor master file or CYB FTEs
depending on the configuration option chosen in the
Budget Configuration Assumptions driver file.

YTD Actual L Year-to-date FTEs from the Payroll26 database.

Month-Month Projected
(FTEs)

M Projected FTEs for the remaining months of the current
fiscal year. Initial FTE allocation is the same as YTD.

FY20XX Budget (FTEs) N Starting point matches projected FTEs. You can make
monthly adjustments theMonth-Year FTEs columns
(columns S-AD).

Month-Month Projected
(Dollars)

O Projected dollars for the remaining months of the current
fiscal year.

FY20XX Budget (Dollars) P Projected dollars for the budget year.

Notes Q Enter comments for the line item, as needed.

Spread Method R Select a spread method for the pay type, as needed.

Month-Year FTEs S-AD Enter a percentage of each FTE factor to the total factor.
For example, let's say that the FTE factor for month one is
177 divided by the FTE factor for the year of 2080 or 2086.
It usually ranges around 8% or so per month.

NOTE: Not all pay types allow you to update the spread
amount.

Month-Year Hours AG-AS Hours spread across months, including total budgeted
hours.

Month-Year Dollars AT-BF Dollars spread across months, including total budgeted
dollars.

Month-Year FICA BH-BT FICA spread across months, including total budged FICA.

Projected FICA BW Total projected FICA amount.
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Column Name Column
Letter

Description

Month-Month Hours BX Total budgeted hours for the remaining months of the
fiscal year.

Month-Month Dollars BY Total budgeted dollars for the remaining months of the
fiscal year.

The following sections include instructions on performing specific actions in this sheet.

� Updating projected and budgeted FTE for an employee
To update projected and budgeted FTE for an employee:

1. Navigate to the job code assigned to the employee, and double-click Double click to show
details.

2. In theMonth-Month Projected (column M) and FY 20XX Budget (column n) columns, update the
FTE values for the employee, as needed.

3. In theNotes column (column Q), enter comments, as needed.

4. After making your changes, in the budget file Navigation panel, click Save Budget.

� Updating projected FTEs for float staff/inactive employees, program additions, and
position changes
To update projected FTEs for float staff/inactive employees, program additions, and position
changes:

1. Navigate to the job code, and double-click Double click to show details.

Setup Guide Axiom Budgeting │ 251



2. In theMonth-Month Projected column (column M) for the Float Staff/Inactive Employees,
Program Additions, and Position Changes line items, as needed.

3. In theNotes column (column Q), enter comments, as needed.

4. After making your changes, in the budget file Navigation panel, click Save Budget.

� Updating the allocation rate for a job code pay type
To update the allocation rate for a job code pay type:

1. Navigate to the job code, and double-click Double click to show details.

2. In the Alloc Rate column (column J), enter a percentage for each line item, as needed.
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3. In theNotes column (column Q), enter comments, as needed.

4. After making your changes, in the budget file Navigation panel, click Save Budget.

� Updating the spread method for a job code pay type
To update the spread method for a job code pay type:

1. Navigate to the job code, and double-click Double click to show details.

2. From the Spread Method column (column R), select the spread method to use.

3. In theMonth-Year FTEs columns (columns S-AD), make adjustments, as needed.
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NOTE: The spread methods available are configured by your organization.

4. After making your changes, in the budget file Navigation panel, click Save Budget.

� Adding a new employee
To add a new employee:

1. Navigate to the job code to add the new employee, double-click Double click to show details.

2. Double-click Double Click to Insert New Employee.

3. Enter information in the following columns, as needed:
l Employee Name (column E)
l Employee ID (column F)
l Current Rate (column G)
l Start Rate (column H)
l Month-Month Projected (FTE) (column M)
l Notes (column Q)
l Month-Month FTE columns (columns S-AD)

4. After making your changes, in the budget file Navigation panel, click Save Budget.
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� Adding contract labor
To add contract labor:

1. Navigate to the contract labor job code.

2. In the Current Rate column (column G), enter the hourly rate for the contract labor.

3. In the Start Rate column (column H), enter the starting rate.

4. In theMonth-Month Projected (FTEs) column (column M), enter the projected FTE value.

5. In theMonth-Year FTEs columns (columns S-AD), enter the FTE spread across months.

6. After making your changes, in the budget file Navigation panel, click Save Budget.

� Adding a new pay type for a job code
To add a new pay type for a job code:

1. In the job code in which to add the new employee, double-click Double click to show details.

2. Double-click Double Click to Insert New Pay Type.
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3. From the Insert Calc Method(s) in sheet Employee dialog, select one of the following calc
methods, and click OK:

l Add New AvgPer Paid Hr PayType - Calculates other non-FTE related pay based on the
relationship to paid hours in the job code block. Monthly spread will be based on the
spread of paid hours.

l Add New AvgPer Prod Hr PayType - Calculates other non-FTE related pay based on the
relationship to productive hours in the job code block. Monthly spread will be based on the
spread of productive hours.

l Add New Input Monthly PayType - Calculates other non-FTE related pay by typing in the
monthly totals.

4. Do the following based on the calc method you selected in step 3:

Calc Method Steps

Add NewAvgPer
Paid Hr PayType

Add NewAvgPer
Prod Hr PayType

a. In the Calc Method Variables dialog, enter a pay type or click
Choose Value to select a pay type, and then click OK.

b. In the Start Rate column (column H), enter the hourly start
rate.

c. In theNotes column (column Q), enter comments, as needed.

d. Repeat steps a-c for each pay type to add.

e. When you finish making changes, in the budget file Navigation
panel, click Save Budget.
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Calc Method Steps

Add New Input
Monthly PayType

a. In the Calc Method Variables dialog, enter a pay type or click
Choose Value to select a pay type, and then click OK.

b. In theMonth-Month Projected (Dollars) column (column O),
enter the projected dollars.

c. In theNotes column (column Q), enter comments, as needed.

d. In themonthly budget (columns AT-BE), enter values for the
applicable months.

e. Repeat steps a-d for each pay type to add.

f. When you finish making changes, in the budget file Navigation
panel, click Save Budget.

� Adding a new job code to a department
To add a new job code to a department:

1. Navigate to the end of the job code listing, and double-click Double Click to Insert New Job Code.

2. In the Calc Method Variables dialog, enter a job code or click Choose Value to select a job code,
and then click OK.

3. To enter adjustments to allocate NYB FTEs for salary calculations, click Double Click to Show
Details.
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4. From the details section, do any of the following:
l Add a new pay type for a job code
l Update the spread method for a job code pay type
l Update the allocation rate for a job code pay type
l Update projected FTEs for float staff/inactive employees, program additions, and position

change
l Add a new employee
l Update projected and budgeted FTE for an employee

5. When you finish making changes, in the budget file Navigation panel, click Save Budget.

� Adding a new department pay type
To add a new department pay type:

1. Navigate to the bottom of the sheet, and double-click Double Click to Insert New Dept Pay Type.

2. From the Insert Calc Method(s) in sheet Employee dialog, select one of the following calc
methods, and click OK:

NOTE: The dialog includes fields that are not enabled at this time.

l Dept_AvgPerProdHr - Calculates other Non-FTE related pay based on the relationship to
productive hours in the department. Monthly spread will be based on the spread of
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productive hours.
l Dept_InputMonthly - Calculates other Non-FTE related pay by inputting monthly amounts

for the department.
l Dept_InputTotal - Calculates other Non-FTE related pay by typing in a total for the

department. Monthly spread will be spread evenly by month.

3. Do the following based on the calc method you selected in step 2:

Calc Method Steps

Dept_AvgPerProdHr a. In the Calc Method Variables dialog, enter a pay type or click
Choose Value to select a pay type, and then click OK.

b. In the Budget column (column H), enter the hourly start rate.

c. In theNotes column (column Q), enter comments, as needed.

d. Repeat steps a-c for each pay type to add.

e. When you finish making changes, in the budget file Navigation
panel, click Save Budget.

Dept_InputMonthly a. In the Calc Method Variables dialog, enter a pay type or click
Choose Value to select a pay type, and then click OK.

b. In theMonth-Month Projected (Dollars) column (column O),
enter the projected dollars.

c. In theNotes column (column Q), enter comments, as needed.

d. In themonthly budget (columns AT-BE), enter values for the
applicable months.

e. Repeat steps a-d for each pay type to add.

f. When you finish making changes, in the budget file Navigation
panel, click Save Budget.

Dept_InputTotal a. In the Calc Method Variables dialog, enter a pay type or click
Choose Value to select a pay type, and then click OK.

b. In theMonth-Month Projected (Dollars) column (column O),
enter the projected dollars.

c. In the FY 20XX Budget (Dollars) column (column P), enter the
projected budgeted dollars.

d. In theNotes column (column Q), enter comments, as needed.

e. Repeat steps a-d for each pay type to add.

f. When you finish making changes, in the budget file Navigation
panel, click Save Budget.
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Staffing sheet

� Overview
This sheet allows 24/7 departments to prepare the budget by shift/day of the week, such as a nursing
department, cafeteria, lab, or security. This sheet is comprised of threemain areas:

Staffing Summary
This area displays at the top of the sheet and provides an overview of the total hours for productive and
target, the FTEs from target, the paid hours per unit, and the productive percentage. It also shows the
trending of FTEs over timewith LYA, YTD, and budgeted. This provides a quick and easy way to ensure
that your numbers are on track without having to dive into the details.

Department Statistics
The first line item in the sheet displays the primary department statistics, which include LYA, YTD, and
budgeted hours as well as the total department hours and dollars over months.

Jobcode summary and details
Most of the sheet is comprised of the individual job code values. By default, the sheet displays only a
summary view that includes the shift FTE values, budgeted hours, pay type information, and the
breakdown of hours and dollars by month. To view the job code details, double-click theDouble click to
show details cell.

Setup Guide Axiom Budgeting │ 260



Instead of calculating values monthly, the Staffing sheet allows you to budget hours on a weekly basis
using the shift grid. This forms the core component of the calculations performed on this sheet. The
totals weekly hours are then translated into monthly values in terms of hours. As you move to the right,
you can view the spread of the hours and dollars.

While the Employee and Jobcode labor methods allow you to change FTEs on a monthly basis, you do
not have this ability using the Staffing labor method, though a lot of the logic is still the same in that you
still use budget to YTD or a target.

� Sheet columns
The following table provides descriptions for the columns in this sheet:

Column Name Column
Letter

Description

LYA N Values from Last Year Actuals

YTD O Values for Year To Date

Month-Month P Values for themonths for Remaining Projection

NYB Q Values for the annual New Years Budget
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Column Name Column
Letter

Description

Job Code AA The identification number associated with the job code
(using Jobcode.KHABgtCode)

Pay Type AB The pay type associated with the job code (using
Paytype.Staffing)

Pay Type Description AC A description of the pay type

Current Rate AD The current pay rate for the pay type

Begin Rate AE The beginning pay rate for the pay type

Year End Rate AF The pay rate for the pay type at the end of the year

Month-Year Hours AG-AR Total hours for each month of the year

Total Hours AS The sum of the total hours

Month-Year Dollars AT-BE Total dollars for each month of the year

Total Dollars BF The sum of the total dollars

� Updating the number of days to staff in a week
To update the number of days to staff in a week:

1. In theDays Staffed/Week field, type the number of days to staff in a week.

l Selecting 7will allocate FTEs in the grid to all seven days of the week.

l Selecting 5will allocate FTEs in the grid to only Mon-Fri columns.

2. After making your changes, in the budget file Navigation panel, click Save Budget.

� Updating the shift FTE hours for a job code
The shift grid provides a visual representation of a full 24-hour clock. You can enter all your FTEs in a
specific row or you can split them up by time of day. While most organizations simply enter all their
hours in the Day part of the grid, you may want to enter hours in another part of the day if there is a
premium pay rate for those FTEs in the budget.

To update the shift FTE values for a job code:
1. Navigate to the job code, and double-click Double click to show details.
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2. In the job code title row, from the drop-down, select the shift to assign to the job code.

3. Next to the shift drop-down, from the Fixed/Variable drop-down, select one of the following:

NOTE: In most cases, you will not need to change this unless an exception needs to bemade
to this job code.

l Fixed - The input is the Total Paid FTEs per a normal work week. Non-productive hours are
allocated based on the allocation percentage.

l Variable - The input is theWorked FTEs per a normal work week. Non-productive hours are
added based upon grossing up to total hours then subtracting productive hours.

l Fixed w/ Replacement - Similar to fixed, the input is the Total Paid FTEs per a normal work
week. Non-productive hours are added based upon grossing up to total hours then
subtracting productive hours.

4. In the shift grid, enter the FTE hours for each day of the work week.

5. After you make your changes, in the budget file Navigation panel, click Save Budget.
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� Updating the allocation rate for a job code pay type
To update the allocation rate for a job code pay type:

1. Navigate to the job code, and double-click Double click to show details.

2. In the Allocation % column (column R), enter the allocation percentage for each pay type, as
needed.

3. After you finish making your changes, in the budget file Navigation panel, click Save Budget.

� Updating the pay type values for a job code
To update the pay type values for a job code:

1. Navigate to the job code, and double-click Double click to show details.

2. In theMonth-Month column (column P) and NYB column (column Q), enter dollar amounts in the
blue fields for each applicable pay type.
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3. After you finish making your changes, in the budget file Navigation panel, click Save Budget.

� Updating the monthly spread
To update the monthly spread:

1. Navigate to the job code, and double-click Double click to show details.

2. In theMonthly Spread column (column V), select one of the following:

NOTE: The choices in the drop-down depend on the pay type.

l FTEAlloc - Percentage of each FTE factor to the total factor. For example, let's say that the
FTE factor for month one is 177 divided by the FTE factor for the year of 2080 or 2086. It
usually ranges around 8% or so per month.

l Global - Define your own percentage. For example, you may want to use this for a special
project where you know there will be a higher use of overtime over the next threemonths
for this project. You can use this option to reflect this in your budget.

l History - Percentage determined over a rolling 12months (i.e. Percentage ofmonth one to
total, month two to total, etc.)

l Prod Hours - Percentage based on productive hours per month to total.
l Paid Hours - Percentage based on the paid hours per month to total.
l Even - Spread evenly across each month.
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3. After you finish making your changes, in the budget file Navigation panel, click Save Budget.

� Adding contract labor
To add contract labor:

1. Navigate to the contract labor job code.

2. In theMonth-Month column (column O), type the total hours for themonths.

3. In theNYB column (column P), type the total hours for the next year's budget.

4. In theHrly Rate cells (column Y and Z), type the hourly rate for current year and for next year's
budget.

5. After you finish making your changes, in the budget file Navigation panel, click Save Budget.

� Adding a new job code
To add a new job code:

1. Navigate to the bottom of the job code list, and double-click Double Click to Insert New Job
Code.

2. In the Select Job Code field, type a job code or click Choose Value to select one, and click OK.

3. Do the following:
l Update the shift values
l Update the allocation rate
l Update the pay type values for non FTE, if needed
l Wage rate for Regular pay for the new job code can be pre-populated if the “Mid” wage rate

from the Labor Rates driver is filled out. Otherwise, a rate can bemanually entered in the
“Current Rate” column (note blue cell for Regular in the image below).

l You can also enter the starting month of the added FTE (if parital year) in the “Start” and
“End” section (note blue cells below for “Start” and “End”).
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4. After you finish making changes, in the budget file Navigation panel, click Save Budget.

� Adding a new department pay type
To add a new department pay type:

1. Navigate to the bottom of the job code list, and double-click Double Click to Insert New Dept Pay
Type.

2. In the Insert Calc Method(s) in sheet Staffing dialog, click OK.

3. In the Select Pay Type field, type a pay type or click Choose Value to select one, and click OK.

4. In theMonth-Month Dollars column (column P), enter the dollars for the pay type.

5. After you finish making your changes, in the budget file Navigation panel, click Save Budget.

Labor Standard by ADC Setup sheet

� Overview
This sheet is designed for nursing departments to prepare an Average Daily Census (ADC) budget and
staffing levels by job class. The ADC worksheet models nursing staffing ratios by ADC level by job class
level.
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IMPORTANT: All positions have to be budgeted in this sheet if you are going to use this labor
method.

The sheet is comprised of threemain areas:

ADC Table
The ADC Table allows you to set the staffing ratio for a job class. You can configure up to 15 job classes.
The staffing ratio determines the number of staff needed per patient. For example, if the RN staffing ratio
is 5:1, then for census levels 1-5, one nurse would be required. At census levels 6-10, two nurses would be
required.

NOTE: The Fixed/Variable settings and the ratio values may be configured for the department using
the Budget Labor ADC Config driverBudget Labor ADC Config driver. The system applies the setup
from this driver to the ADC sheet (starting in column W) in the plan file. The ADC staffing grid builds
out based on the staffing ratios entered for each job class set up in the Budget Assumptions
driverBudget Assumptions driver.

Calculated Staffing Grid
The staffing grid is used to calculate job class specific budget FTEs. There is a section for each job class
that displays the results of these calculations (starting in column F). All calculations are then transferred
to the JobCode tab and allocated to each job code based on relative historical FTEs within each job class.
There is a row for non-productive time for each job class, which defaults to values based off of the history
for each job class, but you can change them, if desired. The productive and non-productive hours are
transferred to the JobCode sheet and distributed to each job code using the YTD historical distribution.
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Summary
The Summary section at the top of the ADC sheet that shows the following:

l The Patient Days for projection and for each budget month. Average Daily Cencus (ADC) values are
also presented.

l FTE information for the department by productive and non-productive.
l FTE differences between the JobCode tab and ADC tab for the department.
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NOTE: You can only use this feature with the JobCode tab. It is not configured to work with the
Staffing or Employee tabs. If the historical hours are zero for the defined JobClass, then JobClass will
not populate a section or the section title will remain unused.

The following sections include instructions on performing specific actions in this sheet.

� Setting the staffing ratio/paid FTEs for a job class
Setting the staffing ratio/paid FTEs for a job class:

1. Navigate to the ADC Table section of the sheet (starting at column W).

NOTE: If your organization has already added these values from the Budget Assumptions
driver, then you may not need to modify. Your system administrator will provide direction, as
needed.

2. In the Fixed/Variable row, select one of the following from the drop-downs:
l Fixed - The input is the Total Paid FTEs. Non-productive hours are allocated based on the

allocation percentage. This means that no matter howmany Average Daily Census days are
calculated in the Summary section, the number of employees will always remain fixed to
the number you enter in the Jobclass row (step 3 below).

l Variable - The input is the Staffing Ratio. Non-productive hours are added to productive
based upon the allocation percentage. This means that the number of people in this job
class will fluctuate based on the Average Daily Census days, so themore ADC days themore
employees are required.

l Fixed w/ Replacement - Similar to fixed, the input is the Total Paid FTEs. Non-productive
hours are added to the total based on the allocation percentage. The difference is that the
number of employees can be split across job codes in a job class.

3. In the Jobclass row, complete the following, depending on the staffing ratio type you selected in
step 2:

l Fixed - Type the true number of FTEs required. In the following example, four LPN FTEs are
required - regardless of patient census.
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l Variable - Type the number of patients the FTE can care for. In the following example, one
RN FTE can care for up to six patients. If more than one RN job code exists on the Jobcode
tab, the FTE value will be allocated to each occurrence of an RN job code

l Fixed w/ Replacement - Type the true number of FTEs required - regardless of patient
census. In the following example, only one clerical job class is required for each patient, but
those hours can be split among multiple job codes in the clerical job class.

4. To update the budgeted non-productive percentage for a job class, navigate to a job class, and in
the Budget Non Prod % row, enter the percentage value for each month, as needed.

NOTE: Using Jobcode ADC will require that you use the payroll utility that accrues biweekly to
monthly so that the historical productive and non productive hours can be used in the plan
file for JobcodeADC.

5. After making your changes, in the budget file Navigation panel, click Save Budget.
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6. Review the Jobclass data on the ADC grid. This will present several data points such as productive
and non productive FTE and hours that will be transferred to the Jobcode tab.

In the following example for the RN jobclass, 20.36 total budget FTEs were calculated from the ADC
staffing grid. The FTEs may vary month to month as shown below. Each month’s FTEs will be
transferred to the Jobcode tab.

Setup Guide Axiom Budgeting │ 272



Provider Detail and Provider Summary sheets

NOTE: This tab only displays if your organization purchased the Provider module license.

There are two sheets available that include provider level information: Provider Summary and Provider
Detail.

Provider statistics are computed using historical relationships. Provider volumes are computed using
today’s Encounters per Production Day and adjusted for next year’s Available Production Days.

IMPORTANT: Because the tab is rebuildable, any changes made in the Provider data tables after the
plan file is built will be automatically updated in the plan file. These changes are commonly referred
to as prior period adjustments, which will be reflected in the YTD columns in the tab.

To view a list of Provider calc methods, click the following:

l Expense sheet calc methods
l Provider sheet calc methods
l Stat_Rev sheet calc methods

� Provider Summary sheet
This sheet provides a summary of the totals at the department and individual provider level.
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NOTE: After you make changes to a provider on the Provider Summary sheet, you must navigate to
the ProviderComp sheet, and double-click to expand the details for the same provider to propagate
the changes from the Provider Summary sheet.

� Provider Detail sheet
This sheet shows summary subtotal information for each provider, but you can also access the details for
each provider by using the Click-to-Expand feature.

The Click-to-Expand feature expands the rows and inserts the calc method that includes the provider
detail information such as WRVUs, gross charges, RVUs, encounters, and so on. You can simply scan and
review the summary information for each provider without having to sort through multiple lines of
details to view the information you need, and if necessary, expand the details and manage only those
providers that need it.
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TIP: When you save the file, the system will remember which providers you have expanded the detail
rows for that day. Let's say you expanded the detail rows for five providers and saved your changes,
when you open the file later, the detail lines will still display for those five providers. When the plan
file processes that evening, however, the system will collapse all of the detail rows so that the tab
opens faster.

NOTE: After you make changes to a provider on the Provider Detail sheet, you must navigate to the
ProviderComp sheet, and double-click to expand the details for the same provider to propagate the
changes from the Provider Detail sheet.

IMPORTANT: The Summary Department Totals section at the top of the tab will not update values
until you save changes to the workbook.
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� Updating detail provider values from the Stat_Rev tab
Any changes made to the provider's FTE value on the ProviderComp sheet will affect the values for that
provider in the Provider Detail sheet. To see that result within your session, double-click theDouble click
to collapse/refresh Provider summaries cell to refresh the data; otherwise, the nightly recalculation
process will update it automatically.

ProviderComp sheet

NOTE: This sheet displays only if your organization has purchased the Provider module.

The ProviderComp sheet displays the selected calc methods for provider compensation, which you can
change in the Budget Provider Assumptions driver (if you have Administrator role privileges).

NOTE: Provider Volume data carries over from the Provider Summary or Provider Detail sheet.

You can automatically change compensation models at a set point during the budget year. To
accomplish this, designate the Primary and Secondary Comp Models for each provider in the Budget
Provider Assumptions plan file, along with the Comp Model Changemonth. To keep the same Comp
Model throughout the year, select the same Comp Model for both the primary and secondary options.

NOTE: After you make changes to a provider on the ProviderComp sheet, you must navigate to the
Provider Summary or Provider Detail sheet, and double-click to expand the details for the same
provider to propagate the changes from the ProviderComp sheet.
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IMPORTANT: Any changes made to the provider's FTE value on this tab will affect the values for that
provider in the Provider Detail tab. For instructions, see Updating detail provider values from the
Stat_Rev tab.

Comp model explanations

Model Description

Salary A traditional hourly rate calculation (usually used for Clinical Nurse
Practitioners and Physician Assistants who are referred to as Midlevel
providers). FTEs are input for the provider and hourly rate pulls from
payroll data.
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Model Description

Guarantee An annual salary guarantee is placed in the ProviderList sheet of the
Budget Provider Assumptions driver file (generally used in the first one to
two years of hire); You can also add an incentive compensation by placing
rates in the tier tables on the same line. For example, Dr. Falk’s guarantee
is $500,000 for next year and his totalWRVUs=5,200. In addition to his
guarantee, he will be paid:
l Level 1 - $7.00 for WRVUs up to 1,000

1000 x $ 7= $  7,000
l Level 2 - $8.00 for WRVUs from 1,001-2,000

1000 x $ 8= $  8,000
l Level 3 - $9.00 for WRVUs from 2,001-3,000

1000 x $ 9= $  9,000
l Level 4 - $10.00 for WRVUs from 3,001-4,000

1000 x $10=$10,000
l Level 5 - $11.00 for WRVUs above 4,000 (max 9,999)

1200 x $11=$13,200

His total compensation will be 5200 $54,720.

CompRate A five-tiered model where volume drives the rate paid. (Highest tier for
volume is paid at that tier rate) For example, Dr. Champion has total
WRVUs of 2,500.
l Level 1 – Threshold=1,000 $0
l Level 2 – Threshold=2,000 $0
l Level 3 – Threshold=3,000 2500 x $ 45 = $112,500
l Level 4 – Threshold=4,000 $0
l Level 5 – Threshold=9,999 $0

His total compensation will be 2500 $112,500.
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Model Description

CompStep A five-tiered model where an employee is paid a different rate, by tier, over
the course of a contract year. For example, Dr. Quintin has totalWRVUs of
1,800.
l Level 1 - $40.00 for WRVUs up to 750

750 x $40= $30,000
l Level 2 - $43.00 for WRVUs from 751-1,000

250 x $43= $10,750
l Level 3 - $45.00 for WRVUs from 1,001-1,500

500 x $45= $22,500
l Level 4 - $47.00 for WRVUs from 1,501-2,000

300 x $47= $14,100
l Level 5 - $50.00 for any Writs above 2,000 (max 9,999)

$0

Her total compensation will be 1800 $77,350.

Comp3Tier A three-tiered model where an employee is paid one rate up to a max and
another rate for any volume over themax. There is also a rate if it is below
a minimum level of volume. For example, Dr. Brush has totalWRVUs of
5,000.
l Level 1 - $32.00 if his totalWRVUs were below 3,600

$0
l Level 2 - $36.00 for all WRVUs up to 4,800

4800 x $36= $172,800
l Level 3 - $48.00 for WRVUs above 4,800

200 x $48= $9,600

His total compensation will be 5000 $182,400.

Max The highest value of Salary, Guarantee, CompRate, CompStep, and
Comp3Tier calculations.

AltRate Uses the same logic as CompRate. A five-tiered model where volume drives
the rate paid. (The highest tier for volume is paid at that tier rate.) Use this
model to compare an alternate CompRate table.

AltStep Uses the same logic as CompStep. A five-tiered model where an employee
is paid a different rate, by tier, over the year. Use this model to compare an
alternate CompStep table.

Alt3Tier Uses the same logic as Comp3Tier. A three-tiered model where an
employee is paid one rate up to a max and another rate for any volume
over themax. There is also a rate if the volume is below a minimum level.
Use this model to compare an alternate CompStep table
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Model Description

Percent of Net
Receivable

Calculates a percent of cash collections from the Provider sheet to use for
compensation calculations. The percentage to use needs to be entered on
the ProviderList sheet of the Budget Provider Assumptions driver file. For
example, Dr. Champion takes cash collections and receives 25%. If his
budgeted cash collections is $1,000,000, then his total compensation will
be $250,000. For example, $1,000,000 * 25% = $250,000.

Percent of Net
Revenue

Calculates a percent of net revenue by calculating Gross Charges minus
Allowances from the Provider sheet to use for compensation calculations.
The percentage to use needs to be entered on the ProviderList sheet of the
Budget Provider Assumptions driver file. For example, the Gross Charges
for Dr. Champion are $2,000,000 and Deductions are $1,500,000. He will
receive 40% of Net Revenue. As a result, his total compensation will be
$200,000. Example: $2,000,000-$1,500,000=$500,000 * 40%=$200,000

GlobalProvider Allows for a calculation amount that is calculated outside of the budget
workbook. This amount is entered into the GlobalProvider sheet in the
Budget Provider Assumptions driver file. The amount then pulls into the
budget workbook in the ProviderComp sheet.

Expense sheet

� Overview
The Expense sheet is where you review and adjust the current year projection and next year’s budget for
Expenses and Paid Hours. The Expense tab also captures data calculated on other budget tabs for paid
hours, salaries, and detail accounts.

The categories include:

l Salaries – All salary and contract labor accounts (Acct.BudgetType=’Salaries’). Most salary
calculations are done on the Labor tabs – JobCode, Staffing, or Employee. The Labor Calc Method
is used to summarize the salary dollars from the defined labor tab (JobCode, Staffing, Employee,
JobCode ADC).

l Benefits – All benefit accounts, if accounted for at the department level
(Acct.BudgetType=’Benefits’). FICA is calculated at the JobCode level on the Labor tabs.
If FICA is not budgeted at the department level, there is the option to use theMonthly FICA by
Dept report to summarize total FICA and add it to the Benefits department budget plan file.

l Supplies – All medical and other supply expense accounts (Acct.BudgetType=’Supplies’). Usually
budgeted on a rate-per-unit basis using the Variable calc method.

l Other Expenses – All other expenses, excluding Bad Debt (Acct.BudgetType=’OtherExp’). Calc
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methods are usually Fixed, Detail, Depreciation, or GlobalExpense.

l Paid Hours – All labor and contract labor hours accounts (Acct.BudgetType=’PaidHours’). Inputs
for hours are done on the Labor tabs – JobCode, Staffing or Employee. The Hours calc method is
used to summarize the paid hours.

NOTE: Be sure to provide comments in any comment field flagged red.

� Drilling to detail
You can drill from an account on the Expense tab (this tab only) to GL Transactions detail. To activate this
feature, open the Budget Configuration driverBudget Configuration driver. In the Expense Transaction
Drilling, On or Off row, select Yes or No to turn on the drill. This is not budget group-specific so the
election is for all plan files.

From the Expense tab, select the account desired, and drill on it from the year-to-date column. There are
three ways to drill on the account:

l On theMain ribbon tab, select Drill > JE Detail.
l From value on the Expense tab, right-click the year-to-date value, and select Drill > JE Drill.
l Double-click the selected row.
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To close the drill to detail report, double-click Return to Report or close the drill report tab.

� Adjusting supply percentage and amount for Next Year Budget
To adjust supply percentage and amount:

1. Navigate to the Supply section of the sheet.

2. In the supply line item, do any of the following to adjust for NYB:
l In the% Adjust column (column O), type the percentage amount.
l In the Amt Adjust column (column O), type the dollar amount.

3. After you finish making your changes, in theMain ribbon tab, click Save.

� Inserting a new expense line item
You can add new expense line items to individual sections, including:

l Salaries
l Benefits
l Supplies
l Other expenses
l Paid hours

The system adds the line by inserting the appropriate calc method into the sheet. The following table lists
the available calc methods used by the corresponding section in the sheet:
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Calc Method Description Sheet Section

Add Detail - Input
Monthly

Use this to insert a row to populate an
individual month.

Other Expenses

Add Detail - Input Total Use this to insert a row to enter an annual
amount, and then decide how to spread it.

Other Expenses

Add NewDetail Zero-based expense calculations. Inputs are
done on the Detail sheet in the budget plan
file.

l Benefits
l Supplies
l Other Expenses

Add NewHours Use this new labor calc method to add a new
hours account to the Expense sheet.

Paid Hours

Add New Input
Monthly

Month-by-month input. Use this calc method
only when adding a new account.

l Salaries
l Benefits
l Supplies
l Other Expenses
l Paid Hours

Add New Labor Use this new labor calc method to add a new
labor account to the Expense sheet.

Salaries

Add NewVariable Calculates based on the relationship to key
statistics. As there is no history when
inserting as new, use the Amt Adjust (column
P) to enter a value. If a projection value is
desired, enter a value in Manager Input
(Column J).

l Salaries
l Benefits
l Supplies
l Other Expenses
l Paid Hours

Fixed Use this fixed methodology and select how
you want to spread.

l Salaries
l Benefits
l Supplies
l Other Expenses
l Paid Hours

PctOfSalaries_FixedPct Calculates a designated fixed percent from
Budget Expense Adjustment Driver file,
Budget Expense Assumptions, based on the
relationship to salaries. Monthly spread will
be based on the spread of salaries.

Benefits

RatePerFTE_Fixed Allows you to define the fixed dollar amount
per FTE in Budget Expense Adjustment Driver
file to apply globally to benefit accounts.

Benefits
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To insert a new expense line item:
1. Navigate to the section to add the new line item.

2. Double-click theDouble Click to Insert... cell.

3. In the Insert Calc Method(s) in sheet Expense dialog, select the calc method to insert, and click
OK.

NOTE: If the line only uses or your organization is only licensed for one type of calc method,
this dialog will not display. The system will open the Calc Methods Variable dialog instead.

4. In the Calc Methods Variable dialog, enter or select the account and department number, and
click OK.

5. Enter the appropriate values in the blue cells, as needed.

6. After making your changes, in theMain ribbon tab, click Save.

New Initiatives sheet

� Overview
This sheet allows you to budget for new projects that are outside of your organization or department's
normal operations. The budgets for each new initiative save to unique Initiative IDs so that you can
analyze the new initiative budget separately from the ongoing operating budget. For each project to
budget, use the Initiatives tab to enter the project's monthly budget values. There is also a comments
section.

To create an initiative, double-click Double Click to Insert New Initiative. The Insert Calc-Method(s) in
sheet Initiatives dialog displays.

You can create one of two types of initiatives: department or system.
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� Adding a department initiative
A department initiative is a project that applies only to a single department.

To add a department initiative:
1. Double-click Add Department Initiative to create an outline for adding detailed information for

department-wide initiatives.

2. In the Insert Description Here cell, enter information to describe your initiative.

3. At the top of the screen, from the drop-down, select one of the following:
l To include the initiative for the next year budget amounts in the database, select Approve.
l To exclude the initiative from the next year budget amounts in the database, select Exclude

4. Update the blue cells with the budget data for the initiative, as needed. You can also add rows for
new items related to the initiative by double-clicking the appropriate row.

5. After you finish making changes, in theMain ribbon tab, click Save.

� Adding a system initiative
A system initiative is a project that applies to multiple departments in your organization.

To add a system initiative:
1. Double-click Add Project Initiative for a single project.
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2. In the Calc Method Variables dialog, click Choose Value.

3. In the Choose Value dialog, select the project, and click OK.

4. In the Calc Method Variables dialog, click OK.

5. The project list is created by you. Each project is pre-defined to Approve or Exclude.
l Approve saves data related to an initiative to the Financial data source for each department

with a budget for the initiative. Approved initiatives would subsequently be included in any
Budget Income Statement reports.

l Exclude saves the data from New Initiatives to the NYBDetail data source. Excluded
initiatives will not be included in any Budget Income Statement reports, but separate New
Initiatives reports can be run to summarize the totals for each initiative.

6. In theMain ribbon tab, click Refresh Data to populate the initiative with data.

NOTE: This assumes that your Axiom Budgeting administrator has instituted the New
Initiatives utility.

7. Update the blue cells with the budget data for the initiative, as needed. You can also add rows for
new items related to the initiative by double-clicking the appropriate row.

8. After you finish making changes, in theMain ribbon tab, click Save.
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Completing operating plan

� Overview
The Operating Plan sheet helps you clarify strategic budget objectives beforemaking updates to a
budget. It presents a questionnaire that lists the department's objectives and describe how any changes
to the budget will support each objective. For example, you can use this for a SWAT analysis approach or
whatever is most meaningful to your organization. The purpose of the planning questions is to capture
higher level, salient points within the plan file to facilitate a discussion with the budget stakeholders such
as department directors or vice presidents. You can review the questions with others by opening the
plan file directly or running the Budget Plan Questions reportBudget Plan Questions report.

NOTE: The questions that display are determined and set up by your organization. If you have
Administrator privileges, you can add or edit them in the Budget Assumptions driverBudget
Assumptions driver, as needed.
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� Completing plan questions
To complete plan questions:

1. In this tab, do any of the following:
l Answer the questions by entering content in as many rows as needed.

NOTE: The content in the rows do not wrap, meaning that once you get to the end of
the row, you need to continue entering content in the next row.

l To add a line, double-click Double Click to Insert New Planning Lines.

2. After you finish making changes, in the budget file Navigation panel, click Save Budget.

TIP: You can also click the Save button in theMain ribbon tab.

Department History sheet

� Overview
This sheet is a report that allows you to reference the historical spending trends for up to the last 18
months. This report is useful to keep open as you work on your budget. The reports is segmented into
the following areas for statistics, revenue, expenses, and hours:

l Last Year Actual - Includes values posted for over the last year.
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l Current Year Actual - Includes values posted for YTD.
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l Department History used for Monthly Spreads - Includes a combination of YTD values plus the
actuals from the previous year to form a full 12months of data. In the following example, the
actuals are posted through February 2019. In theMonthly Spreads section, the actuals are copied
from July through February. But, for themissing months that have no actuals yet, the system
copies the data from Last Year Actual and enters them for themissing months. In this example,
theMarch through June actuals are copied from the samemonths in the Last Year Actual section.

TIP: Before you begin entering budget values, look for anomalies or holes in the Last Year
Actual and Current Year Actual values that do not make sense or cannot be explained -
especially if you intend to use this section. Make sure to resolve any data issues before you
start creating a new budget for the next budget year or select an alternate spread option.

The system uses this combination of actuals and historical values to determine how to spread
budgeted expenses across an account. So, if a department spends moremoney at the beginning
of a fiscal year and adds a $10,000 expense to the budget, the system will automatically apply
more of that expense to the beginning of the year than at the end.

TIP: The same historical information is also available in the Expense sheet at the expense line
level. For more information, see Viewing historical values for expenses.

Adding support files

� Overview
In a budget plan file, you can attach supporting files to help support your budgeting process. For
example, you may want to attach various supporting information about the spending requests or capital
projects, and have that information easily reviewable along with the plan file itself.
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If you have read/write access to a plan file, then you can add and delete attachments as well as view
attachments. If you have read-only access to a plan file, then you can only view existing attachments.

� Managing file attachments
Using theManage Attachments dialog, you can add, delete, and view attachments for a plan file.

l Adding a file attachment: Click Upload Attachment, and then navigate to the file that you want
to add as an attachment. The file will be imported into the Axiom Budgeting database and
associated with the plan file.

l Deleting a file attachment: Select the file, and then click Delete. The file is deleted from the Axiom
Budgeting database and will no longer be available as an attachment.

l Renaming a file attachment: To rename a file attachment, right-click the attachment and then
click Rename. The name becomes editable and you can type your changes.

l Editing the attachment description: To define or edit the description for the file attachment,
select the file and then click Edit Description.

l Opening a file attachment: Select the file, and then click Open (or you can double-click the file).

If the attachment is an Excel-compatible file that opens within the Axiom Budgeting session, it will open
with read/write access. You can edit the file and save changes if desired.

If the attachment is a Word file or a PowerPoint file, then it opens in its native program with read/write
access if the corresponding Axiom Budgeting add-in is already installed (or if it is successfully installed
when the file is opened). You can edit the file and save changes by using the add-in.

If theWord or PowerPoint add-in is not installed, or if the file is some other file type, then you cannot
edit and save the file directly. If you need to edit one of these files, you should save a copy of the file
locally and make your edits. You can then delete the existing file attachment in the Axiom Budgeting
database, and upload your edited copy.

Saving budget plan files
Data resides in the budget plan file, which is not written back to the Axiom database until you save the
budget. When saving a budget, Axiom Budgeting verifies and validates the spreadsheet, saves the file,
and saves the information to the Axiom database.

Depending on how your system is configured, the system may require you to enter comments when a
line item exceeds a defined threshold in the Stat_Rev and Expense tabs before saving the plan file. A
message will display above the Comments column header, informing you of the number of variances to
address. A red flag icon displays in the Red Flag column. After you enter variance comments, you can
save the plan file.
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The order of saving budget plan files is left to right. This means that if required variances are needed, the
notification on save displays first on the Stat_Rev tab. After all Stat_Rev required variances aremet, the
user saves again. If required variances also exist on the Expense tab, another save notification prompts
the user for comments on the Expense tab.

To save a budget plan file
In the Navigation panel, double-click Save Budget.

NOTE: You can use the Save button in the ribbon tab, but when you close the budget plan file, the
system may prompt you to save again.

If your organization uses Axiom process management, then the system displays a message asking to
advance the plan file for review and approval process.

Calc methods

� Employee sheet
For instructions on using this sheet, click here.

Calc Method Type Description

JobCode Interface Sets up initial JobCode block on the Employee tab during the interface
process. Do no use when adding blocks to the JobCode tab.

AvgPerPaidHr Interface Calculates other Non-FTE related pay based on the relationship to
paid hours in the JobCode block. Monthly spread will be based on the
spread of paid hours.

AvgPerProdHr Interface Calculates other Non-FTE related pay based on the relationship to
productive hours in the JobCode block. Monthly spread will be based
on the spread of productive hours.
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Calc Method Type Description

Dept_
AvgPerProdHr

Interface Calculates other Non-FTE related pay based on the relationship to
productive hours in the department. Monthly spread will be based on
the spread of productive hours. Only use this calc method to budget
labor dollars at a department level and not a JobCode level.

Dept_
InputMonthly

Interface Calculates other Non-FTE related pay by inputting monthly amounts
for the department. Only use this calc method to budget labor dollars
at a department level and not a JobCode level.

Dept_
InputTotal

Interface Calculates other Non-FTE related pay by typing in a total for the
department. Monthly spread will be spread evenly by month. Only
use this calc method to budget labor dollars at a department level and
not a JobCode level.

Employee Interface Inserts a new employee into a JobCode block. You can input FTEs and
hourly rate. The default hourly rate comes from Mid Rate column in
the Budget Labor Limits driver.

Holiday Interface Calculate salary dollars based on YTD holiday pay and spreads by the
listed holiday months in the Budget Labor Configuration driver.

Input_
Monthly

Interface Calculates other Non-FTE related pay by typing in themonthly totals.
Add New JobCode 22 Lines New Sets up a new JobCode block on the
Employee tab. This calc method allows you to enter FTEs and hourly
rate for each labor category.

Add New
AvgPer Paid
Hr PayType

New Calculates other Non-FTE related pay based on the relationship to
paid hours in the JobCode block. Monthly spread will be based on the
spread of paid hours. This calc method is only used when adding a
new pay type.

Add New
AvgPer Prod
Hr PayType

New Calculates other Non-FTE related pay based on the relationship to
productive hours in the JobCode block. Monthly spread will be based
on the spread of productive hours. This calc method is only used
when adding a new pay type.

Add New
Input
Monthly
PayType

New Calculates other Non-FTE related pay by typing in themonthly totals.
This calc method is only used when adding a new paytype.

� Expense sheet
For instructions on using this sheet, click here.
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Calc Method Type Description

Depreciation Interface Pushes depreciation calculations to the budget plan
file from List Driver file, Budget Expense
Assumptions. The end-user cannot change the totals
or the spread in the budget plan files. Only users
with administrative rights can update the
calculations.

Detail Interface Zero-based expense calculations. Inputs are done on
the Expense tab in the budget plan file.

FICA Interface Transfers FICA expense from the designated labor
tab (JobCode, Staffing, Employee, Provider) to the
Expense tab.

Fixed_Days Interface Allows changes to the projected year as well as
budget. This calc method uses calendar days as its
default spread option. Users choose themonthly
spread from the drop-down.

Fixed_Even Interface Allows changes to the projected year as well as
budget. This calc method uses an even monthly
spread as its default spread option. Users choose the
monthly spread from the drop-down.

Fixed_History Interface Allows changes to the projected year as well as
budget. This calc method uses history as its default
spread option. Users choose themonthly spread
from the drop-down.

Fixed_Stats Interface Interface Allows changes to the projected year as
well as budget. This calc method uses the key
statistic monthly spread as its default spread option.
Users choose themonthly spread from the drop-
down.

Fixed_WorkDays Interface Allows changes to the projected year as well as
budget. This calc method uses worked days as its
default spread option. Users choose themonthly
spread from the drop-down.

GlobalAmt Interface Pushes expense calculations to the budget plan file
from List Driver file, Budget Expense Assumptions.
An end-user cannot change the totals or the spread
in the Budget Plan files. Only users with
administrative rights can update the calculations.
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Calc Method Type Description

GlobalExpense Interface Pushes expense calculations to the budget plan file
from List Driver file, Budget Expense Assumptions.
An end-user cannot change the totals or the spread
in the Budget Plan files. Only users with
administrative rights can update the calculations.

Hours Interface Transfers hours from the designated labor tab
(JobCode, Staffing, Employee, Provider) to the
expense tab.

InputMonthly Interface Month-by-month input.

Labor Interface Transfers salary dollars from the designated labor
tab (JobCode, Staffing, Employee, Provider) to the
Expense tab.

NoBudget Interface Brings in historical values into the budget plan file,
but the budget for next year will be zero, and cannot
be changed.

GlobalData Interface This calc method allows the administrator to create
configurable budget relationships for calculating NYB
amounts for the Expense tab only. The GlobalData
calc method is similar to GlobalExpense but allows
you to use up to four configurable tabs in Global
Data Assumptions. Has to be setup in the Global
Data Assumptions Driver file.

PctofGrossRevenue Interface Uses the historical percentage of the account to
gross revenue from the Stat_Rev tab.

PctofSalaries_Rolling12 Interface Calculates based on the relationship to salaries using
Rolling12 instead of YTD. Monthly spread will be
based on the spread of salaries.

PctofNetRevenue Interface Calculates based on the relationship to net revenue.
Monthly spread will be based on the spread of net
revenue.

GlobalSum Interface This calc method allows you to budget for an
account at a percentage of the total of specific other
account(s) on the Stat_Rev tab within the same plan
file.

PctofSalaries Interface Calculates based on the relationship to salaries.
Monthly spread will be based on the spread of
salaries.
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Calc Method Type Description

PctofSalaries _FixedPct Interface Calculates a designated fixed percent from List Driver
file, Budget Expense Assumptions, based on the
relationship to salaries. Monthly spread will be
based on the spread of salaries.

RatePerFTE Interface Calculates based on the relationship to FTEs.
Monthly spread will be based on the spread of FTEs.

RatePerFTE_Fixed Interface Allows you to define the fixed dollar amount in List
Driver file, Budget Expense Assumptions.per FTE to
apply globally to benefit accounts.

Variable Interface Calculates based on the relationship to key statistics.
A dollars-per-key statistic rate is calculated based on
YTD history, and is used to calculate the projection
and budget.

Variable_Stat Interface Calculates based on the relationship to a user-
chosen statistic that is listed on the Stat_Rev tab. A
dollars-per-key statistic rate is calculated based on
YTD history, and is used to calculate the projection
and budget.

Add NewDetail New Zero-based expense calculations. Inputs are done on
the Detail sheet in the budget plan file.

Add New Fixed New Allows changes to the projected year as well as
budget. Monthly spread is chosen by the user from
a drop down box selection. Choose the spread
methodology from the drop-down. This Calc
Method is only used when adding a new account.

Add New Input Monthly New Month-by-month input. Use this calc method only
when adding a new account.

Add NewVariable New Calculates based on the relationship to key statistics.
A dollars-per-key statistic rate is calculated based on
YTD history, and is used to calculate the projection
and budget. This calc method is only used when
adding a new account.

Add New Labor New Use this new labor calc method to add a new labor
account to the Expense sheet.

Add NewHours New Use this new labor calc method to add a new hours
account to the Expense sheet.
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Provider Version Only
If your organization purchased the Provider module license, you have access to the following additional
calc methods:

Calc Method Type Description

ProviderComp Interface Transfers Salary calculations from the
ProviderComp sheet to the Expense sheet to save in
the Financial Data Tables.

ProviderLaborComp Interface Transfers Salary calculations from the
ProviderComp and designated labor sheet
(JobCode, Staffing, Employee) sheet to the Expense
sheet to save in the Financial Data Tables.

ProviderCompFICA Interface Transfers FICA calculations from the ProviderComp
sheet to the Expense sheet to save in the Financial
Data Tables.

ProviderLaborFICA Interface Transfers FICA calculations from the ProviderComp
and designated labor sheet (JobCode, Staffing,
Employee) sheet to the Expense sheet to save in the
Financial Data Tables.

ProviderCompHours Interface Transfers Hours calculations from the
ProviderComp sheet to the Expense sheet to save in
the Financial Data Tables.

ProviderLaborHours Interface Transfers Hours calculations from the
ProviderComp and designated labor sheet
(JobCode, Staffing, Employee) sheet to the Expense
sheet to save in the Financial Data Tables.

ProviderCompOther Interface Transfers other labor calculations from the
ProviderComp sheet to the Expense sheet to be
saved in the Financial Data Tables.

Add New ProviderLaborComp New Use this new labor calc method to add a new labor
account to the Expense sheet for Providers.

Add New ProviderLaborHours New Use this new labor calc method when necessary to
add a new hours account to the Expense sheet for
Providers.

� JobCode sheet
For instructions on using this sheet, click here.

Setup Guide Axiom Budgeting │ 297



Calc Method Type Description

JobCode Interface Sets up initial JobCode block on the JobCode sheet during
the interface process. Do not use when adding blocks to
the JobCode tab.

AvgPerPaidHr Interface Calculates other Non-FTE related pay based on the
relationship to paid hours in the JobCode block. Monthly
spread will be based on the spread of paid hours.

AvgPerProdHr Interface Calculates other Non-FTE related pay based on the
relationship to productive hours in the JobCode block.
Monthly spread will be based on the spread of productive
hours.

Dept_
AvgPerProdHr

Interface Calculates other Non-FTE related pay based on the
relationship to productive hours in the department.
Monthly spread will be based on the spread of productive
hours. Only use this calc method to budget labor dollars at
a department level and not a JobCode level.

Dept_
InputMonthly

Interface Calculates other Non-FTE related pay by inputting monthly
amounts for the department. Only use this calc method to
budget labor dollars at a department level and not a
JobCode level.

Dept_InputTotal Interface Calculates other Non-FTE related pay by typing in a total
for the department. Monthly spread will be spread evenly
by month. Only use this calc method to budget labor
dollars at a department level and not a JobCode level.

Holiday Interface Calculates salary dollars based on YTD holiday pay and
spreads by the listed holiday months in the Budget Labor
Configuration driver.

Input_Monthly Interface Calculate other Non-FTE related pay by typing in the
monthly totals.

Add New
JobCode

New Sets up a new JobCode block on the JobCode sheet. This
calc method allows the input of FTEs and hourly rate for
each labor category. The default hourly rate comes from
theMid Rate column in the Budget Labor Limits driver.

Add NewAvgPer
Paid Hr PayType

New Calculate other Non-FTE related pay based on the
relationship to paid hours in the JobCode block. Monthly
spread will be based on the spread of paid hours. This calc
method is only used when adding a new paytype.
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Calc Method Type Description

Add NewAvgPer
Prod Hr PayType

New Calculates other Non-FTE related pay based on the
relationship to productive hours in the JobCode block.
Monthly spread will be based on the spread of productive
hours. This calc method is only used when adding a new
pay type.

Add New Input
Monthly
PayType

New Calculates other Non-FTE related pay by typing in the
monthly totals. This calc method is only used when adding
a new paytype.

� Provider sheet
For instructions on using this sheet, click here.

Calc Method Type Description

FinancialClass Interface Inserts financial class data to use during the initial interface
process.

Provider Interface Sets up the Provider Block to use during the initial interface
process.

Revenue Interface Inserts revenue data to use during the initial interface
process to insert revenue data.

RVU Interface Inserts RVU data to use during the initial interface process.

Statistic Interface Inserts Procedure/Statistic data to use during the initial
interface process.

WRVU Interface Inserts WRVU data to use during the initial interface
process.

Add New
Encounter

New Inserts additional Encounter/Visit lines, if needed, after the
initial interface is complete.

Add New
FinancialClass

New Inserts additional Financial Class lines, if needed, after the
initial interface is complete.

Add New
Procedure

New Inserts additional Procedure lines, if needed, after the
initial interface is complete.

Add New
Provider

New Inserts a new Provider Block.

Add New
Revenue

New Inserts additional Revenue lines, if needed, after the initial
interface is complete.

Add NewRVU New Inserts additional RVU lines, if needed, after the initial
interface is complete.
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Calc Method Type Description

Add NewWRVU New Inserts additionalWRVU lines, if needed, after the initial
interface is complete.

Copy From
Existing Provider

New Inserts a new Provider Block and allows the statistical
history from an existing Provider to copy into the new
Provider block.

� Staffing sheet
For instructions on using this sheet, click here.

Calc Method Type Description

JobCode Interface Sets up initial JobCode block on the Staffing tab during the
interface process. Do not use when adding blocks to the Staffing
tab.

AvgPerPaidHr Interface Calculates other Non-FTE related pay based on the relationship to
paid hours in the JobCode block. Monthly spread will be based
on the spread of paid hours.

AvgPerProdHr Interface Calculates other Non-FTE related pay based on the relationship to
productive hours in the JobCode block. Monthly spread will be
based on the spread of productive hours.

DeptAvgPerPaidHr Interface Calculate other Non-FTE related pay based on the relationship to
paid hours in the department. Monthly spread will be based on
the spread of paid hours. Only use this calc method to budget
labor dollars at a department level and not a JobCode level.

Dept_
InputMonthly

Interface Calculates other Non-FTE related pay by inputting monthly
amounts for the department. Only use this calc methid to budget
labor dollars at a department level and not a JobCode level.

Dept_InputTotal Interface Calculates other Non-FTE related pay by typing in a total for the
department. Monthly spread will be spread evenly by month.
Only use this calc method to budget labor dollars at a
department level and not a JobCode level.

Holiday Interface Calculates salary dollars based on YTD holiday pay and spreads by
the listed holiday months in the Budget Labor Configuration
driver.

Input_Monthly Interface Calculates other Non-FTE related pay by typing in themonthly
totals.

Input_Total Interface Calculates other Non-FTE related pay by typing in the total
dollars. Themonthly spread will be spread evenly.
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Calc Method Type Description

Add New JobCode New Sets up a new JobCode block on the Staffing tab. This calc
method allows the input of FTEs and hourly rate for each labor
category. The default hourly rate comes from theMid Rate
column in the Budget Labor Limits driver.

Add New Input
Monthly PayType

New Calculates other Non-FTE related pay by typing in themonthly
totals. This Calc Method is only used when adding a new paytype.

Add New Input
Total PayType

New Calculates other Non-FTE related pay by typing in the total
dollars. Themonthly spread will be even. This calc method is only
used when adding a new paytype.
The FTEs from Target should have no variance for a budget to be
acceptable.

� Stat_Rev (Statistics and Revenue) sheet
For instructions on using this sheet, click here.

Calc Method Description

Allowance Calculate deductions based on a percentage of gross revenue.

BadDebt Calculate bad debt based on a percentage of gross revenue.

Detail Zeros base revenue calculations.

FixedRevenue Allows changes to the projected year as well as budget. Usually used
for other operating revenue accounts. Select themonthly spread
from the drop-down.

GlobalRevenue Pushes revenue or deduction calculations to the budget plan file from
Budget Assumptions. End users cannot change the totals or the
spread in the budget plan files. Only users with administrative rights
can update the calculations.

GlobalSum This SPM allows you to budget for an account at a percentage of the
total of specific other account(s) on the Stat_Rev tab within the same
workbook.

InputMonthly Month by month input.

IP_Per_Unit This revenue calc method is now an independent calculation of IP
revenue by account using the historical revenue per unit.

IP_Payor Calculates the total IP revenue, and then allocates it based on the
historical percentages by payor. Only use this calc method if the GL
gross revenue account structure is by payor.
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Calc Method Description

OP_Per_Unit This revenue calc method is now an independent calculation of OP
revenue by account using the historical revenue per unit.

OP_Payor This calc method calculates the total IP revenue, and then allocates it
based on the historical percentages by payor. Use this calc method
only if the GL gross revenue account structure is by payor.

Oth_Per_Unit This revenue calc method is now an independent calculation of Other
Patient revenue by account using the historical revenue per unit.

Oth_Payor This calc method calculates the total IP revenue, and then allocates it
based on the historical percentages by payor. Only use this calc
method if the GL gross revenue account structure is by payor.

NoBudget Brings in historical values into the budget plan file, but the budget for
next year will be zero, and cannot be changed.

Statistic Calculates projected and budget key statistics.

Statistic_Oth Calculates projected and budget non-key statistics based on their
relationship to the key statistic.

Revenue_Stat This revenue calc method allows you to define the statistic account
from the Stat_Rev tab to use as the basis of the per unit calculation
and themultiplier for the budget. For example, theremy be an Other
Department statistic in the OR for implant cases that should be used
to drive the Revenue-Implant account.

Add NewDetail Zero-based expense calculations when adding a new account. Inputs
are done on the Detail tab in the budget plan file.

Add New Fixed Revenue Use this new revenue calc method to add a new Fixed Revenue
account to the Stat_Rev tab.

Add New Input Monthly Use this new revenue or statistic calc method to add a new account
to the Stat_Rev tab.

Add New Statistic Use this new statistic calc method to add a new key statistic account
to the Stat_Rev tab.

Add New Statistic_Oth Use this new statistic calc method to add a newOther Statistic
account to the Stat_Rev tab.

Provider Version Only
If your organization purchased the Provider module license, you have access to the following additional
calc methods:
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Calc Method Description

ProviderRev Transfers Revenue calculations from the Provider Summary/Provider
Detail tab to the Stat_Rev tab to save to the Financial Data tables.

ProviderStat Transfers Statistic calculations from the Provider Summary/Provider
Detail tab to the Stat_Rev tab to save to the Financial Data tables.

ProviderComp Transfers Salary calculations from the Provider tab to the Stat_Rev
tab to save to the Financial Data tables.

NOTE: Provider Light Version Only: Calc Methods – Stat_Rev Sheet

If your organization has purchased the Provider module, you can
access the following additional calc methods if using the Provider
Light.

l Provider_Simple_Rev – Transfers Revenue calculations from the
Provider Simple Rev tab to the Stat_Rev tab to save to the
Financial Data Tables. If your GL structure has multiple revenue
accounts for Provider revenue, then apply the calculation method
Provider_Simple_Rev to each revenue account.

l Provider_Simple_Stat – Transfers Statistic calculations from the
Provider Simple Rev tab to the Stat_Rev tab to save to the
Financial Data Tables. Assign this to the key statistic you are using
as your driver stat on the Provider tab. For example, when using
WRVU as your Driver stat, add Provider_Simple_Stat to the GL
acct on the ACCT dimension table for WRVUs.

Setup Guide Axiom Budgeting │ 303



Working with Reports
Reports are spreadsheets designed to help review and analyze your organization's financial data. The
Budgeting reports include:

Budget Reporting
l Budget Analysis – Budget dollars by department by account analysis
l Budget Statement - Budget analysis
l Initiative Analysis - Budget analysis of new initiatives
l Provider Budget (optional) - Physician analysis
l Payroll Analysis - Payroll budget analysis

Financial Reporting
l Financial Analysis - General budget data
l Financial Statement -Month-end financial analysis
l Payroll - Bi-weekly payroll analysis
l Provider Analysis (optional) - Physician analysis
l Report Packages -Month-end or payroll electronic reporting

Like budget plan files, reports pull data from the database and in some cases allow the user to input data
and save it back to the database. However, unlike plan files, reports are not associated with a particular
file group or budget year. The same report can be used to view data for any budget year, or to compare
data across multiple budget years. Reports can even incorporate data from other Axiom Software
Suite applications, provided you have the necessary security permissions.

Browsing the Report Library
In addition to browsing the report folders in the Axiom Budgeting task panes, you can search all of the
available Axiom reports in the Reports Library.

To browse the Report Library:
1. In theMain ribbon tab, in the Reports group, click Reports > Browse All Reports.

6
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2. In the Reports Library dialog, you can do the following:

l To sort, group, or search by any of the columns, click the drop-down arrow next to the
column label.

l To open a report, select it from the list, and click OK.

The system includes many different reports, but you can search through them more easily by using the
following search functionality:

1. Click the down arrow beside theDocument Name column header.

2. In theGroup By box, type a search value, and click OK.

The system will display the reports that include the value you entered in the report name.
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Budgeting reports
Axiom Budgeting 2019.3 comes with a variety of standard budget reports, organized within the following
folders and subfolders.

TIP: In some reports, you can drill down to specific data to view how the values were calculated. For
more information, see Drilling data: Using Drill Down.

� Budgeting Analysis reports
The following reports allow you to view general budget data. For examples of these reports, see Running
Budget Analysis reports.

Report Description

Budget Account Analysis Use to analyze the proposed budget compared to last year
actual, current year budget, and current year projected for
an individual account by department. Comments entered
into the budget plan files also show on the report to assist
with the analysis.

Budget FTE Comparison Use to analyze the proposed budget for FTE compared to
last year actual, current year budget, year-to-date actual,
and current year projected by department.

Budget Key Statistics By Department Use to view highlighted key statistic trends across multiple
fiscal years.

Budget Per Unit Analysis Use to analyze per-unit amounts by comparing the current
year projection to next year’s budget for Patient Revenue,
Salaries, Supplies, and Other Expenses.

Budget Plan Questions Use to report on inputs from the Plan tab in plan files.

Budget Red Flag Analysis Use to review the comments and explanations for
accounts flagged in the budget plan files because they
exceeded the defined red-flag threshold. The report shows
year-to-date actual and current year projection compared
to the proposed budget request. The report also includes
fields for the adjustments and comments posted from the
budget workbook for each account.

Budget Salary Comparison Use to analyze salary variances for the proposed budget
compared to the current year projection. The report also
includes prior year and current year actual history to use
for comparison.
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Report Description

Budget Salary Rate Analysis Use to analyze departmental average hourly-rate variances
in the proposed budget. The report shows prior year and
current year actual history and projection compared to the
new budget. The variance is broken out into two different
categories—FTE and Rate Effect.

Budget Summary by Department Use to analyze total-expense variances by department,
comparing the proposed budget to the current-year
projection. The report shows prior-year actual, current-
year actual, and current-year budget history.

Budget Threshold Analysis Use to analyze account categories by applying a low and
high threshold for variances. Historical data for last-year
actual and current-year budget are also included.

Budget Workbook Changes for CYB
and NYB

Use to view highlighted areas where users made inputs in
the yellow cells in budget plan files.

� Budgeting Statement reports
The following reports are designed for budget analysis. For examples of these reports, see Running
Budget Statement reports.

Report Description

Budget Income Detail Use to analyze the proposed budget-by-income statement
category compared to last-year actual, current-year
budget, current-year projected, year-to-date actual, and
current-year annualized. Each category shows all values for
all accounts in that category.

Budget Income Financial Plan Use to view annuals income statement comparisons across
multiple scenarios.

Budget Income Scenarios Use to analyze the proposed budget by FSDetail category
compared to the Baseline Budget, NYBScenario1, and
NYBScenario2. BudScenario1 and BudScenario2 are fields
in the database used to store the results of different sets of
driver files. You can use this report to compare passes of
the budget (BudPass1, BudPass2).

Budget Income Summary Use to summarize the proposed budget by FSDetail
category compared to last-year actual, current-year
budget, current-year annualized, and current-year
projected.
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Report Description

Budget Monthly Dept P&L Use to review themonthly spread by account for the
proposed budget by Budget Type category for an
individual department. This report is often used to provide
the department manager with a final copy of their month-
by-month budget.

� Initiative Analysis reports
The following reports are designed for budget analysis of new initiatives. For examples of these reports,
see Running Budget Initiative Analysis reports.

Report Description

Budget Income Summary-Initiative Use to review new initiatives by Income Statement
category.

Budget Income Summary-Initiative
Monthly

Use to review new initiatives by Income Statement
category by month.

Income Statement by Initiative ID Use to review new initiatives side-by-side for multiple
initiatives.

Initiative Summary Use to review new initiatives by department by category,
with monthly FTEs.

� Payroll Analysis reports
The following reports are designed for payroll budget analysis. For examples of these reports, see
Running Budget Payroll Analysis reports.

Report Description

FTE Additions and Changes by
JobCode

Use to review the FTE summary by department by
JobCode, highlighting changes made to the projected year
and budget in the plan files.

FTEs by Department Use to review the FTE summary by department, including
prior-year actual, current-year budget, and year-to-date
actual. The proposed budget is compared to year-to-date
actual as well as the current-year budget.

FTEs by Department by JobCode Use to review FTE report by department by job code,
including prior-year actual, current-year budget, and year-
to-date actual. The proposed budget is compared to year-
to-date actual as well as the current-year budget.
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Report Description

FTEs by JobCode Use to review the FTE report by job code, including prior-
year actual, current-year budget, and year-to-date actual.
The proposed budget is compared to year-to-date actual
as well as the current-year budget.

Monthly FICA by Department Use to showmonthly total FICA expense by department
for both current-year projected and next-year budget.
Monthly expense shows for next-year budget. Designed
for use by clients who budget FICA in a central department
or to review the overall monthly spread of FICA expense.

Monthly FTE Target Variance by
Department

Use to review a department summary of the FTE variance
by month for next year’s budget to the department target.

Monthly FTEs by Department Use to review a department summary of total FTEs by
month for next year’s budget. Designed to be used to
review themonthly spread of total FTEs as well as by
department.

NYB Hours and Dollars by Employee Use to review hours and dollars by employee, job code,
paytype, and department. To use this report, the
department must use the employee labor option in plan
files.

Worked Hours Per Unit by
Department by JobCode

Use to compare the projected and NY Budget by Provider
to the current year by selected DataType.

� Provider Budget Analysis reports (optional feature)
The following reports are designed for physician analysis. For examples of these reports, see Running
Provider Budget Analysis reports.

NOTE: You can also find these same reports in the Financial Reporting section > Financial Reporting
> Provider Analysis.

Report Description

Current Period vs Previous
Comparison

Use to compare current period vs previous period
information by provider as well as last year actual. You can
select the data type to analyze in the report.
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Report Description

Current Period vs Previous
Comparison_CPT

Use to compare current period vs previous period
information by CPT or CPT Summary category and last
year actual. You can select the data type to analyze in the
report.

CY Actual vs Budget Comparison Use to compare current period and year-to-date actual vs
budget information by provider and last year actual. You
can select the data type to analyze in the report.

CY Actual vs Budget Comparison_CPT Use to compare current period and year-to-date actual vs
budget information by CPT or CPT Summary code and last
year actual. You can select the data type to analyze in the
report.

NY Budget Comparison Use to compare current year projections with next year's
budget.

NY Budget Comparison_CPT Use to compare current year projections with next year's
budget by CPT or CPT Summary category.

Provider Key Indicators By Month Use to comparemonth-by-month values for last year,
current year, and target by data type.

Provider Key Indicators By Month_
Rolling 12

Use to comparemonth-by-month values for themost
recent 12months by data type.

Provider Revenue Per Encounter Use to compare the current month to the prior three-
month average for different years for revenue per
encounter.

Provider Revenue Per RVU Use to compare the current month to the prior three-
month average for different years for revenue per RVU.

Provider Revenue PerWRVU Use to compare the current month to the prior three-
month average for different years for revenue perWRVU.

Provider Volume by Specialty Use to compare actual vs budget volume by data type for
the current period and year-to-date, subtotaled by
provider specialty.

Provider Volume by Specialty_
Monthly

Use to showmonthly totals by provider, for a chosen data
type and year, subtotaled by provider specialty.

Provider Compensation Benchmark Use to compare the proposed budget salary to a salary
target for each provider. The target is factored for the
budget FTE.
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Report Description

Provider Compensation Comparison Use to compare the calculated budget salary under each of
the available compensation methods, by provider, to
evaluate the cost ofmoving providers to another model or
standardizing the compensation model. There is also a
comparison of the current year vs proposed budget salary
cost per work RVU to test if the compensation is changing
+\- the Hold Harmless percentage.

� Provider Budget Compensation reports (optional feature)
The following reports are designed for payroll/provider budget analysis. For examples of these reports,
see Running Provider Budget Compensation reports.

Report Description

Provider Compensation Benchmark Use to compare the proposed budget salary to a salary
target for each provider. The target is factored for the
budget FTE.

Provider Compensation Comparison Use to compare the calculated budget salary under each of
the available compensation methods, by provider, to
evaluate the cost ofmoving providers to another model or
standardizing the compensation model.

Balance Sheet and Deductions utilities
These reports are designed for budget balance sheet calculation and deductions modeling to post the
results to the database.

� Accessing these utilities
The utilities listed in this section are located in \Axiom\Reports Library\Budgeting Utilities\Balance
Sheet & Deductions. For instructions, see Browsing the Report Library.

You can also access them from the Bud Admin task pane. In the Budget Reporting section, and click
Budget Utilities > Balance Sheet & Deductions.
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� Budget Balance Sheet and Cash Flow
Use this save-to-database report to project the balance sheet for the remainder of the current year and
next year’s budget, by category.

The Budget Balance Sheet and Cash Flow utility allows you to project the remainder of the current year
and next year budget balance sheet and cash flow numbers. This utility integrates with the budgeted
income statement numbers and allows for frequent updates to the budgeted balance sheet and cash
flow numbers, if the income statement is updated. The utility’s results save back to the database and
then become available in the budget data tables and reports for budget analysis.
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Running the Budget Balance Sheet and Cash Flow utility
1. Open the report.

2. In the Refresh Variables dialog, do the following, and click OK:

l From the Select 'Yes' to add New Income to Fund Balance drop-down, select Yes orNo to
determine whether to add net income to the fund balance.

l To select the default departments, where you would like the budget balance sheet
numbers to be saved back to, click Choose Value, and select a department.

l In the Create a Save Tag Value box, type a save tag (max of 100 characters). This save tag
ensures that the data saving back to the database is saved with a save tag that is unique to
a specific entity/group that you may want to filter this report for. It also avoids having to
createmultiple Balance Sheet reports for different entities/groups.

3. After the report populates, do the following:

l At the top of the spreadsheet, make sure that the data in the Net Income rowmatches the
balance sheet to be prepared.

l Verify historical information for Two Years Ago, Last Year, and Current YTD all balance.

l In the header section, review to the Balance Check row to confirm that themodel is in
balance.

TIP: If themodel appears to be out of balance, we recommend that you refresh the report and
verify that the Add Net Income to Fund Balance setting was configured properly per your
organization’s accounting practice.

4. In column AD, in the blue input cells, enter the default accounts numbers that you would like the
balance sheet numbers to save back to. For example, you may choose to save back the numbers
for Board Designated Investments and Other Assets to the same default asset account OR you
may choose to use accounts specific to each of these categories.

5. Complete the following sections of the utility, as needed:
l Balance Sheet Assumptions – Use this section to enter key balance sheet metrics to
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calculate various balance sheet numbers. Values for balance sheet categories can be
adjusted or keyed in directly in the detailed schedules / inputs section.

l Assets
l Liabilities and Net Assets
l Detailed Schedules - Use this section to input detailed schedules for each category.
l Statement and Cash Flows

TIP: Enter inputs incrementally. For example, to change days in AR from 64 to 56, enter 8 and
not 56.

NOTE: The Budget Balance Sheet utility is configured to always stay in balance. As a result,
inputs/adjustments to Balance Sheet metrics will result in the out of balance difference being
plugged to either the other assets/other liabilities section.

6. To save your changes to the database, in theMain ribbon tab, click Save.

The Summary tab of the Budget Balance Sheet utility will populate with next year’s budgeted balance
sheet and cash flow numbers by month for budget analysis purposes.

� Budget Deductions
This is a deductions modeling tool that is similar to the deductions modeling in Kaufman Hall Financial
Planning. All statistics, revenues and deductions are broken out by payer. You can make assumptions for
the projection and budget in each payer section. The resulting calculated values post to the database.
When using this model, do not create budget workbooks for your deduction department(s).
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GL Accounts are summarized by balance sheet categories, and the resulting summary data can be posted
back to the database for both the Current Year Projection and Next Year Budget as well as inclusion in all
related Budget Analysis reports. If necessary, values for balance sheet categories can be adjusted or
keyed in directly.

As budgets and assumptions change, simply refresh data in the Budget Balance Sheet to update and
post newly computed balance sheet information for calculating metrics driven by income statement
parameters (assuming the balance sheet assumptions remain unchanged).

The Budget Balance Sheet report assigns GL accounts to balance sheet categories per the FSSummary,
FSDetail, and FPCode grouping columns in the ACCT dimension table.

The Balance Sheet and Cash Flow Report includes the following sections:

l Balance Sheet Assumptions – Key metrics used to drive various balance sheet calculations. Valid
entries are listed in the Balance Sheet Assumptions Inputs section.

l Assets
l Liabilities and Net Assets
l Detailed Schedules – Contains rows to input detailed schedules for each category.
l Statement of Cash Flows
l Summary Income Statement

You can filter the report by Entity or group, as defined in dimensions by using the Quick Filter option in
theMain ribbon tab. You may make adjustments to the values in any blue cells in the report. After
making your changes, review the cash flow statement to make sure it balances to total cash and make
sure the summaries match your expectations on the summary tab.

To run the Budget Sheet and Cash Flow report:
1. In the Refresh Variables dialog, do the following, and click OK:

l From the Select 'Yes' to add New Income to Fund Balance drop-down, select Yes orNo to
determine whether to add net income to the fund balance.

l To select the default departments to include in the report, click Choose Value, select a
department, and click OK.

2. Add or enter information in the blue cell, as appropriate.

3. After the report populates, verify the following:
l At the top of the spreadsheet, make sure that the data in theNet Income rowmatches the

balance sheet to be prepared.
l Historical information for Two Years Ago, Last Year, and Current YTD all balance.
l In the header section, review to the Balance Check row to confirm that themodel is in

balance.
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NOTE: If themodel appears to be out of balance, you might want to refresh the report
and verify that the Add Net Income to Fund Balance setting was configured properly
per your organization’s accounting practice

4. To save your changes back to the database, in theMain ribbon tab, click Save.

Balance Sheet assumption inputs

NOTE: Enter inputs incrementally. For example, to change days in AR from 64 to 56, enter 8 and not
56.

Asset inputs (All inputs should be in whole dollars)

Cash and cash
equivalents

Computed through days of
operating cash

Short-term cash
investments

Input Schedule

Current assets limited as
to use

Input Schedule

Patient Accounts
Receivable

Computed from Gross A\R days in
gross patient receivables

Configurable sections are
netted from the total
calculation on the first row.

Physician Accounts
Receivable

Input Schedule

Allowance for
Uncollectibles

Calculated from Net A\R Days less
Gross receivables

Configurable sections are
netted from the total
calculation on the first row

Third Party Settlements Computed from 3rd Party days in
Net Patient Receivables

Configurable sections are
netted from the total
calculation on the first row.

Current Receivables Input Schedule
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Supply Inventories, at
cost

Computed from Days in Supply
inventories

Configurable sections are
netted from the total
calculation on the first row.

Driven by total supplies expense
from the income statement

Prepaid Expenses Computed from Days in Prepaid
Expenses

Configurable sections are
netted from the total
calculation on the first row.

Driven by total other expenses
from the income statement

Other Current Assets Input Schedule

Assets Limited as to use –
Trusteed Assets

Input Schedule

Assets Limited as to use –
Board Designated
Investments

Computed

PPE – Land Input Schedule Net Capital Acquisitions

Revaluation amount

PPE – Property and
Equipment

Input Schedule Net Capital Acquisitions

+\- Revaluation amount

PPE – Accumulated
Depreciation

Input Schedule Depreciation Expense –
Automatic flow from Income
Statement

+\- Disposals

PPE – Construction in
Progress

Net Capital Acquisitions +\- Revaluation amount

Unamortized Financing
Fees

Input Schedule

Amortization of existing
fees

Input Schedule

Investment in
subsidiaries

Input Schedule

Notes Receivable Input Schedule

Other Long-Term Assets Input Schedule Liability Inputs (All inputs
should be in whole dollars)
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Line of credit Calculated

Current maturity of long-
term debt

Input Schedule Est. current portion of long-
term debt

Adj of current portion of long-
term debt

Accounts Payable Computed from A\P days in other
expenses

Configurable sections are
netted from the total
calculation on the first row.

Driven by total other expenses
from the income statement

Accrued Payroll Computed from Acc Payroll days in
salary expenses

Configurable sections are
netted from the total
calculation on the first row.

Driven by total other expenses
from the income statement

Accrued Expenses Computed from Accrued Exp days
in other expenses

Configurable sections are
netted from the total
calculation on the first row.

Driven by total other expenses
from the income statement

Third Party Settlements Computed from 3rd party days in
other expenses

Configurable sections are
netted from the total
calculation on the first row.

Driven by total other expenses
from the income statement

Other Accrued Liabilities Input Schedule

Other Long Term
Liabilities 1

Input Schedule

Other Long Term
Liabilities 2

Input Schedule

Long-Term Debt Input Schedule Net new loans

Regular principal payments
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Equity inputs (All inputs should be in thousands)

Fund Balance Input Schedule Net Income – Computed and
included in projection if
Instructions tab diaplsy Yes to
include in Fund Balance. Net
Income is automatically added
to fund balance for budget.

Temporarily restricted
net assets

Input Schedule

Permanently restricted
net assets

Input Schedule

� NYB_Deductions_FSDetail
Use this deductions model to project deductions using the historical relationship to gross revenue for
each deduction category. This report summarizes categories using the Acct-FSDetail column in
dimensions. The resulting calculated values posts to the database. If you are using this model, do not
create budget workbooks for your deduction department(s).

� NYB_Deductions_FSPayor
Use this deductions model to project deductions using the historical relationship to gross revenue by
payer. This report summarizes categories using the Acct-FSPayor column in dimensions. The resulting
calculated values post to the database. If you are using this model, do not create budget workbooks for
your deduction department(s).
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Reconciliation utilities
These utilities are designed for budget reconciliation to the database.

� Accessing these reports
The utilities listed in this section are located in \Axiom\Reports Library\Budgeting Utilities\Budget
Reconciliation. For instructions, see Browsing the Report Library.

You can also access them from the Bud Admin task pane. In the Budget Reporting section, click Budget
Utilities > Budget Reconciliation.
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� Budget Department Audit report
Use to resolve possible mapping errors at the department level by highlighting mapping and process
management inconsistencies in the DEPT dimension table before building plan files and starting process
management.
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� Budget Process Management report
Use to showwhat stage each budget plan file is in when using process management for budget staging.

� Budget Workbook Reconciliation
Use to compare check totals from different columns in the budget workbooks to the summary fields in
the database to make sure they are in balance. If the budgets are all in balance, then this report returns
no data, which is the desired outcome of this report.

Setup Guide Axiom Budgeting │ 322



� Global Depreciation Reconciliation report
Use to show the variance between the budgeted depreciation accounts to the same accounts in the
general ledger budget for a user-specified budget year.

� Global Expense Reconciliation report
Use to show the variance between the budgeted depreciation accounts to the same accounts in the
general ledger budget for a user-specified budget year.
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� Global Revenue Reconciliation report
Use to show the variance between the budgeted global revenue accounts to the same accounts in the
general ledger budget for a user-specified budget year.

� Labor Non-Matched
Use to identify the JobCode/PayType combinations that have dollars but have no FTE hours for the year.
This causes a matching issue because to create a JobCode block on the labor tabs, that JobCode needs to
have YTD FTE related hours. This report identifies thosemismatches and posts a 1 to the NYBKHA field so
that the JobCode interfaces into that labor tab.
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� Payroll12 Hours Reconciliation
Use to highlight job codes saved in the Payroll12 data source from the budget workbooks that have
hours but no dollars in the budget.
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� Payroll12 Negative Hours
Use to highlight job codes and pay types that have any negative FTEs budgeted in any month. The report
returns all job codes in the database, but only the ones with the Review flag need to be investigated and
changed, if necessary.

� PayType Mapping Analysis
Use during budget set up for payroll budgeting to showwhat PayTypes map to which payroll budget
category.

NOTE: Prior to reviewing the report, your organization needs to load and reconcile the payroll data
as well as complete the Labor Configuration driver. To understand this report, the user needs to have
knowledge of the Labor Configuration Driver.

Running the PayType Mapping Analysis report
Use the following instructions to run and review the report.
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1. Open the report.

2. Press F9, and select the proper Refresh Variables to review based on organizational needs.

3. Review the following in the report:
l In the top section of the report, which provides an overall summary, ensure that all the pay

types are loaded and map to a specific grouping. The variance should be zero. If not, review
your PAYTYPE dimension table to see what pay type is not mapped.

l The remaining sections of the report correspond to the Labor Configuration driver set up
and how the pay types are grouped/mapped in the PAYTYPE dimension table. These
sections give you an overall summary of what pay types are grouped together, the overall
hours and dollars, the FTE status, as well as the GL accounts if the GL is structured by pay
type.

l Review the overall groupings to make sure they are grouped as expected. The bottom
section shows what is not interfaced or coming into the plan files. Confirm that these are
accurate prior to beginning the budget cycle. If you need to make changes, update the
PAYTYPE dimension table and rerun the report to review.

� Reconcile NYBDetail to Financial
Reconcile values saved in NYBDetail table to those values saved in the Budget Table which could indicate
that values in your budget plan files are not saving properly.

� Reconcile Payroll12 to Financial-Dollars
Use to test the data transfer from the Labor tab to the Expense tab in the budget workbook. It compares
the dollars saved in the Payroll12 tables (Labor tab in budget plan files) to the values posted to the
Financial tables (Expense tab in budget plan files). If there any variances in this report, they will need to
be fixed in the budget workbook and saved to the database. The desired outcome for this report is to
have zero variances.
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� Reconcile Payroll12 to Financial-FICA
Use to test the data transfer from the Labor tab to the Expense tab in the budget workbook. It compares
the FICA dollars saved in the Payroll12 tables (Labor tab in budget plan files) to the values posted to the
Financial tables (Expense tab in budget plan files). If there any variances in this report, they will need to
be fixed in the budget workbook and saved to the database. The desired outcome for this report is to
have zero variances.
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� Reconcile Payroll12 to Financial-Hours
Use to test the data transfer from the Labor tab to the Expense tab in the budget workbook. It compares
the hours saved in the Payroll12 tables (Labor tab in budget plan files) to the values posted to the
Financial tables (Expense tab in budget plan files). If there any variances in this report, they will need to
be fixed in the budget workbook and saved to the database. The desired outcome for this report is to
have zero variances.
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� Salaries Do Not Match
Use to identify accounts on the Labors tabs in the plan files that do not have history on the Expense tab
and would cause a balancing mismatch. This utility posts a 1 to the NYBKHA fields so those accounts
interface in the plan files.
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Financial reports
Axiom Budgeting 2019.3 comes with a variety of standard financial reports, organized within the
following folders and subfolders.

TIP: In some reports, you can drill down to specific data to view how the values were calculated. For
more information, see Drilling data: Using Drill Down.

� Financial Analysis reports
The following reports allow you to view general budget data. For examples of these reports, see Analysis
reports.

Report Description

Account Analysis Use to analyze the current month- and year-to-date
variances for an individual account by department.

Current Year Actual (CYA) Per Unit
Analysis

Use to analyze year-to-date (current) per-unit amounts for
Patient Revenue, Salaries, Supplies, and Other Expenses
compared to current-year budget (Budget).
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Report Description

Expense Summary by Department Use to analyze expense variances by department.

Key Dept Ratios Use to analyze current month and year-to-date salary
variances for an individual department. The salary variance
is broken into categories for Price, Volume, and Efficiency.
A summary section is also provided to show the
components of the total variance.

Labor Price, Volume, & Efficiency
Variances

Use to quickly analyze salaries to determine if the variances
are related to rate or volume.

Labor Summary by Department Use to analyze labor variances by department.

MultiYear Statistic Review Use to show key and non-key statistical accounts for the
current-year actual and budget, prior year, and two years
ago. You can run this report for a single department or
combined for multiple departments. If is often used to
confirm that the statistical basis across different years is
consistent.

Threshold Analysis Use to analyze current month values compared to the
average of the previous threemonth. You can enter a
dollar threshold. After the report is populated, you can
change the view to only show the departments that
exceed the threshold. The purpose of this report is to show
unusual activity or possible missing entries in the current
month.

� Financial Statement reports
The following reports are designed for month-end financial analysis. For examples of these reports, see .

Report Description

Balance Sheet Use to review and analyze the Balance Sheet values by
FSDetail category across multiple years.

Balance Sheet and Cash Flow Use to review and analyze the Balance Sheet and Cash
Flow across multiple years.

Balance Sheet By Entity Use to show by entity for one fiscal year across the balance
sheet categories in FSDetail. You can update the report to
run for any fiscal year in the database.

Balance Sheet Detail Use to show the detail accounts within each balance sheet
category of FSDetail, showing last-year actual and current-
year actual.
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Report Description

Forecast Income Summary Use to show the Current Year Forecast by FSDetail
category compared to Current Year Budget and Current
Year Annualized.

Forecast Scenario Comparison Use to show the Current Year To Date, Current Year
Annualized compared to the Current Year Forecast and
Alternate Forecast.

Income Statement By Entity Use to show the Income Statement categories by entity for
the current fiscal year.

Income Statement Detail Use to show the detail accounts within each income
statement category of FSDetail showing current-year detail
and last-year actual.

Income Statement Multi-Year Use to review the Income Statement totals by FSDetail
category across multiple fiscal years.

Income Statement Projection Use to review the Income Statement totals by FSDetail
category by month. For the remaining months of the year,
it projects using the current-year budget or current-year
forecast, which you can then compare to the annual
budget.

Income Statement Summary Use to review the Income Statement totals by FSDetail
category for the current period and year-to-date compared
to budget and prior year.

Income Statement Summary-12
Month

Use to view the Income Statement totals by FSDetail
category, by month. You can also update the report to
process for any fiscal year in the database.

Income Statement Summary-Drill Use to view review the Income Statement totals by
FSDetail category for the current period and year-to-date
actual compared to budget and prior year. You can drill
down to the detail transactions for revenue, expense,
payroll data, or show a trend for each category.

Provider Income Statement Summary Use to show the Income Statement totals by FSProvider
category for the current period and year-to-date compared
to budget and prior year.

� Payroll reports
The following reports are designed for bi-weekly payroll analysis. For examples of these reports, see
Payroll reports.
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Report Description

Employee Roster Use to show employee-related information for a single
department by job code. This information is used for
budget-labor budgets.

Employee Roster – Position Control Use to show employee-related information by job code
and by employee.

Labor Distribution Use to show bi-weekly paid hours and dollars by job code,
employee, and pay category for a single pay period.

Labor Distribution Detail Use to show hours and dollars by a department, by job
code for multiple pay period, and by category of pay.

Overtime Alert Use to show highlights of overtime trends by pay period
and department.

Overtime Analysis Use to show overtime FTE-related hours by department
trended for multiple pay periods. This report is normally
processed by VP or Director.

� Provider Analysis reports (optional feature)
The following reports are designed for physician analysis.

NOTE: You can also find these same reports in the Budget Reporting section > Provider Budget >
Analysis.

For a description of each report, see Provider Budget reports.

� Report Packages
The following reports are designed for month-end or payroll electronic reporting.

For further instructions, see the following:

l Understanding the ExecutiveMonthly Package
l Understanding theManager Reporting Package
l Running theMonthly All in One Executive Reporting batch

Executive
For examples of these reports, see Running Financial Report Packages - Executive reports.
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Report Description

Budget Variance Rollup Use to show the current month and year-to-date Actual,
Flexible, or Fixed Budget and Prior Year values by category
in detail. This report can be processed at a rolled-up level
by Entity, VP, Director, and so on. You can use any
grouping column in dimensions for summarization.

Budget Variance Summary Use to show the expense, cost-per-unit of service, and
hours-per-unit of service variances for each department.
This report is typically run by VP to give them a summary
of the departments that have variances for the current
month.

Cover_Executive Use as the cover page for monthly Executive report
package. You can customize this report to meet your
reporting needs.

Dept Variance Rollup Use to show department variances over a chosen
threshold by category for revenue and expenses for the
current period and year-to-date. This report also contains
a monthly variance output and projection for the rest of
the fiscal year.

ExecutiveMonthly Package Use to speed up report processing and distribution by
running all of the individual executive reports and including
them in one report package.

Pay Summary by Department Use to show bi-weekly paid hours by department, by
payroll summary category trended over multiple pay
periods. This report is normally processed by VP but can
also be processed by Director, Division, and so on.

Statistic Variance Summary Use to show key statistics by department for the past four
months to show statistical trends and variances.

Top 10 Variances Use to show top and bottom ten department variances for
salaries, supplies, and other expenses.

Variance Overview Use to showmonthly variances by department, by
account that exceed the thresholds set by the system
administrator.

Manager
For examples of these reports, see Running Financial Report Packages -Manager reports.
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Report Description

AP Distribution Report (optional
feature)

Use to show themonthly Accounts Payable (AP) detail by
general ledger account by vendor, check number, and
check date.

AR Distribution Report (optional
feature)

Use to show themonthly Accrued Receipts (PO Received
Not Invoiced) detail by vendor, PO Number, line item
description, and receipt date subtotaled by general ledger
account.

Budget Variance By Department Use to show the current month and year-to-date actual,
which are then compared to the Flexible or Fixed Budget as
well as Prior Year values by category and in detail.

Cover_Manager Use to generate a cover page for monthly Manager report
package. You can customize this report to meet your
reporting needs.

Dept Monthly Package Use to run all of the individual manager reports and
distribute them in one report package

GL Distribution Report (optional
feature)

Use to show themonthly journal entry detail for each
general ledger account.

MM Distribution Report (optional
feature)

Use to show themonthly materials management issues,
including the location of issue, unit of issue, unit price,
quantity, and the amount subtotaled by general ledger
account.

Pay By Employee ID Use to show the biweekly paid hours by employee, by
payroll summary category trended over multiple pay
periods.

Pay By JobCode Use to show the biweekly paid hours by job code, by
payroll summary category trended over multiple pay
periods.

RU Report (optional feature) Use to show the current month and year-to-date Revenue
and Usage units and gross revenue by CDMCode. Units for
specific CDM can be RVUweighted to use for monthly
statistics summarization.

RU Report_Budget (optional feature) Use to show the current-month actual, budget, and year-
to-date Revenue and Usage units and gross revenue by
CDMCode. Units for specific CDM can be RVUweighted to
use for monthly statistics summarization.

Scorecard Use to show financial and ratio indicators for the chosen
department compared to budget and trend.
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Report Description

Variance Alert Use to show accounts that exceed variance thresholds for
themonth.

Package Utilities
For examples of these reports, see Running Financial Report Packages - Utilities.

Report Description

Monthly All in One VP Package Use to automatically build a report packaging batch using
the database and dimensions. You may build a batch to
distribute reports based on a single dimension grouping by
another dimension grouping (For example, Dept by VP,
Manager by Director, etc.).

Monthly Manager Package Use to package and email monthly reporting packages to
managers. Each column in the report represents a
recipient, with the reports listed under each person as the
reports they receive in their monthly package.

Monthly VP Package Use to package and email monthly reporting packages to
VPs. Each column in the report represents a recipient, with
the reports listed under each person as the reports they
receive in their monthly package.

Analysis reports
These reports are designed for designed for month-end close analysis.

� Accessing these reports
The reports listed in this section are located in \Axiom\Reports Library\Management
Reporting\Analysis. For instructions, see Browsing the Report Library.

You can also access them from the Bud Admin task pane. In the Financial Reporting section, click
Financial Reporting > Analysis.
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� Account Analysis
Use to analyze the current month- and year-to-date variances for an individual account by department.

� Current Year Actual (CYA) Per Unit Analysis
Use to analyze year-to-date (current) per-unit amounts for Patient Revenue, Salaries, Supplies, and Other
Expenses compared to current-year budget (Budget).
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� Expense Summary by Department
Use to analyze expense variances by department.

� Key Dept Ratios
Use to analyze current month and year-to-date salary variances for an individual department. The salary
variance is broken into categories for Price, Volume, and Efficiency. A summary section is also provided
to show the components of the total variance.

Setup Guide Axiom Budgeting │ 339



� Labor Price, Volume, and Efficiency Variances
Use to quickly analyze salaries to determine if the variances are related to rate or volume.

� Labor Summary by Department
Use to analyze labor variances by department.
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� MultiYear Statistic Review
Use to show key and non-key statistical accounts for the current-year actual and budget, prior year, and
two years ago. You can run this report for a single department or combined for multiple departments. If
is often used to confirm that the statistical basis across different years is consistent.

� Threshold Analysis
Use to analyze current month values compared to the average of the previous threemonth. You can
enter a dollar threshold. After the report is populated, you can change the view to only show the
departments that exceed the threshold. The purpose of this report is to show unusual activity or
possible missing entries in the current month.

Setup Guide Axiom Budgeting │ 341



Balance Sheet and Cash Flow reports
These reports are designed for designed for month-end close analysis.

� Accessing these reports
The reports listed in this section are located in \Axiom\Reports Library\Management
Reporting\Financial Statements\Balance Sheet & Cash Flow. For instructions, see Browsing the Report
Library.

You can also access them from the Bud Admin task pane. In the Financial Reporting section, click
Financial Reporting > Financial Statements > Balance Sheet & Cash Flow.
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� Balance Sheet
Use to review and analyze the Balance Sheet values by FSDetail category across multiple years.

� Balance Sheet and Cash Flow
Use to review and analyze the Balance Sheet and Cash Flow across multiple year
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� Balance Sheet by Entity
Use to show by entity for one fiscal year across the balance sheet categories in FSDetail. You can update
the report to run for any fiscal year in the database.
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� Balance Sheet Detail
Use to show the detail accounts within each balance sheet category of FSDetail, showing last-year actual
and current-year actual.

Setup Guide Axiom Budgeting │ 345



Data Reconciliation utilities
These reports are designed for designed for month-end close analysis.

� Accessing these reports
The reports listed in this section are located in \Axiom\Reports Library\Management Reporting
Utilities\Data Reconciliation. For instructions, see Browsing the Report Library.

You can also access them from the Bud Admin task pane. In the Financial Reporting section, click
Financial Utilities > Data Reconciliation.
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� Acct Standards Review
Use this report to map standardized data for accounts in your organization to KHA Standard Class codes.
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� BiWeekly Payroll Reconciliation report
After the payroll file is loaded, run the Biweekly Payroll Reconciliation report.

Using the loaded import file, total the dollars and hours from the import file, and enter the totals into the
BiWeekly Payroll Reconciliation report to see if your check totals from your import file match what was
loaded in to Axiom.

If your dollars and hours for the loaded period matches the Grand Total, the data is reconciled, and you
can move on to either loading another payroll for the current month or running the Payroll Accrual utility
to accrue your biweekly payroll to a monthly payroll.

� Consolidations and Eliminations
This is a save to database report that allows you to input eliminations for your Financial database.
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� Dept Standards Review
Use this report to map standardized data for departments in your organization to KHA Standard Class
codes.

� Entity Standards Review
Use this report to map standardized data for entities in your organization to KHA Standard Class codes.

� Jobcode Standards Review
Use this report to map standardized data for job codes in your organization to KHA Standard Class
codes.
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� Monthly RevUsage Reconciliation
After all data is loaded, run theMonthly RevUsage Reconciliation. This report shows the IPVolume,
IPRevenue, OPVolume, and OPRvenue by department for each month.

Using the import file that was loaded, total the Volumes and Revenue dollars from the import file, and
key the totals into theMonthly RevUsage Reconciliation report to see if your check totals from your
import file match what was loaded in to Axiom.

If your dollars and volumes for the period loaded matches the Grand Total, the data is reconciled. If you
use RevUsage volumes to calculate statistics for productivity, you can move forward to summarize your
IP\OP volumes from your RevUsage data table (ACT_RU_20XX) to your Financial data table (ACT20XX)
using the Summarize CDM Statistics utility.

� Paytype Standards Review
Use this report to map standardized data for pay types in your organization to KHA Standard Class
codes.
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� Reconcile GL to GLTransactions report
If you load subledger detail into Axiom, such as Accounts Payable (AP), Accrued Receipts (AR), Materials
Management (MM) and Journal Entries (JE), we have a reconciliation utility that ties the subledger data
back to the ledger data (ACT20XX). This report confirms that the data loaded to the GL matches the data
loaded to Journal Entry (JE) detail. It also compares the JE Detail to AP, MM, AR transactions to make
sure the data is in balance.

TIP: Your Kaufman Hall Implementation Consultant will help you set up this report during
implementation.

NOTE: Use the Reconcile GL to RevUsage report to reconcile your chargemaster data for Inpatient
and Outpatient between the Financial data source (ACT20XX) and the RevUsage data set (ACT_RU_
20XX). Manual adjusting journal entries outside of the source system will cause reconciling variances
to the General Ledger RevUsage data so do not use this report regularly. The report is located in the
Reports Library in theManagement Reporting Utilities > Data Reconciliation folder.

� Reconcile GL to Pay12 to Pay27 report
Use this report to compare the Current Year Gross Revenue in the Financial tables to the RevUsage
tables.
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� Reconcile GL to Rev Usage report
Use to reconcile GL revenue data in the Financial tables to the Revenue and Usage data imported into the
database on a monthly and year-to-date basis. The desired result for this report is to show a zero
variance.

Income Statement reports
These reports are designed for designed for month-end close analysis.

� Accessing these reports
The reports listed in this section are located in \Axiom\Reports Library\Management
Reporting\Financial Statements\Income Statement. For instructions, see Browsing the Report Library.

You can also access them from the Bud Admin task pane. In the Financial Reporting section, click
Financial Reporting > Financial Statements > Income Statement.
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� Forecast Income Summary
Use to show the Current Year Forecast by FSDetail category compared to Current Year Budget and
Current Year Annualized.
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� Forecast Scenario Comparison
Use to show the Current Year To Date, Current Year Annualized compared to the Current Year Forecast
and Alternate Forecast.

� Income Statement By Entity
Use to show the Income Statement categories by entity for the current fiscal year.
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� Income Statement Detail
Use to show the detail accounts within each income statement category of FSDetail showing current-year
detail and last-year actual.
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� Income Statement Multi-Year
Use to review the Income Statement totals by FSDetail category across multiple fiscal years.

� Income Statement Projection
Use to review the Income Statement totals by FSDetail category by month. For the remaining months of
the year, it projects using the current-year budget or current-year forecast, which you can then compare
to the annual budget.
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� Income Statement Summary
Use to review the Income Statement totals by FSDetail category for the current period and year-to-date
compared to budget and prior year.

� Income Statement Summary-12 Month
Use to view the Income Statement totals by FSDetail category, by month. You can also update the report
to process for any fiscal year in the database.

� Income Statement Summary - Detail
Use to view review the Income Statement totals by FSDetail category for the current period and year-to-
date actual compared to budget and prior year. You can drill down to the detail transactions for revenue,
expense, payroll data, or show a trend for each category.
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Payroll reports
These reports are designed for bi-weekly payroll analysis.

� Accessing these reports
The reports listed in this section are located in \Axiom\Reports Library\Management Reporting\Payroll.
For instructions, see Browsing the Report Library.

You can also access them from the Bud Admin task pane. In the Financial Reporting section, click
Financial Reporting > Payroll.
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� Employee Roster
Use to show employee-related information for a single department by job code. This information is used
for budget-labor budgets.

� Employee Roster - Position Control
Use to show employee-related information by job code and by employee.
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� Labor Distribution
Use to show bi-weekly paid hours and dollars by job code, employee, and pay category for a single pay
period.

� Labor Distribution Detail
Use to show hours and dollars by a department, by job code for multiple pay period, and by category of
pay.

� Overtime Alert
Use to show highlights of overtime trends by pay period and department.
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� Overtime Analysis
Use to show overtime FTE-related hours by department trended for multiple pay periods. This report is
normally processed by VP or Director.

Payroll utilities
These utilities are designed to post calculated values to the database.

� Accessing these reports
The reports listed in this section are located in \Axiom\Reports Library\Management Reporting
Utilities\Payroll. For instructions, see Browsing the Report Library.
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You can also access them from the Bud Admin task pane. In the Financial Reporting section, click
Financial Utilities > Payroll.

� BiWeekly to Monthly
Use this utility to accrue for both hours and dollars from your biweekly payroll load (Payroll26) into the
monthly data tables (Payroll12).

Depending on howmany years of biweekly payroll data are stored in your Axiom system, you have two
utility options:

l Biweekly to Monthly – Your organization is in their first year in Axiom and have no prior year
payroll data utilize this utility.

l Biweekly to Monthly with LY – Your organization has more than one year of historical payroll
data to capture the days of the year-end biweekly payroll that may cross over their fiscal year
utilize this utility.

In the Refresh Variables dialog, select from the following drop-downs options, and click OK:

Option Description

Choose Year (Current Year
or Last Year

Depending on what biweekly payrolls you want to accrue, select CYA
(Current Year) or LYA (Last Year) .
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Option Description

Choose Payroll Sequence
(Hours, Dllrs, Stats)

Select Hours or Dllrs.

NOTE: These need to be run individually so once you run one (Hours)
you will have to then run the other (Dllrs).

Post results to the
database?

To post the results to the Axiom database, select Yes; otherwise,
select No.

TIP: Ensure that the number of FY days in First Pay Period are correct. If they are not, review the pay
period dates on the Custom Tables > Payroll tab.

In the File Processing task pane, click Process file multipass to run the utility by department and post
the values to the database. Repeat this step for the Hours by refreshing the report variables, select Hours
from the refresh variable, and then Process File multipass. If you also load statistics into you biweekly
payroll tables, you can also run this utility to move the statistics to your financial data source.
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� BiWeekly to Monthly with LY
Use this utility to post accrued biweekly hours or dollars from the Payroll27 tables to the Payroll12 tables.
The first period of the year is calculated using the final LY pay period.

� Monthly to BiWeekly
Use this utility to post reverse-accrued budgeted monthly hours from the Payroll12 tables to biweekly
amounts and post them to the Payroll27 tables for labor or productivity reporting.
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� Monthly to GL
If payroll hours are not coming through your GL Import, you can move your hours from the Payroll12
data tables created from the previous process to your Financial tables by running theMonthly to GL
accrual utility.

IMPORTANT: Only run this utility if you are not loading hours from your GL via the GL12Month or
Monthly Statistics imports.
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NOTE: Use theMonthly to BiWeekly utility to take budgeted Payroll12 data and reverse accrue it to a
biweekly data set.

Provider Analysis reports
These reports are designed for physician analysis.

NOTE: These reports are optional reports that you can purchase as an add on to your current
license.

� Accessing these reports
The reports listed in this section are located in \Axiom\Reports Library\Management
Reporting\Provider Analysis. For instructions, see Browsing the Report Library.

You can also access them from the Bud Admin task pane. In the Financial Reporting section, click
Financial Reporting > Provider Analysis.
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� Current Period vs Previous Comparison
Use to compare current period vs previous period information by provider as well as last year actual. You
can select the data type to analyze in the report.

� Current Period vs Previous Comparison_CPT
Use to compare current period vs previous period information by CPT or CPT Summary category and last
year actual. You can select the data type to analyze in the report.

� CY Actual vs Budget Comparison
Use to compare current period and year-to-date actual vs budget information by provider and last year
actual. You can select the data type to analyze in the report.
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� CY Actual vs Budget Comparison_CPT
Use to compare current period and year-to-date actual vs budget information by CPT or CPT Summary
code and last year actual. You can select the data type to analyze in the report.

� NY Budget Comparison
Use to compare current year projections with next year's budget.

� NY Budget Comparison_CPT
Use to compare current year projections with next year's budget by CPT or CPT Summary category.
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� Provider Key Indicators By Month
Use to comparemonth-by-month values for last year, current year, and target by data type.

� Provider Key Indicators By Month_Rolling 12
Use to comparemonth-by-month values for themost recent 12months by data type
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� Provider Practice Summary
Use to analyze by provider, by practice the worked vs target productivity by provider.

� Provider Productivity
Use to analyze by provider worked vs target productivity.
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� Provider Revenue Per Encounter
Use to compare the current month to the prior three-month average for different years for revenue per
encounter.

� Provider Revenue Per RVU
Use to compare the current month to the prior three-month average for different years for revenue per
RVU.
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� Provider Revenue Per WRVU
Use to compare the current month to the prior three-month average for different years for revenue per
WRVU.

� Provider Volume by Specialty
Use to compare actual vs budget volume by data type for the current period and year-to-date,
subtotaled by provider specialty.
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� Provider Volume by Specialty_Monthly
Use to showmonthly totals by provider, for a chosen data type and year, subtotaled by provider
specialty.

Provider Income Statement reports
These reports are designed for month-end financial analysis.

� Accessing these reports
The reports listed in this section are located in \Axiom\Reports Library\Management
Reporting\Financial Statements\Provider. For instructions, see Browsing the Report Library.

You can also access them from the Bud Admin task pane. In the Financial Reporting section, click
Financial Reporting > Financial Statements > Provider.
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� Provider Income Statement Summary
Use to show the Income Statement totals by FSProvider category for the current period and year-to-date
compared to budget and prior year.
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